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GRANT OF LICENSE. As registered user, the author grants to you the right to use one
copy of the enclosed software program (the "SOFTWARE"). You may not network the
SOFTWARE or otherwise use it or make it available for use on more than one computer
at the same time.

DSP-QUATTRO COPYRIGHT. The SOFTWARE is owned by Stefano Daino, via Romeo
Rodriguez Pereira 129/C - 00136 ROME - ITALY, and is protected by lItalian copyright
laws and international treaty provisions. Therefore, you must treat the SOFTWARE like
any other copyrighted material (e.g. a book or musical recording) except that you may
either (a) make one copy of the SOFTWARE solely for backup or archival purposes, or
(b) transfer the SOFTWARE to a single hard disk provided you keep the original solely for
backup or archival purposes. You may not copy the written materials accompanying the
software.

OTHER RESTRICTIONS. You may not rent, lease, sell or transfer the SOFTWARE to
other persons. You may not modify, adapt, translate, reverse engineer, decompile, or
disassemble the SOFTWARE.

DISCLAIMER OF WARRANTY AND LIMITED WARRANTY. THE SOFTWARE AND
ACCOMPANYING ELECTRONIC AND WRITTEN MATERIALS (INCLUDING
INSTRUCTIONS FOR USE) ARE PROVIDED "AS I1S" WITHOUT WARRANTY OF ANY
KIND. FURTHER STEFANO DAINO DOES NOT WARRANT, OR MAKE ANY
REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF
THE SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS,
ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE.

THE ABOVE ARE THE ONLY WARRANTIES OF ANY KIND, EITHER EXPRESSED OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE THAT ARE MADE
BY STEFANO DAINO ON DSP-QUATTRO PRODUCT. NO ORAL OR WRITTEN
INFORMATION OR ADVICE GIVEN BY THE AUTHOR, ITS DEALERS, DISTRIBUTORS,
AGENTS, OR EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY
INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON SUCH
INFORMATION OR ADVICE. THIS WARRANTY GIVES YOU SPECIFIC LEGAL
RIGHTS. YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM STATE TO STATE.
NEITHER THE AUTHOR NOR ANYONE ELSE WHO HAS BEEN INVOLVED WITH THE
CREATION, PRODUCTION, OR DELIVERY OF THE SOFTWARE SHALL BE LIABLE
FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES
(INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS
INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT
OF THE USE OR THE INABILITY TO USE THE SOFTWARE EVEN IF THE AUTHOR
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME
STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR
CONSEQUENTIAL OR INCIDENTAL DAMAGES OR THE LIMITATIONS OF DURATION
OF IMPLIED WARRANTY, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

OTHER TRADEMARKS AND COPYRIGHTS:

- D-SoundPRO is Copyright © 1998 by Stefano Daino. All rights reserved.
- Apple and all other copyrights and trademarks are held by their respective holders.
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Introduction

Welcome to the DSP-Quattro User’s Guide. DSP-Quattro is the direct result
of a very long experience developing Digital Audio applications for the
MacOS, starting with D-SoundPRO, the powerful audio editor developed
since 1994 for Apple Macintosh™ computers, a highly innovative product
which uses even the latest technology of the new millennium. DSP-Quattro
inserts the new dimension of real-time into the world of audio editors, turning
your computer into a real time workstation for music production, plug-in
hosting and audio editing for writing files ready for mastering. All of the
above through the smoothest interface you have ever seen. DSP-Quattro is
designed for the most professional users, however, thanks to the simple and
intuitive interface, DSP-Quattro turns out to be the ideal product for whoever
has no experience in the field and would like to enter in the world of digital
audio.

This User’s Guide will show you all there is to know about DSP-Quattro.

What is DSP-Quattro?

DSP-Quattro is an extremely powerful Audio Editor / AudioCD Mastering
Application with extended real-time and off-line support of AU Effect and
Virtual Instrument plug-ins for the Apple MacOS.

- DSP-Quattro is a real time audio editor.

DSP-Quattro is the right software for all people who want to record, create or
edit their audio work with the computer. With DSP-Quattro you can record
audio sources, edit existing audio files, and even create new files ready for
mastering. All these using various existing formats, thanks to the import
function, such as WAVE, AIFF, SDIl, mp3, m4a, DDP, etc. You will then be
able to edit the new file starting with the basic Cut, Copy&Paste commands,
to the most advanced algorithms, as the Time Stretching, Frequency and
Pitch Shifting, Linear Phase Sample Rate Converter (SRC), and Digital Real
Time Effects, like reverbs, stereo enhancers, graphic and parametric EQs,
Analog Filter Simulators, and so on. And it is all built-in!

But not only that: DSP-Quattro is open to the standard third parties plug-ins
as well. DSP-Quattro Editor allows you to use any plug-in exactly as any
other internal edit function, offering also a real time preview of the result
before to apply it. And, if you will not like the result, you have not to worry:
DSP-Quattro internal engine keeps track of all edits and you can Undo/Redo
your operations without any limitation.

- DSP-Quattro is the perfect tool for Audio COROM mastering.

DSP-Quattro integrates CD burning that conforms to the Redbook standards
for playback in any CD player. DSP-Quattro comes also with a fully
programmable AudioCD Layout, offering all the features needed to build
your audio CDROM by using your favourites songs or even selections of
audio files. Several non-destructive cross-fade types can be programmed to
make the transitions between your audio tracks even smoother, without
audio clicks or abrupt changes. And, as very unique feature, DSP-Quattro
allows you to setup a serial chain of effects (to choose from the internal list
or from the effect plug-ins installed on your system), to play and master you
AudioCD giving a tremendous additional power to your master. Even more,
each track of the AudioCD may have its own chain of real time non-
destructive effects, different from track to track to best suite all your needs!
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CD-Texts, EAN/UPC, ISRC, PQ sub-codes are supported as well. You can
even import/export the AudioCD layout according the DDP 2 standard.

- DSP-Quattro is an Instrument and Effect plug-in Host:

DSP-Quattro is also a great real time synthesizer and multi-effects that can
be used by an experienced musician or by someone who simply wants to
learn how to play an instrument. Thanks to its specific connection with audio
plug-ins and MIDI, DSP-Quattro is able to play a real time standard
Instrument plug-in by using a MIDI controller and/or a external sequencer,
while listening to an audio file and recording everything on a new file! Even
more, you can add in real time the effect plug-ins that better suites your
needs. DSP-Quattro can even be used to better the sound quality of your
voice or of your instruments as with a professional multi-effect, thanks to its
real time management of the input/output connections of both internal
standard and/or external analog/digital interfaces. All of the above without
any additional hardware or using all the features of those eventually
connected to your computer.

- DSP-Quattro is a tool for software and hardware samplers:

For all those among you that have already experienced music and both
hardware and software samplers, DSP-Quattro is the perfect editing tool. In
fact, DSP-Quattro offers not only a way of processing in floating point
precision to satisfy even the more professional user, it offers also all the
graphical tools for the sample-based editing of your audio files. You will be
able to set loop points through a special loop editor window, and apply any
internal or plug-in effect directly to your samples! DSP-Quattro guarantees
the direct compatibility of audio files such as AIFF and WAVE, including the
loop points information.

About Third Parties AudioUnit Plug-Ins formats

DSP-Quattro is capable to support Instruments and Effects plug-ins.
Instruments can be used to play music in real time and to generate new
audio files. Effects can be used as real time modifiers or as offline edit
function with real time previewing. More about this will come later on this
manual.

DSP-Quattro supports Instruments and Effects Audio Unit (AU) 64 bits plug-
ins.

What do | need to use DSP-Quattro?
DSP-Quattro works on any Apple Macintosh with an Intel microprocessors
running MacOS 10.11 (EI Capitan) or higher.

The minimum requirements are: a CPU Intel Core 2 Duo, 1GBytes of free
RAM, and around 50 MBytes of free space on your HD.

The audio and graphic engines of DSP-Quattro run at 64 bits and are
multithread. If present, DSP-Quattro will use the CPU multicores.

Please consider also that the performances of DSP-Quattro are heavily

dependent by the number of plug-ins and effects that are used at the same
time.
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If you have older systems, previous versions of DSP-Quattro which runs on
previous versions of MacOS 10.11 - even on MacOS 9.2 - are still available
upon request (but not supported anymore). Please contact the

support@dsp-quattro.com to know the requirements to run it.

Mac standard audio interface can be used with DSP-Quattro by CoreAudio,
which is built-in in the MacOS.

DSP-Quattro fully supports CoreMIDI, which is built-in into MacOS.

DSP-Quattro supports also all the external hardware audio interfaces if
compatible with MacOS.

What do | need to know to use DSP-Quattro?

This User’'s Guide assumes that you know how to operate the Macintosh
and are familiar with the basic Macintosh terminology such as point, click,
drag & the MacOS file system and desktop. If you aren’t familiar with these
terms, you should refer to the Macintosh User’s Guide to learn the basic
operations of using the Macintosh. Optionally, this User's Guide assumes
that you know what technologies like AudioUnit, CoreAudio, and, if you are
interested to play software AU Instruments, what CoreMIDI and MIDI are.

Support:
DSP-Quattro official home page is:

www.dsp-quattro.com

Here you can find additional information on our product, you will be able to
register your copy and, by being a registered user, you will be able to use a
list of additional services in the user area.

At any time write us by e-mail at support@dsp-quattro.com to have the
answer to your technical questions or for more information regarding the use

of DSP-Quattro.
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Installing DSP-Quattro

After downloading the DSP-Quattro archive from the web, your browser
should decompress the zip archive and MacOS should automatically mount
a disc titled DSP-Quattro.

If it does not happen, look into the Download folder on your HD for the DSP-
Quattro zip archive, double-click on it to decompress it. Then, double click
on the decompressed dmg file. Mac OS mounts a DSP-Quattro Hard Disk.
Open it.

[ XON ] || DSP-Quattro
23 = Dol Zv £v Q Ricerca
DSP-Quattro =+

Preferiti
;A; Applicazioni
@ Documenti
[ Scrivania

@) Airbrop # W
[E] Macintosh HD —

Plug-Ins DSP-Quattro Applicazioni
@ Immagini
B3 Libreria
£} steve
iCloud Dri
- To Install DSP-Quattro
0 Download
Projects MacOS

E Recenti

- Drag the above DSP-Quattro Icon into the Applications folder

- Go to Applications folder and run DSP-Quattro from there.

Dispositivi
[] Steve MacBook PRO (2)

Disco remoto E D=
) Macos a = =
Q DSP-Quattro 2 RTF 7 RTF
Tag About&FAQs Install...GUIDE DSP-...License
© Casa
X 5 elementi — —

To complete the operation, drag the DSP-Quattro application icon into the Application folder.

Please read very carefully any additional documentation which is on the mounted DSP-Quattro
disc, like About&FAQ and DSP-Quattro License.

Then, navigate to the Application folder on your HD, look for the DSP-Quattro application icon.
Running and Registering DSP-Quattro
Double click on DSP-Quattro application icon to run it. Then, please refer to
the DSP-Quattro Installation GUIDE which is in the DSP-Quattro disk image

to know how to register your full version of DSP-Quattro.

That’s it. Enjoy DSP-Quattro!
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The Basics of DSP-Quattro

To make the most of DSP-Quattro, it is important to understand how it works.

Output Recorder

) Audio OUTs
Insert Fx

Audio Editor

Audio Files

Audio CD Layout

Insert Fx Insert Fx . Insert Fx
Audio Inputs Virtual Instruments Input Recorders

The Project: a project is the document used by DSP-Quattro. The project is
a container including all the objects you need to accomplish your work. You
start using DSP-Quattro creating a new project or opening an existing
project, and you must decide if you want to save or discard the edits you did
on your project when you quit DSP-Quattro.

When you wish to edit your audio files, or you wish to build an AudioCD, you
import the audio files into the project. DSP-Quattro will make a copy of each
of them into the project bundle. Then, DSP-Quattro will not touch anymore
your source audio files, it will work on its internal copies: when you save the
edits on your audio files using the Audio Editor, DSP-Quattro updates the
internal audio files, not the source audio files. So, to re-use the edited audio
files outside DSP-Quattro, you must export them back to MacOS file system,
eventually replacing your source files if this this is what you want to do.

If you need, you can add to the Project also Audio Inputs and Input
Recorders modules, you can also load and configure your Audio Unit Virtual
Instruments, load your plug-ins on insert to your audio sources or on output
channels. When you quit, you can save the Project if you wish to keep what
you have done.
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The Audio Generators: DSP-Quattro is based on Audio Generators. By
Audio Generator we mean any source of sound. Examples of Audio
Generators are any kind of audio file player, audio input, and virtual
instrument plug-ins. In the real world, in a recording studio, a recorder, a
synthesizer, a piano, a microphone, a musician playing his instrument would
all be considered Audio Generators.

In DSP-Quattro it is possible to open or create as many Audio Generators as
you want. These Audio Generators can than be played one at a time, all
together or not even be played at all! A generator can be loaded or released
dynamically, regardless of the other generators.

Effects and MasterOut Recorder: the sounds created by Audio Generators
go into a mixer that has one Master Out + four Aux channel strips, each one
playing in stereo. It is possible to load on insert to each channel strip a
series of real time effects that can be chosen among the internal effects of
DSP-Quattro or among the third-party AU effect plug-ins installed on
MacOS. What you listen on output of the stereo channels can be even
recorded as a new file using an Audio Output Recorder, and/or can be
addressed to your audio devices, such as your Mac audio output or to an
external audio device connected to the Mac.

The next chapters will deal with how to use different Audio Generators, how
to configure an effects chain, and with all the other functions of DSP-Quattro.

Audio File Editor: a special kind of Audio Generator is the Audio File Editor.
It is not only capable of playing an audio file, but it allows you to edit the file
by a several different editing functions.

If you are already used a digital audio editor, the Audio File Editor of DSP-
Quattro will look just like what you may have already used. But please do not
stop at the use of DSP-Quattro as a simple audio editor, although it has all
the possibilities to do so. DSP-Quattro introduces a new dimension of audio
editing, and the time you will spend to understand how it works will be spent
very well.

The AudioCD Layout: another very important component of DSP-Quattro is
the AudioCD Layout. The AudioCD Layout is able to play a sequence (often
called also playlist) of audio files or only portions of audio files. Each of these
is called ‘Audio Regions’. It is also possible to set cross-fades between an
Audio Region and the next one, to avoid abrupt changes of the output audio
stream, making smooth transitions between them. You can also place
markers to set the CD-Track starts and preGaps - or pauses - of your audio
CD-ROM. The AudioCD Layout output can be rendered to disc as a new
audio file, can be used — in real time - as audio generator itself, or can be
used to create an image of an audio CD-ROM, using a standard format
called DDP. Moreover, DSP-Quattro is able to burn audio CD-ROMs by
itself, if you have an internal or external CD writer device connected to your
Mac.

Following are basic examples of what can be done with DSP-Quattro. And
they could be even many more...

NOTE: Everything shown in these examples is dynamic and therefore can
be fully customized by the user. Nothing stops you from adding or closing
any of the elements, and to create a mix of the different configurations
shown in the examples.
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Using DSP-Quattro as Audio File Editor

You can choose to open/save audio files in all the most used formats, like
AIFF, WAVE files (8, 16, 24, 32 or 32-Floats bits/sample), mp3, m4a,... or
joining L&R channels from dual mono files if needed, and you can even
import/export from/to RAW binary files. Again you can open different files at
the same time and copy&paste data to one another audio file using the
audio clipboard of DSP-Quattro.

Output Recorder

T :l Audio OUTs

v

Insert Fx

Audio Files Audio Editor

Insert Fx

Output Channels

DSP-Quattro offers a range of editing possibilities. Not only the basic Cut,
Copy and Paste editing commands, but also highly professional commands
such as High Quality Time Stretching and Frequency Shifting algorithms, an
amazing De-clicker for audio restoration, reverbs, stereo enhancers,
graphical and parametrical EQs, Analog Filter Simulators. Moreover, DSP-
Quattro has been developed to host standard Audio Unit effect plug-ins,
which can be used as edit function as well.

1:256 <>

Playback Marker Sta 0
00:01:20:600 en 7 | p——T—
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DSP-Quattro includes a very special Cut Editor as well. Using it, you can
very easily remove portions, paste different audio materials on your audio
file just looking to it and dragging waveforms back and forth in the time line
to set crossfades between the regions, before and after the cut, avoiding
abrupt changes or clicks on the resulting audio stream.

And don’t forget that the editing is not destructive, because DSP-Quattro
offers an infinite number of Undo/Redo levels. Last but not least, all the
editing algorithms work with the precision of 64 bits floating point arithmetic
when needed, to guarantee the best dynamic and professional results.

A series of real time effects can be added, both as insert on the audio file
under editing and as global to the master out or to one of the auxiliary
outputs.

Each effect can be chosen among the internal effects of DSP-Quattro and/or
between the Audio Unit effect plug-ins installed in your system. There is also
a very special internal ‘plug-in’ to address output/inputs of the Mac (or of the
external audio device connected to your mac), so you can route your audio
signals to/from an external analog/digital audio hardware.

The insert chain of effects can then even be used as an off-line editing
algorithm to “render” it into a new audio file.

Not only this. Using the built-in Output Recorder of DSP-Quattro, which his
able to make a new recording of what you are listening to the output of DSP-
Quattro. Using it, any real time modification done on an audio file which is
playing - such as pitch changes, time stretching, using jog shuttle in Audio
Scrub mode, etc. - can be recorded into a new audio file.

Using DSP-Quattro as Digital Audio Recorder

Outputs v  Effects

Effects
)" File Cmds

Insert FXs

¢ "Edit Fx-1
Parametric EQ §

)" "Edit Fx-2
Graphical EQ  §

)" "Edit Fx-3

0.00 Reverb 1 s

“ ) "Edit Fx-4
TAL Re...Plugin §

)" "Edit’ Fx-5

MultiTap Delay §

Edit Fx-6

A
v

Edit Fx-7

A
v

Edit Fx-8

A
v

Input Recorder Module
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The easiest way to make a new recording is to open an Input Recorder. This
object is able to create a new audio file, choose a pair of stereo audio inputs
(or only one input, if you prefer) and then record everything exactly as with a
traditional recorder.

You can open how many Input Recorders you wish at the same time. This
could be very useful when you have audio interfaces with multiple audio
inputs. All them will be synchronised with the transport control of the Mixer
Transport bar.

Each Input Recorder may have its own effect chains on insert.

DSP-Quattro offers also another possibility to make a new recording: the
Output Recorder. It works almost as the Input Recorder, but it dumps to file
everything that DSP-Quattro sends to the audio outputs. Because it takes its
inputs after the mixer, in the case in which you use multiple Input Recorders,
ending a multiple recording sessions you will get one new file for each Input
Recorder, plus one file with the mixed audio. And, last but not least, you can
configure different insert Fx for each recording, and for the mixed recording
on output, of course.

@ Output Recorder

Recording Time Partial Rec Time: (00:00:00:000

00:00:00:000  mmeonko: 01:08:29:279
=
= S File Name New Recording - 3
New Marker
Format

Slave

And, of course, while listening to one input DSP-Quattro can play any other
audio file and record everything mixed by using the Output Recorder...

Using DSP-Quattro for audio CD-ROM Mastering

DSP-Quattro allows you to do new recordings, get your audio files, edit
them, improve the audio quality of your product, build your AudioCD layout,
and even burn and audio CD-ROM which is compliant with the Redbook
standard, extended to include CD-Text, EAN/UPC CD-ROM Disc code, CD-
Track ISRC and PQ sub-codes. You can import/export the AudioCD layout
according to the DDP 2 standard as well.

In just a few steps you will have your AudioCD ready for the distribution:

Step 1: Record your audio files or import your audio files into the DSP-
Quattro Project.

Use DSP-Quattro as Digital Audio Recorder, as described above, to do your
new recordings. DSP-Quattro will add the new recordings to the list of the
imported audio files, ready for being used for editing or for building a new
AudioCD Layout.
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» Outputs Easy Mode Advanced Mode

v Effects File ¢ Bumn CD PDF Sheet AudioCD Info

(U} File Cmds

00:00:00:000 00:08:53:160

0:04:26:580

00:13:19:741
Insert FXs

Edit Fx-1

00:03:39:428 00:04:34:285 00:05:29:142 100:06:24:000
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Edit Fx-5
a
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gior Commands 4  Region Info

ID Start Name Length Gain  Fade In Mode
AUTO
AUTO
AUTO
AUTO
AUTO
AUTO

AUTO

Fade Out

00:00:35:279
00:00:12:253
00:01:20:693
00:00:23:701
00:01:02:912
00:00:00:000
00:01:05:626

001 00:00:02:000 01 Politik

002 00:04:45:414 02 In My Place

003 00:06:26:655 02 In My Place - 1
004 00:07:16:853 03 God...Your Face
005 00:08:39:048 03 God...r Face - 1
006 00:10:59:675 04 The Scientist
007 00:16:10:912 05 Clocks

00:05:18:693
00:01:53:494
00:01:55:312
00:01:45:895
00:03:23:539
00:05:09:237
00:05:07:539

+0.00
+0.00
+0.00
+0.00
+0.00
+0.00
+0.00

00:00:00:000
00:00:35:279
00:00:12:253
00:01:05:113
00:00:23:701
00:01:02:912
00:00:00:000
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AudioCD Layout
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AUTO
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ID Pause Start Title Length CP PE ISRC
00:04:41:414 X
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00:04:45:414
00:05:48:997
00:06:26:655
00:07:16:853
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01 Politik

02 In My Place
02 In My Place - 1
02 In My Place - 1
03 God Put A Smi
03 God Put A Smi
03 God Put A Smi

Regions ' CD-Tracks | AudioCD

Time Display

Step 2: Edit your audio files and improve the audio quality.

Use the Audio File Editor of DSP-Quattro to edit your audio files and to apply
its internal effects or your favorite Audio Unit plug-in to clean or to improve
their dynamics, modify their frequency spectrums, add reverbs and enhance

the stereo image, and more.

Paste | Compare

Fastand Smooth

Copy | Paste | Compare

Multiband Compressor

Band 1 Band 2B

Compression Levels

AUMultibandCompressor
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Audio Editor

MacOS X Finder

Audio Files

Step 3: Build the AudioCD layout.

Use the audio files, or simply their selections/regions to build the sequence
you want to burn on your AudioCD. By mouse dragging each region on the
AudioCD row on the table on the left of the Project main window, DSP-
Quattro will automatically add a new AudioRegion on the AudioCDLayout.
The, step to the AudioCD to set the cross-fades between Audio Regions to
avoid clicks and for the smoothest transitions between them just dragging
each AudioRegion waveforms back and forth on the time line. You can also
use DSP-Quattro for setting realtime non-destructive serial chains of effects
differently for each track, or on the AudioCD Layout output if you want to
apply the same effects to all the Audio Regions. You can choose the effects
among the real-time effects internal to DSP-Quattro or Audio Unit effect plug-
ins installed on your configuration.

Step 4: Save your work, burn and AudioCD or export as DDP.

As soon as your AudioCD layout suites all your needs, save your Project.
Then, you can export the AudioCD Layout as and audio file using the very
best audio audio format (DSP-Quattro allows you to save even with 32 float
sample bit precision), export each CDTrack as single audio file, choosing the
audio file format you prefer, including the iTunes Plus AAC, the format used
to upload the audio file to iTunes Music Store.

DSP-Quattro allows you also to burn an audio CD-ROM directly using your
Mac, without the need of additional software. The resulting audio CD-ROM
will be compliant with the Redbook standard, to guarantee the perfect
compatibility with all the audio CDROM players available on the market.
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If you need to distribute your AudioCD as a master Audio CD-ROM image,
export it as DDP. DSP-Quattro will then create a folder including all the files
needed, including CD-Texts, EAN-UPC, ISRC and PQ codes.

Using DSP-Quattro as Real-Time Digital Multi-Effects Unit

The chain of effects in the Master Out can be easily changed to use DSP-
Quattro as a Real Time Digital Multi-Effects Unit. All you need to do is to
open an Audio Input, set a couple of input, load the chosen effects in the
Master Out, and choose the output.

Output Recorder

* P Audio OUTs

Audio Inputs

il

all Audio Input Module

Insert Fx

Output Channels

Your Mac, without any other hardware or software, is now a Digital Multi-
Effects Unit. And since DSP-Quattro let you choose the input and output on
your audio board, this use allows you to turn the built-in real time effects or
your Audio Unit Effect plug-ins into a professional stand alone processing
units for your recording studio.

This possibility can be extended, because each Audio Input may have its
own insert effect chain. It allows you to set-up a fully customizable parallel
real time multi effect unit, with any limitation except the CPU power...

Even more, an external hardware effect unit can very easily be integrated
into the effect chain of DSP-Quattro, simply using its special internal module
to address hardware Input/Output devices of your mac.

In this way, the audio stream will be routed to a pair of L&R outputs and

taken again from a pair of L&R inputs, and external hardware will be seen
exactly as an internal plug-in.

Using DSP-Quattro as Software Synthesizer

As with what has been said before, you can open a Audio Unit Instrument
plug-in, set it to use it with a MIDI port and a MIDI channel, and play it in real

DSP-Quattro 5 User Manual

12




time listening to it through the output. You can even process it with the chain
of effects loaded in an Insert Effects chain (independent for each open
Instrument) or in the Master Out Effects chain, recording everything while
playing, if that's what you want!

Output Recorder

N

P Audio OUTs

MIDI

vy

Insert Fx

rVirtuaI Instrument Module

Insert Fx

Output Channels

Third party Audio Unit instrument plug-ins

You can play a Virtual Instrument plug-in in real time by using an external
MIDI control, or by using a sequencer. It is always possible to open several
different virtual Instrument plug-ins at the same time (even the same plug-in
more than once), and mix this configuration with the others. This allows you
to record what is played while listening to an audio file, or while singing into
a microphone connected to the Mac, or while you are playing a Virtual
Instruments and your friend is playing a guitar connected to an Audio Input
Module and using different effects on insert...

Efx

Paste Compare

Mic 1
Mic2 4

AUDIO SEND AUDIO RETURN

External Audio Send&Return
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What'’s

All of the above are possible simply opening, creating or closing Audio
Generators, and without worries about setting new systems or make audio
connections. All connections are automatically handled by DSP-Quattro.

All you need to do is open a new object to use it. And when you don’t need it
anymore, simply close it again.

next...

The next chapters deal with the different parts of DSP-Quattro, how they
work and how to use them. They describe the Audio Editor, the
AudioCDLayout, the Mixer, the different audio generator modules, all graphic
interfaces, software and hardware compatibility and so on. Also a complete
list of menu commands and the instructions about how to use them are
included.
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The Project

As already introduced, the Project is the document used by DSP-Quattro.
The Project is a container which includes all the objects you need to
accomplish your work. You start using DSP-Quattro creating a new Project
or opening an existing Project, and you must decide if you want to save or
discard the edits you did on your Project when you quit DSP-Quattro - or you
close the existing Project, of course.

The commands to create a new Project, to load an existing or to save the
current Project are on the top bar of the application, under the File menu:

@ DSP-Quattro NFEW Edit Options Window Help

[ BON ) New Project BN
Open Audio File...
Open Project... #0
Open Recent Projects »
Add ¢ X
Close Project #EW
» Il Audio Editor Save Project #S
Save Project As...
> i
Il AudioCD Layout Bl 4%S
v Il AudioFlles Revert to Saved Project
@ | Don't Know Why Share >

where:

- New Project (or 8N): to create a new empty Project Document. DSP-
Quattro will show a file browser asking for a project name and where to
save it. Immediately after it will show a new empty Project Document
window at full size on the main display.

- Open Project... (or 80): to open an existing Project Document. DSP-
Quattro will show a file browser asking to locate the Project Document to
open.

- Open Recent Projects: it shows a sub menu with the list of the most
recent Project Documents which DSP-Quattro opened, if they are still
available.

- Close Project (or 38W): to close the current Project Document. DSP-
Quattro will first ask if you wish to save the changes, if any.

- Save Project (or 38S): to save the current Project Document replacing
the source Project Document on disc.

- Save Project As...: to save the current Project Document with a different
name and, optionally, into different location. DSP-Quattro will show a file
browser asking for the file name and allowing you to choose the place
where to save the current Project Document.

- Revert to Saved Project...: to reload the last saved Project Document. It
is similar to an immediate undo up to the last time in which you saved the
current Project Document. NOTE: calling this command, DSP-Quattro
will clear the Undo/Redo history. In other words, you will loose all your
edits done after saving the last Project Document.
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On this menu there is also a command

- Open Audio File...: to open an audio file into a new Project if there is not
still an open Project, or on the current Project if there is already an open
Project. DSP-Quattro will show a file browser to select one or more audio
file to add on the Document Manger of the Project Document (more
about this later in this manual).

NOTE: it is not possible to have more than one Project open at the same
time. For this, calling the command to open an existing Project when there is
already an open Project, DSP-Quattro will first close the current Project,
asking if you wish to save the changes if needed.

The Project Document Window

The Project interface uses one main window. Even if DSP-Quattro also uses
some additional accessory floating windows like the Loop tool or custom
plug-in GUIs, most of the work is done on the main Project Document
Window.

The Main View:
The Document Manager AudioEditor, AudioCD, Mixer Output Channel Strips

Audio Editor AudicCD [}

Al § Remove @ » Outputs 1 Don't Know Why Example 5 - Kings Choir Effects
> Il Audio Editor »  Effects File 4 Edt 4  Commands § Processing 4

» Il AudioCD Layout

00:00:00:000 00:00:23:498 00:00:46:997 00:01:10:496 00:01:33:995 00:01:57:494 00:02:20:993 00:02:44:492
v I AudioFlles = =

 Example 5 - Kings Choir

> I Audiolnputs

v Il AudiolnputRecorders
InputRec - 1
00:01:04:426 00:01:20:532 00:01:36:639 00:01:52{746 00:02:08:852 00:02:24:959 00:02:41:065 00:02:57:
. it
> Bl Virtual Instruments

Mon 1 ®
Mon 2 ¢

Output Channels

0.00 Solo

“ Mute

Mono

4000 -INF

a

AudioEditor 0 6 17108 <>

L&R MainOUTs
T

Playback Marker start: 00:00:00- Y

00:01:55:498  ms oo

Transport Bar

The components of the Project Document Window are the following:

- The Document Manager: the Document Manager shows a list of the
audio generators which are open in DSP-Quattro. They can be audio
files, audio inputs, input recorders, virtual instruments.

- The Main View - the Audio Editor, the AudioCD Layout, the Mixer: it

is the main view of the Project Document window. It is possible to switch
the main among the Audio Editor, the AudioCD Layout and the Mixer.

DSP-Quattro 5 User Manual 16



- The Output Channel Strips: The Output Channel Strips view shows the
audio outputs of DSP-Quattro and allows the complete control of how
DSP-Quattro will play on output.

- The Transport Bar: it shows the buttons and sliders to control the
playback and the display to show information about current marker
position and the current playback time.

More about these components in the following chapters of this manual.

NOTE: it is possible to show, hide, resize each one of the above
components of the Project Document window. It is possible to resize their
sub views as well. Just click and drag with the mouse the border of the view
to resize it.

Each component has its own menu commands

Differently from the previous versions of DSP-Quattro, the top menu bar
contains only the commands for the Project management and for the options
which are shared among different Projects, like the audio settings.

It does not mean that DSP-Quattro has not all the commands to do audio
editing and audio mastering of the previous versions, of course.

Menu commands are now on the interface of the project component where
you can apply them. It means, as an example, that the commands to make
an editing on an audio file are on top of the AudioEditor view, the commands
to burn an audio CD-ROM using the AudioCD Layout is on top of the
AudioCD view, and so on.

In the next chapters each project component will be deeply described,
together with all the related menu commands.

The Project Document is a bundle

When you wish to edit your audio files, or you wish to build an AudioCD, you
load the audio files into the Project. Before to edit an audio file or to add it to
the AudioCD Layout, DSP-Quattro will automatically make a copy of each of
them into the Project bundle. Then, DSP-Quattro will not touch anymore
your source audio files, it will work on its internal copies: when you save the
edits on your audio files using the Audio Editor, DSP-Quattro updates the
internal audio files, not the source audio files.

So, to re-use the edited audio files outside DSP-Quattro, it is necessary to
export them back to MacOS finder, replacing your source files if this this is
what you want to do. This can be accomplished by a menu command or by
Drag&Drop the file from the Document manager table of the Project to the
MacQOS finder.

If you need, you can add to the Project also other objects as Audio Inputs
and Input Recorders modules, you can allocate and configure your Virtual
Instruments, load your plug-ins on insert to your audio sources or on output
channels. When DSP-Quattro quits or you close a Project, it is necessary to
save the Project if you wish to keep what you have done.

NOTE: please consider that to be able to restore again the current Project
document, DSP-Quattro will need also of all the AU plug-ins used on insert
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to all the channel strips which are part of this Project. These AU plug-ins
must be installed on MacOS when you will load again the same Project
document. It is also valid if you wish to load the same Project document on a
different mac. Also in this case, the Project document keeps all the
necessary audio files safe into its bundle, but the same AU plug-ins used by
the Project must be installed also on the Mac where you wish to restore the
Project.

Of course, DSP-Quattro will take care to restore the current presets for each
plug-in used into the Project by itself.
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The Output Channel Strips

On the right part of the Project window, you find the Output Channel Strips.
There are five Output Channel Strips: the L&R MainOUT and four Aux
channel strips.

The Output Channel Strips view shows the audio outputs of DSP-Quattro
and allows the complete control of how DSP-Quattro will play on output.

i Empty 2
Audio Editor AudioCD Mixer ()|

3 —

» Effects > Effects > Effects > Effects » Effects

Commands § Processing §

00:00:00 00:00:00

Mon 1 Mon 1 Mon 1 Mon 1 Mon 1
Mon 2 Mon 2 Mon 2 Mon 2 Mon 2
Output Channels Output Channels Output Channels Output Channels Output Channels

Solo 0.00 Solo 0.00 Solo 0.00 Solo 0.00 Solo

o =~ o o )

Mono

-INF

<

oy

Start 00:00:00 < L&R MainOUTs
End 00:00:00

By default, DSP-Quattro shows only the L&R MainOUT channel strip. Use
the rightmost button on the top of the Project window to show/hide the
Output Channel strips view:

Audio Editor AudioCD Mixer (] ()}

or you can drag the left border of the Output Channel Strips view to enlarge
or reduce it, showing/hiding it partially:
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|l Empty 2
Audio Editor AudioCD Mixer

Commands § Processing §

00:00:00 00:00:00

Mon 1

A
v
A
v

Mon 2
Output Channels

() 00

Playback Marker Start 00:00:00

— L&R MainOUT:
00:00:00 End:  00:00:00 y ==
C—

In DSP-Quattro, each channel strip has a common element: the Gain/VU
Meters control view:

The Gain Sliders, Peak and RMS Meters and other channel strip buttons.

Gain Sliders and VU Meters on the L&R MasterOut are really intuitive. The
elements of the MasterOut are the same as yo will see also on the channel
strips of the other elements of DSP-Quattro.

Using the Gain Sliders:

- Click&Drag: clicking and dragging the knob of the Gain Slider will
change the gain of the channel according to the dB scale.

- CTRL + click: jump to the default value of the channel gain slider, which
in this case is equal to 0 dB.

Using the numerical control above the Gain Slider:

- Click: a dialog window will prompt you to enter a new numerical value,
expressed in dB (float number).

Peak and RMS Meters:
On the right of the Gain Slider there are the Peak and RMS Meters. They

show the Peak and RMS levels of the Left and Right output signals of DSP-
Quattro. The Peak meters are innermost respect the RMS meters.
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) 00

L&R MainOUTs

Peak meters show the current max signal level, with the sample precision.
They have a release time such that when the signal goes down, they follow
smoothly. If the signal goes up, the follow immediately.

RMS meters show the ‘power’ of the signal. It is a very important measure
about how much the audio signal is ‘strong’. An audio signal can have very
high peak levels (even up to the distortion) but very low RSM values. In this
case, it sounds very weak. A good mastering engineer is able to rise the
RMS level without causing the distortion due too high Peak levels. Usually,
multi-band compressors plug-ins can help a lot about this.

In the upper part of the Vu-Meters there is a number that shows the peak
value in dB. This number shows the highest value reached or the highest
value reached in the last 3 seconds. By an option in the preference dialog,
you can set a flag to keep this value to the maximum. In this case, to reset
the last value shown, you need to click on it with the mouse.

Also there is a red peak level indicator that flashes if the signal exceeds 0dB.
Be careful not to let these indicators flash too often because even if DSP-
Quattro uses a special clipping algorithm, just like analog devices, any
abuse of the output levels, if not wanted, will cause the saturation and
distortion in the audio output signal.

The Panpot Rotary Control:

On top of the Gain Slider there is a rotary control, to set the balance
between the L&R channels, or panpot. Possible values are in the range
[-1.0..1.0], where -1.0 means that the only the L channel will play, 0 means
that both L&R channels will play at full volume, and +1.0 that only the R
channel will play.

It is also possible to use the numerical value above the rotary control to set
the exact value for the panpot.
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ON/OFF button:

At the bottom of the Gain Slider there is a button to turn On/Off the audio to
that channel strip.

Solo button:

Use the Solo On/Off button to switch or do not switch the audio from that
channel strip to the Solo bus. If there is one or more channel strips with the
Solo button ON, only the channel strips with the Solo ON will play at a
certain moment.

In other words, you can activate more than one Solo button on output
channel strips, in this case only these channel strips will play. As soon as the
channel strip Solo buttons are all turned OFF, all the channel strips will play
as by default.

Mute button:
Use this button to mute/un-mute that channel strip.

Mono button:
Use this button to mix the L&R channels into a single mono channel, which
will play on both L&R channels on the channel strip output. This is very
useful to verify the mono compatibility of the audio coming out from the
current mastering session.

L&R Phase Invert button:
At the bottom of each VU-Meter there is a button with a @ sign. Tuning ON
this button will invert the phase of that audio channel. Use this button to

check if there is a frequency cancellation when inverting the phase of one
channel, you should always avoid that.

The Output Device control

It allows you to set which audio connector of the output audio device DSP-
Quattro will use to play its Left and Right output audio channels.

Output-L
Output-R

Output Channels

Usually, if you have not configured any multi-outputs audio device, the two
popup-up menus show the standard L&R output ports. If an audio device
with several audio outputs ports is connected to your mac, you can set which
pair of audio ports the channel strip must address for playing its L&R output
channels.

NOTE: By default, DSP-Quattro uses the audio device which also MacOS is
using as standard device. If you wish to assign a different output audio
device to DSP-Quattro, you must first configure this by using the Audio
Device Settings dialog from the Options menu. See later in this manual to
know how to do this.
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The Aux Busses

DSP-Quattro allows to address up to four additional Auxiliary (AUX) channel
strips which play in parallel to the L&R MainOUT channels. Each AUX
channel strip can address its own pair of audio ports of the current output
audio device. An AUX channel strip has its own FX send, and has its own
settings about being in Solo, Mute and Mono modes.

Each AUX channel strip has the same feature and offer the same controls of
the L&R MainOUT channel strip.

As you would expect, each audio generator module can address the L&R
MainOUT channel strip or one of the four AUX Channel strips.

Using the AUX Channel strips, if you have a multi-output audio device
connected to your mac, you can configure DSP-Quattro to play different
modules on different audio outputs, applying also different effects on each
output.

Configuring the AUX Channel strips, if all them play thru the same port of the
output audio device, it is possible to apply different effects to different audio
generators just setting a different AUX channel strip as output on each
channel strip of the audio generator.
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The Document Manager

On the left part of the Project Document window, you find the Document
Manager panel.

By default, when DSP-Quattro opens a new Project window, the Document

Manager panel is visible. Use the left button of rightmost buttons on the top
of the Project window to show/hide the Document Manager panel:

Audio Editor AudioCD Mixer ([

or, to show/hide it, you can also drag the right border of the Document
Manager panel view.

$ Remove |

v I Audio Editor

AudioEditor

v Il AudioCD Layout

AudioCDLayout

v Il AudioFlles

o | Don't Know Why

¢ MyCount
Polaris BRASS 1-24-60
Polaris BRASS 1-27-60
Polaris BRASS 1-30-60
Polaris BRASS 1-33-60
Polaris BRASS 1-36-60
Polaris BRASS 1-39-60
Polaris BRASS 1-42-60
Polaris BRASS 1-45-60
Polaris BRASS 1-48-60
Polaris BRASS 1-51-60
Polaris BRASS 1-54-60

v [ Audiolnputs

Audiolnput - 1

Audiolnput - 2

v l AudiolnputRecorders
InputRec - 1
InputRec - 2
InputRec - 3

v Bl Virtual Instruments
ARP ODYSSEY
LuSH-101
Diva

Repro-5
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The Document Manager shows a list of the audio generators which are open
in DSP-Quattro at a certain moment. The different types of generators are
divided into the following categories:

- Audio Editor and AudioCD Layout: on each Project, there are always
one Editor of Audio Files and one AudioCD Layout. They are static
instance, you cannot trash or add them to the Project.

- Audio Files: this the list of the audio files used by the Project. DSP-
Quattro imports into the Project bundle the audio files used by the Audio
Editor and/or the AudioCD Layout. You can distinguish the imported audio
files by a green dot on the left of the audio file name. The audio files which
has not been imported have a blue Info button on the right of the audio file
name. Clicking on it, DSP-Quattro will reveal the position on the MacOS
finder of that audio file.

- Audio Inputs: these are the objects to get mono/stereo audio inputs from
the audio device, route the audio into the mixer and then to the output
channel strips of DSP-Quattro.

- Audiolnput Recorders: same as audio inputs, these objects are also
recorders.

- Virtual Instruments: Audio Unit Virtual Instruments, each with its own
MIDI settings.

Command buttons on the Document Manager

In the upper part of the Document Manager panel there two buttons, one to
Add a new element on the Document Manager table, one to Remove the
current selected elements from the table.

Clicking on the Add button on the top of the Document Manager table, it is
possible to select one of the following commands:

Add - ———
Import Audio File...

(& WNEHIE Import Audio File from Dual Mono L&R

o Import Audio File from Binary File

New Empty Audio File...

New Audio Input
New Input Recorder

AU Virtual Instrument

- Import Audio File...: to load an audio file from the HD. DSP-Quattro will
show a file browser, allowing you to select an audio file to add to the
Document Manager table. DSP-Quattro won’t import it into the Project
bundle, it will keep only a reference to the source file. DSP-Quattro will
import it into the Project bundle only if you will load the audio file on the
AudioFile Editor or on the AudioCD Layout (more about this later on this
manual).
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Import Audio File from Dual Mono L&R...: to load a stereo audio file
using two mono audio files, one for the left channel, one for the right
channel (dual mono). DSP-Quattro will show a file browser asking to
choose two audio files, then will add a reference to a dual mono audio
file to the audio file list. As above, DSP-Quattro won'’t import them into
the Project bundle, it will keep only a reference to the two source files.

Import Audio File from Binary File...: to load a mono/stereo audio file
from a raw binary audio file. DSP-Quattro will show an additional dialog
to set the parameters which it needs to play correctly the samples from
the binary file:

Bytes Order:  Little Endian (PC) d
Bit Depth: = 16 Bits d

Stereo/Mono = Stereo d Set

DDP Audio Binary File
Sample Rate: 44100 Hz

First Sample Offset: 0

where:

Bytes Order: can be LittleEndian (as used mostly on Windows and Intel
based Macs) or BigEndian (as used mostly by other Macs)

Bit Depth: 8, 16, 24, 32 or 32 floats - the bit depth of each sample on the
binary file.

Stereo/Mono: set the number of interleaved audio channels.
Sample Rate: set the sample rate used to play the audio file

First Sample Offset: set an offset to start reading samples from the
binary audio file. Set this value if the binary audio file has a header in
front of the audio sample which DSP-Quattro must skip looking for
samples.

On the right of this panel, there is a button to Set the current values to
the values used by the DDP standard. Use these settings if you are
importing the binary audio file generated exporting as DDP (Btw you
should use the “import DDP” function of the AudioCD Layout to do it).

New Empty Audio File...: DSP-Quattro shows a dialog to set a new
File Name and the parameters to fill the header of the new audio file, as
Bit Depth, SampleRate, number of audio channels (Mono or Stereo),
and then create a new audio file adding it to the Audio File list.

New Audio Input: to add a new Audio Input module to the Project. DSP-
Quattro will switch to the Mixer panel showing the new Audio Input
channel strip. By default, DSP-Quattro will mute the output of the added
Audio input module to avoid unwanted audio feedbacks on output.

New Audio Input Recorder: to add a new Audio Input Recorder module
to the Project. DSP-Quattro will switch to the Mixer panel showing the
new Audio Input Recorder channel strip. By default, DSP-Quattro will
mute the output of the added Audio Input Recorder module to avoid
unwanted audio feedbacks on output.
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- AU Virtual Instrument: DSP-Quattro will show a list of all 64 bits Audio
Unit Virtual Instruments installed on your system as returned by MacOS.
This list is ordered by Company producing the third party AU plug-in. If
there are not AU Virtual Instruments installed on you system, you will
see listed only the Apple Virtual Instruments installed by default on
MacOS.

To remove (delete) one or more elements from the Document Manager, first
select the element(s) to remove, then click on the Remove button on the
top of the Document Manager table. DSP-Quattro will show you a warning
and, if you click on OK, will remove the selected elements, cancelling the
reference to the source audio files if it has not been imported or trashing the
imported audio files if already copied into the Project bundle.

Using Drag&Drop to Import/Export audio files

Audio Editor AudioCD

» Outputs » Outputs » Outputs » Outputs >

Remove

» Effects » Effects » Effects > Effects >

v Il Audio Editor

v Il AudioCD Layout

AudioCDLayout —
< B = E ({1} =

L 4
I AudioFlles Indietro/Avanti Vista Disposizion¢

o | Don't Know Why

© MyCount
Polaris BRASS 1-24-60
Polaris BRASS 1-27-60
Polaris BRASS 1
Polaris BRA'!
Polaris BRA‘1
Polaris BRAJE
Polaris BRA!1
Polaris BRA“
Polaris BRA':
Polaris BRA‘.1

b
Polaris BRA‘ 11

Polaris BRAJHEL 12
o Untitied
v I Audiolnputs [ll 15
Aumalnput-. L
Audiolnput - g
vim AudlolnpulR!ﬂ
InputRec - 1
InputRec - 2
v Il Virtual Instr

ARP ODYSSEY

Preferiti
32 Dropbox
Gobbler
Q MacBook Pro

£ Tutti i miei file
< iCloud Drive

@ AirDrop

#~: Applicazioni
= Scrivania

ﬁj Steve

Libreria

@ Documenti
Utility

0 Download
Immagini
Plug-Ins

B Projects ios
Projects MacOS
Dispositivi

1 C+aun ManDAnl DDA

01 4VCOs - R C1.aif
02 4VCOs - R D#1.aif
03 4VCOs - R F#1.aif
04 4VCOs - R A1.aif
05 4VCOs - R C2.aif
06 4VCOs - R D#2.aif
07 4VCOs - R F#2.aif
08 4VCOs - R A2.aif
09 4VCOs - R C3.aif
10 4VCOs - R D#3.aif
11 4VCOs - R F#3.aif
12 4VCOs - R A3.aif
13 4VCOs - R C4.aif
14 4VCOs - R D#4.aif
15 4VCOs - R F#4.aif
16 4VCOs - R A4.aif
17 4VCOs - R C5.aif
18 4VCOs - R D#5.aif
19 4VCOs - R F#5.aif
20 4VCOs - R A5.aif
21 4VCOs - R Cé6.aif
22 4VCOs - R D#6.aif
23 4VCOs - R F#6.aif
24 4VCOs - R A6.aif

DSP-Quattro allows for the drag&drop of the audio files between the
Document Manager Panel or the Audio File Player/Editor and the MacOS file
system, on both directions:

A - Dragging one or more audio files from the desktop or from a folder on the
window of the Document Manager will load the file audio in the current
Project but will NOT open the new Audio File Player/Editor window. The
result is the same as using the command Import Audio File. If you wish
then to open it on the Editor window, double click on the file name inserted
on the Document Manager table.

B - Dragging one or more audio files from the Document Manager table to
the desktop or to a folder, DSP-Quattro will export those audio files. If a file
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having the same name already exists (if, for example, you drag the file to the
same folder of the source file), DSP-Quattro creates a new file having the
same name of the source file with an increasing number added to the end of
the destination file name.

Once opened an audio file in an Audio File Editor view,

A - Dragging one or more audio files from the desktop or from a folder on the
Audio Editor view, DSP-Quattro imports the audio file into the current Project
AND will opens the audio file in a new Audio File Editor Tab.

B - On the Audio Editor view, clicking on a waveform selection without
moving the mouse, after around 2 seconds the mouse pointer will change to
an hand. It is therefore possible to drag the selection from the Audio Editor to
the desktop or to a folder. In this case, DSP-Quattro exports the selection in
a new audio file with the same name of source file. If it already exists (if, for
example, you drag the file to the source folder), DSP-Quattro creates a new
file having the same name of the source file with an increasing number
added to the end of the destination file name.

C - Moreover, dragging the selection over the Document Manager table
instead of the MacOS file system, DSP-Quattro exports the selection into a
file which is internal to the Project and will automatically load the new file into
the current Project. You can use this shortcut to create new files trimming the
portions of the audio you want to export.

NOTE: it is even possible to drag the selection of only one channel of a
stereo file to export only that channel (or a part of it).

D — The above points B) and C) work also if the is not a selected waveform
on the AudioEditor waveform view. In this case, DSP-Quattro will export the
audio file from the beginning up to the end. This feature is very useful as
shortcut to the Audio Editor command ‘Export Audio File As...’, because it
saves a copy of the current audio file as it is in that moment.

You are highly recommended to spend some minutes to make some practice
with the extended Drag&Drop support in DSP-Quattro for exporting files
with an incredible speed. It is an irreplaceable tool which will allow you to
incredibly speed up your edits.
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The Audio Editor

Use the left of the topmost central buttons on a Project window to switch the
main central view to the AudioEditor of DSP-Quattro:

Audio Editor AudioCD Mixer

» Outputs

p  Effects i $ Commands § Processing §

00:00:00 00:00:00

)

20

AudioEditor
Playback Marker Start 00:00:00

00:00:00 e 00:00:00

If you have not already loaded an audio file into the AudioEditor, DSP-
Quattro will show an empty AudioEditor view.

To edit an audio file you need to load it first into the Project. This can be
done by a two steps procedure, or by using a single command of DSP-
Quattro, it will do both steps one after the other automatically.

1 - Two Step procedure:

first load an audio file into the Project Document Manager, then open it into
the AudioEditor doing one of the following actions:

- double-click on the audio file name on the FileList table
- drag the audio file name on the FileList table on the AudioEditor row
on the same table.
2 - SingleStep procedure:

- use the menu command File->OpenAudioFile... on the Application
menu bar:
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@ DSP-Quattro m Edit Options Window K
® e New Project #BN

Open Audio File...
Open Project... #0
Open Recent Projects >

Add &

Close Project ®’W
v Il Audio Editor Save Project %S
AudioEditor Save Project As...
Duplicate %S

v Il AudioCD Layout Revert to Saved Project

=

- use the command on the popup menu control File->ImportAudioFile->...
on the top of the AudioEditor main view:

Audio Editor AudioCD

p Outputs Polaris Squares 2-33-90

Fil
»  Effects — New Audio File

00:00:00 Import Audio File Import Audio File... ~380

Import Audio File from Dual Mono L&R

Save Current Audio File Edits ~3S Import Audio File from Binary File

Duplicate Current Audio File  ~3C
= Import Project Audio File
Export Audio File >
L Send To AudioCDLayout >

Close All

NOTE: on this sub-menu there is also a command to open an audio file
composed of two mono files. DSP-Quattro will use them as L&R channels of
a stereo audio file (Dual Mono L&R). There is another command to import a
RAW Binary audio file, and to select an audio file already loaded on the
Project. Please refer to the chapter describing the AudioEditor for a detailed
explanation of these commands.

- use the command OpenAudioFile... on the down arrow popup menu
control on the top right of the AudioEditor main view:

Audio Editor AudioCD Mixer

» Outputs Polaris Squares 2-33-90 Open Audio File...

»  Effects Fie 4 Edt 4 Commands 4  Processing 4 Project Audio Files

Close All
00:00:00 00:02:32 00:03:49
+ Polaris Squares 2-33-90

DSP-Quattro will open a file browser. Select the audio files you wish to edit.

NOTE: You can select multiple files by {++Clicking or 3+Clicking on the file
names.

Once opened the Audio Editor view will look something like this:
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L s b s g b | I SR i i T It i OO o S i T B
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AudioEditor

This window interface features four main areas:

- The overview: in the upper part of the window there is the waveform of
the audio file under editing. During all editing operations the overview will
show you the waveform of all the file, from the beginning up to the end.
The overview zooms in or out automatically if the file changes its length,
as in the case in which you do cut or paste, for example,

- The audio file editor Wave view area: in the middle part of the window
there is also the waveform view which, differently from the overview,
allows to zoom-in any region of the audio file. When the waveform zooms,
the underneath scroll bar can be used to scroll the view along the x-axis,
ie along the time. The audio file editor waveform area is the main part for
every editing operation. It is possible to set the level of zoom very easily
by using the mouse wheel, by using the commands in the menu, by the
keyboard, or clicking on the zoom buttons located in the lower right angle
of the waveform view area.

- The control section: in the lower and left part of the window, there are
three different sections: the transport bar, the counter display, and the gain
sliders and Vu-Meters section. By these commands it is possible to play/
stop the audio file, it is possible to set playback position, loop points and
markers, and set the output signal level as well.

The control section

The transport bar is the lower part of the audio editor window. This section
consists of the transport bar and the counter display which shows where is
marker as well as loop and playback points.

Playback Marker start: 00:00:03:157

00:00:03:157 End: 00:00:05:154
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The Transport Bar:

On the left part of the control section, there is the transport bar, which
consists of the buttons to control the playback:

Playback at normal speed, forward or reverse.

one click: Stop

double click: set the playback cursor at the
beginning of the file.

Playback at double speed, both forward and
reverse.

Go to the next or previous generic marker, or to
the beginning or end of a selection or of the file.

<

Toggle Cycle Mode ON/OFF. If the Cycle Mode
is ON, the playback, after reaching the end of
the region to play, restarts at the beginning
without interruption. Otherwise, it stops.

Toggle Audio Scrub Mode (slow motion mode)
ON/OFF. When Scrub Mode is ON, the playback
speed - on both directions — is controlled by the
ribbon controller which is located on the right
part of the control section.

Toggle PreRoll ON/OFF. If the PreRoll is ON,
when DSP-Quattro starts to play, the playback
starts 2 secs in advance respect the playback
cursor current position.

NOTE: The keyboard controls the playback as well:

- Space Bar: to toggle Play/Stop mode. If it stops, the playback cursor
returns to the position which it had when the playback started.

- Return Key: to stop the playback.

In the middle of this view there is the ribbon controller which controls the

playback speed.

Pitch

While playing at normal speed, moving the ribbon controller to the right
causes the increase of the playback speed - as well as the pitch. Instead,
moving it to the left causes the decrease if the playback speed as well as of
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the pitch. Releasing the mouse button will then reset the ribbon controller to
the central position. Keeping the cmd key pressed while dragging the ribbon
controller, releasing the mouse the ribbon controller will remain locked in the
last position.

NOTE: to lock the ribbon controller in a certain position, press the cmd key
when releasing the mouse.

If the Audio Scrub button on the transport bar is ON, the ribbon controller
works in almost the same way as before, but its center position is equal to
the stop position (playback speed = 0). Moving the controller to the right will
cause the slow playback in the forward direction, while moving it to the left
will cause the slow playback in the backward direction. By using the audio
scrub, it is very easy to place a playback cursor exactly where you wish,
since it is possible to listen the audio while moving slowly the playback
cursor. This helps very much to find with high precision the wanted position
on the waveform.

Using the ribbon controller, DSP-Quattro plays the audio file at a different
pitch, but also at a different speed. Raising the pitch will result in a faster
speed and shorter time duration, and vice versa. If there is the need of
changing the pitch without modifying the speed - or duration in time, instead
of this function, use the Pitch Shifting command which is on the Processing
menu of the AudioEditor. Instead, to change the speed but not the pitch, use
the Time Stretching command on the same menu. These functions will be
explained later in this manual.

The Counter Display

In the central part of the Control Section there is the Counter Display, which
shows the position of the playback cursor or of the current marker.

Playback Marker start: 00:00:03:157

00:00:03:157 End: 00:00:05:154

The Counter Display shows the position of the playback cursor in the main
part, while, in the 2 smaller sections on the right, it shows the positions
where DSP-Quattro will cycle playing the file. When you click on a different
marker on the upper waveform editor, the information on the Counter Display
- name and position — will change accordingly. Clicking and dragging the
mouse on the waveform view to make a waveform selection, the display will
show the length of the new selection on the main part, while the counters on
the right shows the selection start and end.

The default time unit is hours:minutes:seconds:milliseconds. It is also

possible to set Frames, Seconds, Milliseconds or AudioCD (CDDA) by the
command on the application menu bar Options->X-Axes Unit->...

@ DSP-Quattro File Edit m Window Help

—— L & / HH:MM:SS:MSEC
Y-Axis Units S Frames
v AutoZero  Milliseconds
Seconds

{
|

Audio Settings... 3D { AudioCD
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The Audio Editor Channel Strip
In the left part of the Audio Editor view there is the Channel Strip. It allows

you to control the output signal of the Audio Editor. It also shows the Vu
Meters for monitoring the signal level.

AudioCD Layout

Please refer to the previous chapter for the description of the Gain/Vu
Meters control view elements.

On top of the Audio Editor channel strip, there is a control to assign the L&R

outputs to the Output Channel Strips. Use this to address the L&R
MasterOut or one of the available AUX Channel strips.

v  Outputs

MainOUT
Aux1 Aux2

Aux3 Aux4

Below it there is the interface to manage the effects on insert to the Audio
Editor output. Click on the white triangle on the left to disclose the FX view.

These effects process the output of current audio file, and each audio file
loaded into the Audio Editor has its own FX chain on insert. It is possible to
use this chain of effects as edit function, processing the audio file rendering
it into a new audio file. It is also possible to copy this chain of effects in the
custom FX clipboard of DSP-Quattro. In such ways it is possible to duplicate
it into another FX chain on insert to a different object.
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v Effects

)" File Cmds
Insert FXs

h Edit Fx-1
Parametric EQ %

¢y 'Edit Fx-2
AUDelay 4

() Edit Fx-3
PSP Vi...amer2 §

Edit Fx-4

Please refer to the previous chapter for the description of the insert FX view
elements and about using it.

The overview

The waveform overview is in the uppermost section of the Audio Editor view:

00:00:00:000 00:00100:952 00:00:G1:904 00:00:02:857 00:00:03:8013 00:00:04:761 00:00:05:714 00:00:06:666) 00:00:07:619 00:00:08:571 00:00:09:

This view is a waveform view without the zoom in/out control. However it is
always possible to use the waveform overview to make new waveform
selection, move the markers or the playback position, and even set the zoom
for the underneath main waveform view area.

At the top of the waveform there is the Time Ruler. To set the unit used by

the time ruler use the application menu command Options->X-Axis Unit.
Possible values are hours:minutes:seconds:milliseconds, Frames, Seconds,
Milliseconds or AudioCD (CDDA). On the right side there is the Level Ruler,
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that shows the level of the signal, accordingly to the unit set in the menu
Options->Y-Axis Unit. Possible values are Floats (normalized into the
range [-1.0..1.0[) and dB (decibel).

Below the waveform display, there is a special Zoom Controller, that can be
used to set the zoom level of the main zoomable waveform view area. This
control highlights in orange the region that the main waveform view area
displays. By clicking on it and then dragging the mouse, DSP-Quattro sets
the position where the main waveform view must scroll and its zoom level.

The zoom controller is really easy to use:

- passing on the zoom controller with the mouse, the mouse pointer turns
into a magnifying glass.

- clicking on it and dragging the mouse, the control draws an orange
region. Then, releasing the mouse button, the main waveform view scrolls
to the position where the orange region starts and zooms up to display

waveform corresponding to the region on the overview having the same
width of the orange rect of the zoom controller.

-+ mouse click and dragging, will scroll the zoomed area over the new
region pointed by the mouse, without modifying the zoom level.

The use of the markers will be discussed later.

The Audio Editor main waveform view area

04:063 00:00:04:643 120:00:05:224 00:00:05:804 00:00:06:385 00:00:06:965 00:00:07:546 00:00:08:126
N TS AT AT R E i)

As for the overview, the Audio Editor main waveform view area shows the
waveform. This view however can be used to zoom in any part of the
waveform, up to one sample per pixel and even more. Both axes have an
independent zoom levels. The vertical axis can be zoomed-in without limits,
it is even possible to see the quantization noise in the audio file.
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There are several ways to zoom In/Out:

- Using the mouse wheel: to set the horizontal X-Axis zoom-in/out ratio.
The same can be done moving vertically 2 fingers on the Apple Trackpad,
if connected. Do 8 + mouse wheel to set the vertical Y-Axis zoom-in/out

ratio.

- Using the +/- buttons: use the +/- at the bottom right of the waveform
view to zoom in/out horizontally on the X-Axis or vertically on the Y-Axis.

- Using the menu commands: click on the Commands button which is on
top of the waveform overview to show the popup menu, and select the
Zoom sub menu to see the available commands to zoom in/out on both

axis:

pippo region

A i A
v v Commands

00:00:00:000 00:00:01:335

oo:oo:o4:oei3 00:00:04:643

Playback Cursor
Generic Markers

Regions

Turn Loop OFF
Lock Loop Length
Loop Selection

Show Loop Window

Select All
Select Loop

Rebuild Graphic Overview

paperino region

>
>
>

>
8L

XL

{a8L

XL

#A
38A

X-Axis Zoom In
X-Axis Zoom Out =

X-Axis Full Zoom In
X-Axis Full Zoom Out

Y-Axis Zoom In ®B+
Y-Axis Zoom Out 0=

Y-Axis Full Zoom Out
XY-Axis Full Zoom Out  ~3 -

Fit On Selection #=
Fit On Loop

- X-Axis/Y-Axis Zoom In/Out will increase or decrease the zoom in/out
ratio by a factor 2 (it will magnify the waveform by a factor x2 or will
zoom-out by a factor x0.5)

- Full Zoom In/Out: it is a shortcut to the maximum/minimum possible

level.

Both functions are available for the X-Axis X (horizontal), Y-Axis (vertical) or
in pair (XY-Axis Full Zoom Out).

There are also some functions to fit the zoomed area to a special region of

waveform:

- Fit On Selection: to zoom in/out on the current selection. This
command is not available if there is not a selection.

- Fit On Loop: to zoom in/out on the loop region. This command is not
available if the loop is turned OFF.

- Using the Keyboard shortcuts: you can use the keyboard as shortcut
to the above menu commands.

After zooming the waveform, the scroll bar a the bottom of the main
waveform view lets you to scroll the view to another position.
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Do not forget the shortcut of using the Zoom Controller on the waveform
overview section for doing faster zoom in/outs!

NOTE: you can scroll the view also by clicking and dragging the Time Ruler.
The effect is the same as using the scroll bar, but often it is smoother and
very much more precise.

While playing, the Audio Editor waveform view area will scroll following the
playback cursor.

In the area at the bottom of the main waveform view, on its left, you can see
information such as the sample rate, bit depth and total length of the audio
file under editing.

The button AutoZero lets you to toggle On/Off the AutoZero options when
placing markers and selection start/end (more about this later in this
chapter).

The button Info open the side panel on the right of the main waveform view,
described here below.

Making a waveform selection

Let's define “selection” as a region of the audio file which we wish to edit.
Most of DSP-Quattro editing functions work on the selection, if there is one.
Otherwise, they works on the whole audio file.

There are several ways for making make a selection: by clicking and
dragging the mouse, by using menu commands or by using keyboard key
commands.

A selection can be done on the main waveform view area or on the
waveform overview. Since both views refer to the same file, a selection done
on one waveform view be visible also on the other waveform view as well.
Doing a selection on the main waveform view area, and dragging the mouse
pointer outside the right or left borders, the view will scroll. The scrolling
speed will increase/decrease accordingly to the distance from the waveform
border.

NOTE: If the is already a selection, {++click will extend the selection up to
the point where you are clicking. If there isn’t already a selection, {*+click
creates a new selection between the playback cursor and the point where
you are clicking on.

NOTE: you can also select the left or right channel of a stereo audio file
independently. To make a selection of the right channel only, click and drag
on the topmost part of the waveform of the right channel. To make a
selection of the left channel only, click and drag the bottom part of the
waveform view. In the case of a selection of the left or right channel only, if
applicable, the edit function will process only that channel.

Doing a selection by clicking and dragging the mouse, the Counter Display
will show in real time the length, the starting and ending point of the current
selection.

NOTE: A double mouse click selects the portion of waveform between the

two closest markers - the previous and the next one. If there aren't any, the
all the waveform is selected. A triple mouse click select all the waveform.

DSP-Quattro 5 User Manual



) . -
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00:00:01:306 00:00:01:523 00:00:01:741 00:00:01:959 00:00:02:176 00:00:02:394 00:00:02:612 00:00:02:¢29 00:00:03:047

By clicking on the Commands button which is on top of the waveform
overview, you can use the following menu commands to do selections:

- Select All (or 38A): creates or extends the current selection to all the
waveform.

- Select Loop (or {+3A), available only if Loop has been turned On,
select the region of the Loop.

The audio file Info side panel

Clicking on the Info button located at the bottom left of the main waveform
view, or on the rightmost button among the three buttons located at the top
of the Audio Editor, a side panel will open on the right of the waveform view
itself. This side panel has three tab buttons, use them to switch the
underneath views among the audio file Info view, the Markers view, and the
Regions view.

One of the two buttons used to open the side panel will close it if pressed
again.

The audio file info panel is divided into two parts: on top you see read-only
info: the audio file name, the length expressed in hh:mm:sec:msec and
frames units, the audio file format, sample rate and bit depth. The bottom
part shows user editable settings: CD-Texts and ID3 Tags. Click on the
editable fields to enter the new value, and hit return (or click outside the
popup view used to enter the new text) to confirm.

NOTE: please consider that exporting the audio file, not all the different
audio file formats support the CD-Text and ID3 Tags information.
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Info Markers Regions

Audio File Name:
Time
Audio File Length:
Frames
File Format:

Sample Rate:
Bit/Sample:

Title:
Performer:
Songwriter:
Composer:

Arranger:

Childrens v

ID3 Tags

Working with Markers

The other two tabs on top of the Info side panel switch to the Markers and
Regions view.

An audio file can define several types of markers that points to different
location of the audio file itself.

Markers can be:

- Playback Cursor (RED marker) - it is always positioned at the current
playback position.

- Generic Markers (BLUE markers) - each generic marker is identified
by a location and a name.

- Region markers (ORANGE markers) - a region is a portion of the
audio file which is identified by two markers, one at region start, one at
region end, and by a region name.

- Loop markers (YELLOW markers) - A Loop is a portion of the audio
file to cycle when playing it. It is identified by two markers, one at loop
start, one at loop end.

NOTE: DSP-Quattro is compliant with the standard when it reads/writes
markers informations from/to PCM uncompressed audio files (AIFF, WAVE,
CAF). These audio files can be exchanged among different audio
applications and software/hardware samplers, maintaining the information
about loop and other markers.
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Time
Playback:
Frames

End

Length

Commands §

NOTE: DSP-Quattro gives you an option of Auto Zero. When this option is
ON, setting the position of a marker or of the selection, DSP-Quattro will
automatically shift it to the previous point of Zero Crossing. A Zero Crossing
point is the location in which the waveform passes thru the zero level
changing its sign. This option is very useful when you wish to place markers
in a position that has a shared zero level.

To activate the option of Auto Zero, use the AutoZero button at the bottom of
the main waveform view of the Audio Editor, or go to the menu Options-
>Auto Zero, or to use the combination of keys U. This command toggles
the AutoZero ON/OFF. When the option is active, a check mark appears in
correspondence of the command in the menu.

The Markers view shows the Loop and the Generic Markers, the Regions
view shows the Regions markers.

On the Marker view there are two main parts: on top there is a part to show
the current values of the markers which always exist: the playback cursor,
the Loop markers (they are visible only if the Loop is ON) and the current
waveform selection. The bottom parts has a table showing the Generic
markers list, and a Command button to edit the Generic markers.

Click on the numerical field of a marker to edit its value. DSP-Quattro will
show a popup:
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0000:02:962 Time

Playback:

Frames

Use the tab key to move from one field to the next, the enter key to close the
popup.
Menu commands to place the playback cursor:

There are several menu commands to move the playback cursor at specific
points of the audio file.

Clicking on the Commands button on the top of the waveform view,
disclosing the Playback Cursor submenu, you can:

Commands

Rebuild Graphic Overview

00:00:00:000 00:00:01:335 Zoom

Playback Cursor

Generic Markers
Go To Next Marker #¥K
Regions > Go To Prev Marker 3K
Turn Loop OFF #L Go To Selection Start
" - Lock Loop Length  \_{*36L Go To Selection End
PR -00:01- par Loop Selection {3L
00:00:00:000 00:00:01:335 :00: P Go To Loop Start
Show Loop Window 8L Go To Loop End

Select All #BA
Select Loop {#8A

- Go To Start: to move the playback cursor at the beginning of the audio
file.

- Go To Next Marker (or 3K): to move the playback cursor to the
position of the next marker.

- Go To Prev Marker (or {+3K): to move the playback cursor to the
position of the previous marker.

- Go To Selection Start: to move the playback cursor to the beginning of
the current audio selection. This command is not available if there is not
an audio selection on the waveform.

- Go To Selection End: to move the playback cursor to the beginning of
the current audio selection. This command is not available if there is not
an audio selection on the waveform.

- Go To Loop Start: to move the playback cursor to the Loop start. This
command is not available if the Loop is OFF

- Go To Loop End: to move the playback cursor to the Loop end. This
command is not available if the Loop is OFF
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Into the Loop section there are also a button to turn On/Off the loop (the
yellow start/end loop markers will appear/disappear on the waveform views)
and to lock/unlock the loop points and loop length.

If one or both start/end loop markers is locked, the corresponding marker
cannot be dragged or moved. If the loop length is locked, setting the start
loop marker position will set also the end loop marker accordingly. And, of
course, also the contrary.

The Generic markers table

In the bottom part of the Marker view there is the Generic markers table:

Commands §

Time

All fields are editable. Just click on the filed you wish to edit, DSP-Quattro
will show a popup to enter the new setting.

On the right of each generic marker name there is an arrow which turns on
red if the corresponding generic marker is the current selected generic
marker. If you click on a blue generic marker on the waveform view, that
becomes a selected generic marker.

NOTE: it is possible to define a group of generic markers, selecting all them
at the same time, just keeping the cmd or the shift key pressed while clicking
on the arrow on the left part of the generic marker row - or on the blue
generic markers on the waveform view.
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If there are more than one generic marker selected in a certain moment,
dragging one of them on the waveform view, will shift along the time axis
also the others, accordingly.

Generic markers can be locked. In this case, it is not possible to change
their position, and it is not possible to move or drag them on the waveform
view. If in a group there is a locked generic marker, it is not possible to move
the others as well.

Clicking on the Commands button on top of the generic markers table, DSP-
Quattro shows a menu:

Commands

New At Playback

New At Selection Bounds
New At Selection Start
New At Selection End

New At Loop Bounds
New At Loop Start
New At Loop End

T -

Select All
Unselect All

Remove Selected
Remove All

Lock Selected
Unlock Selected

Markers To Regions
Selected Markers To Regions

Markers to AudioCD Layout

Using these menu commands you can (these menu items are greyed-out if
the command not applicable):

- New At Playback (or 8M): it creates a new generic marker in
correspondence to the playback cursor

- New At Selection Bounds (or ~8M): If there is a selection, it creates
two new generic markers in correspondence to its start and end. If there
is not an audio selection on the waveform, this command is not available.

- New At Selection Start: if there is a selection, it creates a generic
marker in correspondence of the selection start. If there is not an audio
selection on the waveform, this command is not available.

- New At Selection End: if there is a selection, it creates a generic marker
in correspondence of the selection end. If there is not an audio selection
on the waveform, this command is not available.
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File ¢

00:00:00:000

New At Loop Bounds (or \_88M): if the Loop is On, it creates two new
generic markers in correspondence to the loop start and end. If the Loop
is OFF, this command is not available.

New At Loop Start: if the Loop is On, it creates a generic marker in
correspondence of the loop start. If the Loop is OFF, this command is not
available.

New At Loop End: if the Loop is turned On, it creates a generic marker
in correspondence of the loop end.If the Loop is OFF, this command is
not available.

Select All: to select all the generic markers, ie it groups them all together.

Unselect All: to unselect all generic markers. If there are not selected
markers, this command is not available.

Remove Selected (or 1+ 38M): to remove (delete) the selected generic
marker(s). If there are not selected markers, this command is not
available.

Remove All (or ~ 1+ 3M): to remove (delete) all generic markers

Lock Selected: lock the selected generic markers. If there are not
selected markers, this command is not available.

Unlock Selected: unlock the selected generic markers. If there are not
selected markers, this command is not available.

paperino region MyCount 1 Don't Know Why

E] Commands - - .
M, Rebuild Graphic Overview

a a - Playback:
00:00:01:335 [y, Zoom > 00:00:06674 00:00:0:013 00:00:09
>

[ Playback Cursor m_
‘ Generic Markers > New At Playback #M

| Regions > New At Selection Bounds ~M
' New At Selection Start

NN Ty Loop OFF #L New At Selection End

00:00:00:000

Lock Loop Length  X{r88L

Loop Selection L New At Loop Bounds X#M §

New At Loop Start Length
New At Loop End

00:00:01:335 100:00:02

Show Loop Window (8L

Commands 4

Select All BA
Select Loop 0O 8A

o

Select All
Unselect All Time

Remove Selected
Remove All

Lock Selected
Unlock Selected

Markers To Regions
Selected Markers To Regions

1:589 <>
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- Markers To Regions: creates new regions accordingly to all the generic
Markers on the list. Each region will extend from one generic marker to
the next one on the list.

- Selected Markers To Regions: it does the same of the “Markers To
Regions” command, but uses only the generic markers which are also
selected.

- Markers to AudioCD Layout: creates AudioRegions and CD-Tracks on
the AudioCD from the generic markers list, one for each marker. Each
AudioRegion of the AudioCD will extend from one generic marker to the
next one on the list. DSP-Quattro allows you to choose between clear the
AudioCD before to build it, or to append the new AudioRegions to the end
of the current AudioCD.

The same commands are available from the Commands button on top of the
waveform view.

NOTE: the “Markers to AudioCD Layout” command on the menu on top of
the Generic markers table is replicated on the “Generic Market List to
AudioCDLayout* on the File->SendToAudioCDLayout->... menu from the
File button on top of the waveform view:

pippo region paperino region

New Audio File >

Import Audio File > 00:00:05:342

Save Current Audio File Edits ~3S
Duplicate Current Audio File  ~8C

Export Audio File >

e 5€Nd To AudioCDLayout Append As AudioRegion

Append Only Selection As AudioRegion
Close All

00:00:00:000 00:00:07:335 00:00:UZ:6/1 Generic Markers List To AudioCDLayout 2:0

Audio Regions List To AudioCDLayout I

Working with Regions

As already introduced, a region is a portion of the audio file which is
identified by two markers, one at region start, one at region end, and by a
region name.

Markers Regions

Commands §

Name Time

¥ This is the region name V-
This is the region name - Start 00:00:01:288
This is the region name - End 00:00:02:302
This is the region name - Length  00:00:01:014

¥ Region - 2 vo-
Region - 2 - Start 00:00:04:426
Region - 2 - End 00:00:06:258
Region - 2 - Length 00:00:01:831

¥V Region -3 v -
Region - 3 - Start 00:00:07:348
Region - 3 - End 00:00:09:159
Region - 3 - Length 00:00:01:810
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The Regions table
One of the tabs on top of the Info side panel switch to the Regions view.
DSP-Quattro allows you to add and remove audio regions, edit region name,
show/hide the region markers on the waveform view. There are also several
commands dedicated to audio regions.

For each audio region, there is a row on the table:

Name Time

V¥ This is the region name v -

This is the region name - Start 00:00:01:288
This is the region name - End 00:00:02:302
This is the region name - Length  00:00:01:014

Click on the white arrow on the left side of the region row to expose/collapse
the details about the region start and end positions, and the region length.

Click on the blue check mark on the right of the region row to show/hide the
region markers (the orange markers) on the waveform view.

The minus (-) button on the right of the region row will remove (delete) the
audio region.

You can edit the audio region name, the region start, the region end
positions and the region length just clicking on the corresponding text or
value, DSP-Quattro will show an editable popup view.

Clicking on the Commands button on top of the generic markers table, DSP-
Quattro shows a menu:

Regions Commands §

New From File
New From Selection
New From Loop

Name

¥ This is the region name
This is the region name - Stal Show All
This is the region name - End [EEETTe 9|

This is the region name - Leng

¥ Region-2 Remove Visible

Region - 2 - Start Remove All
A E=EE Regions List To AudioCDLayout
Region - 2 - Length

¥ Region-3 Export Regions List To Audio Files...

Region - 3 - Start New Project Audio Files from Regions List
Region - 3 - End 00:00:09:159
Region - 3 - Length 00:00:01:810

- New From File (or \_4*88U): to create a new audio region starting at the
beginning of the audio file and ending at its end.

- New From Selection (or \_38U): to create a new audio region starting at
the beginning of the current selection and ending at its end. This
command is not available if there is not an audio selection on the
waveform.

- New From Loop: to create a new audio region starting at the beginning
of the Loop and ending at its end. This command is not available if the
Loop is Off.
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- Show All (or ~38U): to make all the audio region markers visibile on the
audio waveform view.

- Hide All (or ~{>38U): to hide all the audio region markers on the audio
waveform view.

- Remove Visible: to remove (delete) all visible audio regions.
- Remove All: it removes (deletes) all audio regions.

- Region List to AudioCDLayout: creates AudioRegions and CD-Tracks
on the AudioCD from the audio regions list, one for each audio region.
DSP-Quattro allows you to choose between clear the AudioCD before to
build it, or to append the new AudioRegions to the end of the current
AudioCD.

The same commands are available from the Commands button on top of the
waveform view.

Rebuild Graphic Overview

00:00:00:000 00:00:01:335 Zoom

Playback Cursor
Generic Markers

Regions New From File X {3U
New From Selection 38U

Turn Loop OFF 8L New From Loop
: ‘ Lock Loop Length Q3L
OO 000 OO0 01396 Loop Selection {8L Show All ~3U

. Hide All ~{r38U
Show Loop Window  \C&8L

Remove Visible

Remove All
4

NOTE: the “Region List to AudioCD Layout” command on the menu on top of
the Generic markers table is replicated on the “Audio Regions List to
AudioCDLayout* on the File->SendToAudioCDLayout->... menu from the
File button on top of the waveform view:

Select All 3#BA
Select Loop {38A

New Project Audio File

Import Audio File

Save Current Audio File Edits
Duplicate Current Audio File  ~3C

Export Audio File

Append As AudioRegion
Append Only Selection As AudioRegion

Generic Markers List To AudioCDLayout
Audio Regions List To AudioCDLayout
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Working with the Loop

The Audio Editor of DSP-Quattro uses two different concepts for cycling on a
certain region of an audio file: the Loop and the Cycle.

Cycle Mode and the Loop

The Loop is a region of the audio file to cycle when playing it. It is identified
by two markers, one is the loop start, the other one is the loop end (the
yellow markers on the waveform view). These two markers are saved into
file, and into the Project.

Also the Cycle is a portion of the audio file to cycle when playing it, BUT it is
not identified by any marker. It is simply a region which DSP-Quattro will play
again and again without interruption.

The Loop can be ON or OFF accordingly to On/Off button on the audio file
Info side panel, under the Markers tab:

The Cycle can be ON or OFF accordingly to the state of the Cycle button on
the Transport bar:

<

Q: When DSP-Quattro plays cycling on the Cycle or cycling on the
Loop?

A: let’s start from what DSP-Quattro will play:

1) If there an audio selection, DSP-Quattro plays that audio selection
ONLY, starting at the beginning of the audio selection and ending at its
end.

Then, if the Cycle is ON, DSP-Quattro will play cycling on that audio
selection, otherwise it will stop as soon as it reaches the end of the
selection. This will happen no matter if the Loop is On or Off.

2) If there is not an audio selection, DSP-Quattro will play the audio file
starting at the beginning of the audio file. Then:

- If the Loop in ON, DSP-Quattro will play cycling on the Loop (yellow
markers on the waveform view).

- If the Loop is OFF, DSP-Quattro will play the audio file up to the end,

then it will cycle starting again at the beginning of the audio file ONLY if
the Cycle button is ON.
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- If the Loop is OFF and Cycle button is OFF, DSP-Quattro will stop to
play as soon as it reaches the end of the audio file.

NOTE: if there is an audio selection on the waveform view, DSP-Quattro will
play that selection only, cycling on it if and only if the Cycle button is ON.

NOTE: and, if there is an audio selection on the waveform view, when
playing that selection, DSP-Quattro will not consider the Loop (yellow
markers) settings, even if the Loop is ON.

Often it is useful to cycle on a selection, sometimes you want to cycle on the
loop.

An example will help you to better understand the difference between the
two concepts: let's say that while listening you find out that there are some
clicks that shouldn't be there and that you want to find out their position. In
such case, you can select the zone around the suspect point, and while
listening to DSP-Quattro playing that region again and again (setting the
Cycle ON) you can find out the point that causes the click. Instead, let's
suppose that you have recorded a drum pattern, and that you want to use
that pattern later, as loop in an arrangement. You will than have to set and
activate a Loop in such a way that DSP-Quattro will play that region of the
file again and again, repeating that drum pattern. You may also want that
that Loop is saved into the file, to be used by an external software or
hardware sampler. In this case, turn the Loop ON and use the yellow
markers and the editing commands to set the Loop to set the loop point,
without using any selection on the waveform view.

Clicking on the Commands button on top of the waveform view, DSP-Quattro
shows a menu which includes the following commands to set the Loop:

4 $ Commands

Rebuild Graphic Overview

00:00:00:000 00:00:01:335 Ry Zoom

Playback Cursor
Generic Markers

Regions

Turn Loop OFF
Lock Loop Length  C{r88L
Loop Selection 3L K

[ g .
00:00:00:000 00:00:01:335 00:00:07

Show Loop Window  \C38L '

Select All #A
Select Loop {0 8A
I S | :

- Turn Loop ON/OFF (or 38L): to toggle the Loop ON and OFF. If the Loop
has been turned ON, the two Loop markers (the yellow markers), will appear
on the waveform view. Otherwise, DSP-Quattro will hide them.

- Lock Loop Length (or \_{+ L) to lock/unlock the length of the Loop. If
the Loop length is locked, moving any one of the two Loop markers, the
other one will move accordingly. This option is useful in the case that, once
you have found a good Loop, you wish to shift the Loop without changing its
length. This command is not available if the Loop is OFF.

- Loop Selection (or {+3L): to place the Loop markers at the current
selection start and end. (This command is not available if there is not a
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selection on the waveform view). If the Loop is turned Off, it will
automatically be turned On.

- Show/Hide Loop Window (or \_3L): to show or hide the Loop floating
window tool. More about this here below.

The Loop Window

DSP-Quattro gives you a special tool for placing Loop points: the Loop
Window and a very special X-Fade Looping tool. In this chapter the Loop
Window will be described. To know about the X-Fade Looping tool, please
refer to the chapter describing the X-Fade Looping editing function of DSP-
Quattro.

This tool allows you to monitor anything that happens to the waveform in
correspondence of the Loop point.

NOTE: the window is of floating type, this means that it is always visible on
top of the Project window. You can also work on the AudioEditor view at the
same time.

Any operation in the Audio File Player/Editor, even the drag of a Loop
marker, will result in a real time change in the Loop window, and vice versa.

[) [ ] Loop Tool

The Loop Window (fig. A)

This window consists of two parts, the left and right parts, divided by a
yellow marker that corresponds to the loop point, where DSP-Quattro jumps
back cycling: the left side of the view shows the final part of the waveform as
it is before the Loop End point, the right side of the view shows the part of
waveform as it is immediately after the Loop Start point.
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When playing the Loop, DSP-Quattro plays the samples up to the Loop End
point, then it jumps and restarts to play from the sample at the Loop Start
point. The Loop Window shows you what DSP-Quattro will play when it
reaches the Loop point, showing you the visual continuity of the waveform
which plays. If the two points of Loop Start and End don't coincide or don’t
grant a continuity to the waveform, as for example in the figure A above, it is
clear that a very unpleasant click will be heard at loop point as soon as DSP-
Quattro will cycle jumping to the Loop Start.

00 @ Loop Tool

The Loop Window (fig. B)

On the other hand, if the loop points are moved in such way to give a
continuity to the waveform, as shown in figure B, we may expect that the
audio will not produce an audible click at Loop as soon as DSP-Quattro will
cycle playing the file.

Unfortunately the visual continuity is not always enough to guarantee that
the Loop will play without clicking, but surely the Loop Window is an
essential tool to position the loop points at a very good position.

After this, you can use the X-Fade Looping algorithm of DSP-Quattro to
make Loop which will play absolutely perfect in most of the cases. But, of
course, a certain experience is necessary to find the “perfect" Loop,
especially for audio files which are harmonically complex, as in the case of
samples of strings or acoustic piano.

The Loop Window has its own vertical Y-Axes zoom level a custom transport
bar to move the start/end points:

- on the left there are the buttons for the vertical zoom in/out
- At the bottom of each half Loop view there are the buttons for setting the

loop point current position, more precisely to set the Loop End for the left
view and the Loop Start for the right view:

|< << < > >> >|
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Respectively, from left to right, these buttons allow you:

- to Move the Loop point on the previous Zero Crossing position. The Zero
Crossing is the point in which the waveform passes thru the zero, changing
its sign. This command is very useful to find the continuity of the waveform
finding two different points of crossing of the level zero, if the the slope of the
curve is the same at the end and loop positions. The waveform of a perfect
loop has always the same level and same slopes at loop point, and the point
of zero crossing can be very useful for having a shared reference point for
placing both start and end loop points.

- To quickly move the Loop point backward.

- To slowly move the Loop point backward.

- To slowly move the Loop point forward.

- To quickly move the Loop point forward.

- To move the Loop point to the next point of Zero Crossing.

NOTE: you are able to drag forward or backward the Time Ruler of every
Loop view. The respective Loop point will move accordingly.

NOTE: to place the loop points in the right place is only the first step to have
a file playing perfect when jumping at loop. After placing the loop markers,
use the X-Fade looping algorithm (see the processing function in the
following chapters) to smooth the waveform at loop boundaries. Surely, the
result will surprise you.

Editing an Audio File using DSP-Quattro

This chapter describes in deep all the functions of audio editing offered by
DSP-Quattro and how to use them.

Audio File Formats

DSP-Quattro loads audio file previously saved using almost all known
formats, starting from the PCM uncompressed formats, like AIFF, WAVE or
SDII (SoundDesigner 1), having 8, 16, 24, 32 and 32 float bits/sample, and
any sample rate, to compressed audio file formats as mp3, MPEG-4, mp2,
ac3, aifc, 3gp, mpa, mp4, caf, 3g2, m4a, AAC...

DSP-Quattro takes care to do all necessary conversion loading an audio file,
and this process is totally invisible to you.

As a special option, DSP-Quattro is able to import an audio file as RAW
data. It means that DSP-Quattro will read the file, loading it sample by
sample without looking for an audio file header, as it usually does. It is useful
to recover corrupted PCM files where the header is no longer valid. The
RAW data import DOES NOT work at all the formats which are not PCM-
based, ie if the source file is encoded or compressed by some techniques.
See the following paragraph to know how to import an audio file as RAW
data.

When DSP-Quattro needs to edit an audio file, it imports the source audio
file into the Project, translating it to the internal uncompressed CAF 24 bits
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audio file PCM format. This is because the CAF guarantees the maximum
audio fidelity and supports to audio long file header.

This means that you can work with audio files without any reasonable
restriction on its length, as it happens if using the standard AIFF and WAVE
formats, which are limited to 2.1 GB for the single audio file and which is,
working at 24bits/96kHz, a little bit more than 1 hour only. Instead, CAF
audio files can be as long as needed, so you can work with even hours and
hours of music at 24bits/96kHz without any problem.

Playing an audio file, DSP-Quattro is always synchronized with the current
audio device. It means that its internal audio engine work at the same rate of
the current audio device. If the sample rate of the audio file is not equal to
that of the current audio device, DSP-Quattro will apply a real time sample
rate conversion (SRC), to play the audio file at the correct pitch.

NOTE: the sample rates of the current audio device and sample rate of the
current audio file should have always the same value, otherwise DSP-
Quattro will process the audio stream with its SRC algorithm and you will not
hear EXACTLY what you are going to save on the audio file after your edits.

So, you should always set the sample rate of the current audio device to the
same value of the current audio file under editing OR resample the audio file
under editing to the sample rate of the current audio device using the off-line
SRC algorithm of DSP-Quattro (it is a very high quality linear phase SRC)
and then do your edits with it.

Undo/Redo

When you do your edits, DSP-Quattro always allows you to cancel the edits
you did, using the Undo command (or 3Z). The Redo command (or
4+ 32Z) command returns to the snapshot taken just before to do Undo.

In other words, the Undo command cancel the last edit you did, the Redo
restores again the last edit you did just before doing Undo.

The Undo/Redo engine of DSP-Quattro allows an unlimited number of
Undos/Redos: DSP-Quattro keeps track of all edits done since when it

opened the file — until you save your edits.

Please be aware that saving an audio file will also cancel the Undo/Redo
history. The same happens when you quit the application.

NOTE: each file under editing has its own Undo/Redo history. If you do
some edits on one file, and then you switch on a different audio file, doing
some additional edits on this new file, DSP-Quattro will start a new Undo/
Redo history. When you switch back to the previous audio file, its Undo/
Redo history is safe and you can Undo/Redo last edits you did on that file.

Introducing the Real-Time Previewer Controller

For previewing the processed audio, DSP-Quattro uses a control that allows
you to listen to the result of the edit before to decide if apply it on the audio
file or not. Using this controller you can set in real time the parameters of the
algorithm while listening to the result.

DSP-Quattro uses the same Real-Time Previewer Controller for several

editing functions. It is located on the right side of the dialog including the
graphical interface which is specific to the edit function.
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v

<4 > Copy Paste Compare

Playback Marker

00:00:07:575  en

The controller consists of:
The Preset programmer:

On top there is the preset programmer, that manages the preset of the
algorithm.

Small Room $

Copy Paste Compare

If the algorithm allows to store one or more preset, on top there is an active
popup menu which allows to select one of the available preset.

This section allows to set, save and load a preset. A preset is a collection of
all the settings which are necessary to control the algorithm. A typical
example of editing function allowing the use a presets is an plug-in or an
internal effect of DSP-Quattro.

The preview transport bar:

On the bottom part there is the Transport bar, to control the playback of the
audio file.

Playback Marker Start: 00:00:07:575

00:00:07:575  Ena: 00:00:08:637

This is very similar to the transport bar used to control the playback of the
Audio Editor. Please refer to the relevant character for the description of the
use of each button and of the display.

The File Menu
Clicking on the File button on top of the waveform view, DSP-Quattro shows

a menu with the commands for creating new audio files, and audio file
import/export.
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B —
New Audio File New Empty Audio File ~EN
New Audio File from Clipboard

Import Audio File > New Audio File from Selection

Save Current Audio File Edits ~¥8S
Duplicate Current Audio File  ~8C

New Audio Files from Markers
New Audio Files from Regions

Export Audio File >
Send To AudioCDLayout
Close All

New Audio File...

New Empty Audio File (or ~3N): to create a new audio file adding it
into the Project. DSP-Quattro will show a dialog to enter the new audio
file settings:

o TS

) 44100
vonoistorec:  (ETEENITS
Bt Dept

Sample Rate:

[ cancel IR S

Enter the name for the new file, the sample rate, the number of channels
(mono or stereo), and the bit depth. DSP-Quattro creates a new file, will
add it to the Project, and will show it on a new tab of the Audio Editor
view.

New Audio File from Clipboard: to create a new audio file filling it with
the current audio clipboard contents, adding the new audio file to the
Project, and showing it on a new tab of the Audio Editor view. If the audio
clipboard is empty, this command is not available.

New Audio File from Selection: to create a new audio file filling it with
the current audio selection contents, adding the new audio file to the
Project, and showing it on a new tab of the Audio Editor view. If there is
not an audio selection, this command is not available.

New Audio Files from Markers: to create new audio files from the list of
the generic makers, adding the new audio files to the Project. Each new
audio file will extend from one generic marker to the next one on the list.
If there are not generic markers, this command is not available.

New Audio Files from Regions: to create new audio files from the list of
the audio regions, adding the new audio files to the Project. If there are
not audio regions, this command is not available.
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Import Audio File...

New Audio File

Import Audio File Import Audio File...
' Import Audio File from Dual Mono L&R
Import Audio File from Binary File

Save Current Audio F
Duplicate Current Audio File  ~3C

N Import Project Audio File
Export Audio File

Send To AudioCDLayout

Close All

- Import Audio File... (or ~30): to load an audio file from the MacOS
file system. DSP-Quattro will show a file browser and, if you select an
audio file and click on the OK button, it will add the selected audio file to
the Project, and will show it on a new tab of the Audio Editor view.

NOTE: you can select more than one audio file at the same time.

NOTE: DSP-Quattro will allow you to select only an audio file in one of
the possible recognized format (.aif, .wav. .mp3, .m4a, .caf, ....) and it will
take care to translate the audio file to a uncompressed PCM audio file to
start to work with it at maximum quality. If it is not possible to select the
audio file you wish to import, because it is greyed-out, be sure that the
file name ends with the proper extension (.wav, .mp3, ...).

- Import Audio File from Dual Mono L&R: to load a stereo audio file
selecting a mono audio file used for the Left channel and a mono audio
file used for the Right channel (Dual Mono). This command is useful if
you need to edit in DSP-Quattro a stereo audio file generated by an
external application which uses to save a stereo audio file as two mono
audio files with the names ending with -L and -R.

- Import Audio File from Binary File: DSP-Quattro is able to import an
audio file building it reading a RAW binary file. It is necessary to enter
some parameters used by DSP-Quattro to translate the binary file to an
audio stream to save into a new audio file.

Choose the file to import:

o < 2 =) =- 4VCOs - L 2 m Q
Eavoritas > Chroma Polaris B B 4vCOs - L > 01 4VCOs - L C1.aif
@ R t > D50 Fantasia.caf 4VCOs - L.aif 02 4VCOs - L D#1.aif
ecents 2.6 > D50 Glass Voices.caf [ 4vcos -R > 03 4VCOs - L F#1.aif
. MacBook HD2 .2.6.zip DDPs > 4VCOs - R.aif 04 4VCOs - L A1l.aif
Plug-Ins 2 » [ EsQ1 > 4VCOs-L 05 4VCOs - L C2.aif
t > Hollowsun > 4VCOs-R 06 4VCOs - L D#2.aif
#3; Applications 441.zip | Don't Kno...ny - 3 - L.aif 07 4VCOs - L F#2.aif
Gobbler > | Don't Kno...hy - 3 - R.aif 08 4VCOs - L A2.aif
Data > | Don't Know Why.aif 09 4VCOs - L C3.aif
[ Desktop
Bytes Order: | Little Endian (PC) &)
Bit Depth: | 16 Bits 7]
Stereo/Mono = Stereo B Set
DDP Audio Binary File
Sample Rate: 44100 Hz
First Sample Offset: 0
Options Cancel
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DSP-Quattro will show a file browser. In the bottom part of this file
browser it possible to set the parameters used to to translate the binary
audio file to a playable audio file:

- Bytes Order: when the below Bit Depth parameter is greater than 8
bits/sample, each sample will use more than one byte. These bytes can
be ordered by following the “Big Endian” standard, generally adopted by
the Motorola microprocessors and computers Apple Macintosh, or “Little
Endian” standard, generally adopted by Intel microprocessors and PC
MSDOS/Windows.

- Bit Depth: to set if DSP-Quattro must read 8, 16, 24, 32 or 32 (floats)
bits for each sample.

- Stereo/Mono: to set the number of interleaved audio channels. For
stereo audio files, DSP-Quattro will read one sample to fill the left
channel, then one sample to fill the right channel, and again.

- Sample Rate: to set the sample rate that will be adopted for playing the
file.

- First Sample Offset: to set the offset, expressed in bytes, from the
beginning of the file, that will be used by DSP-Quattro before to start to
read samples. This value is very important to skip the audio file header
correctly to realign the audio sample reading position.

Click on the Set button to set the values to the default values to use to
read a binary audio file produced accordingly to the DDP standard.

- Import Project Audio File: to load an audio file which has been already
loaded into the Project. DSP-Quattro will show the list of the audio files
as from the Document Manager table. Just select the audio file you wish
to edit, DSP-Quattro will load it on the Audio Editor and will show it on a
new tab of the Audio Editor view.

Save Current Audio File Edits

- Save Current Audio File Edits... (or ~35S): to save the current edits
on the audio file which DSP-Quattro keeps into the Project. Use this
command to finalize and render to file your edits.

New Audio File

Import Audio File

Save Current Audio F
Duplicate Current Audio File

e ———
Export Audio File Export Audio File As...

Send To AudioCDLayout Export As iTunes Plus AAC

Close All Export Audio File As .aif
UUIOUUL.7 T2 -OUUS.4 Export Audio File As .wav
Export Audio File As .mp3
Export Audio File As Dual Mono L&R

Export Selection As...
Export Selection As iTunes Plus AAC

Export Loop As...
Export Markers List to Audio Files...
Export Regions List to Audio Files...

I
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NOTE: Editing an audio file, DSP-Quattro works on a copy of the source
audio file which it keeps into the Project bundle.

NOTE: DSP-Quattro will always ask to save your edits also when it quits.

NOTE: saving edits, DSP-Quattro will empty the Undo/Redo history.

Duplicate Current Audio File

- Duplicate Current Audio File... (or ~8C): to make a copy of the

current audio file, adding this copy to the Project, and showing it on a
new tab of the Audio Editor view.

Export Audio File...

- Export Audio File As... (or ~3E): to export the current audio file from
the Project bundle to the MacOS file system. DSP-Quattro will show a file
browser where you must enter the file name to use for the destination file,

and with a custom view to set the audio file format to use for the
destination file.

Export AudioFile As (enter the file name without any extension):

File Name: | MyCount -
Tags:
2 =) = BB 4VCOs - L 2 Q
Favorites Chroma Polaris > | 4VCOs -L >
n HD2 1 4VCOs -R >
£33 Plug-Ins DDPs >
ESQ1 S

#™: Applications

~—

Audio File Format: = CAF E
Bits/Sample: | As Source | T
Mono/Stereo: | As Source | T
© | AsSource s
Sample Rate: u
44100 Hz
SRC Algorithm Quality: | Excellent K

Process Fx Plug-ins on Insert

Adc Tai msecs
Apply Fade-Qut on Tai

Hide extension | New Folder Cancel m

where:
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Audio File Format: to set among the standard formats which are
available on the list:

AIFF
WAVE
v CAF

MPEG Layer 3

NeXT/Sun

Sound Designer |l

AAC ADTS

Apple MPEG-4 Audio
Apple MPEG-4 AudioBooks
MPEG-4 Audio

According to the chosen audio file format, the view which is on the
bottom part of the custom DSP-Quattro view will change.

The uncompressed PCM formats (AIFF, WAVE, CAF) need of these
additional parameters:

Bits/Sample: DSP-Quattro can save 8, 16, 24, 32 or 32 (floats) bits
for each sample. Set “As source” to keep the bit depth of the audio file
used into the Project.

Stereo/Mono: to set the number of interleaved channels. Set “As
source” to keep the number of channels of the audio file used into the
Project.

Sample Rate: to set the sample rate of the destination audio file. Set
“As source” to use the same sample rate value of the audio file used
into the Project.

SRC Algorithm Quality: if the sample rate of the destination audio file
is not the same of the audio file used by the Project, DSP-Quattro will
use its internal Sample Rate Converter (SRC) to write the destination
audio file. Four levels of quality of the advanced liner phase algorithm
of DSP-Quattro are available, ranging from Fast to Excellent.

Process Fx Plug-in on insert: if ON, DSP-Quattro will process the
source audio file thru the FX chain on insert on that audio file channel
strip before to write the samples to disc.

Add Tail: if the option to process FX is ON, it is possible to add a tail
to the destination audio file, setting how much this tail must be long,
as well. This is very useful if the FX chain includes an effect like a
reverb or space simulator which produce audio at the end of the file
even when the audio file stops. Turning ON the option “Add Tail”,
DSP-Quattro will continue to process the audio after the audio file
end, capturing the tail of the effect into the destination file.

Apply Fade-Out on Tail: If the options to process FX and to Add Tail
are ON, it is possible to process the tail thru a fade-out curve to avoid
an abrupt end at the end of the destination file. Turning ON “Apply
Fade-Out on Tail”, DSP-Quattro will decrease the output gain while
processing the tail, to guarantee a smooth end.
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- Export As iTunes Plus AAC: to do “Export Audio File As...” using the
iTunes Plus AAC standard audio file format for the destination audio file.
In this case, no additional parameters are required.

- Export Audio File As .aif: calls “Export Audio File As...” setting the
default audio file formats to AIFF.

- Export Audio File As .wav: calls “Export Audio File As...” setting the
default audio file formats to WAVE.

- Export Audio File As .mp3: calls “Export Audio File As...” setting the
default audio file formats to MPEG Layer 3.

- Export Audio File As Dual Mono: given a stereo audio file, saves two
different mono files, the first one exporting only the left channel, naming
it with a name ending with “-L”, the second one exporting only the right
channel, naming it with a name ending with “-R”.

- Export Selection As...: calls “Export Audio File As...”, exporting only
the region of the selected audio file waveform. If there is not an audio
selection on the waveform view, this command is not available.

- Export Selection As iTunes Plus AAC: calls “Export Selection As...”,
but using the iTunes Plus AAC standard audio file format for the
destination audio file. If there is not an audio selection on the waveform
view, this command is not available.

- Export Loop As...: calls “Export Audio File As...”, exporting only the
region of the Loop. If the Loop is OFF, this command is not available.

- Export Markers List to Audio Files: to export audio files from the list of
the generic makers. Each exported audio file will extend from one
generic marker to the next one on the list. If there are not generic
markers, this command is not available.

- Export Regions List to Audio Files: to export audio files from the list of
the audio regions. If there are not audio regions, this command is not
available.

Send to AudioCDLayout...

New Audio File

Import Audio File 00:05:14 00:00:6:920

Save Current Audio File E
Duplicate Current Audio File

Export Audio File 2 u-

Send To AudioCDLayout Append As AudioRegion

Append Only Selection As AudioRegion
Close All

Generic Markers List To AudioCDLayout
Audio Regions List To AudioCDLayout

- Append As AudioRegion: to add the current audio file to the AudioCD
appending it at the end of the AudioCD. DSP-Quattro will create a new
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AudioRegion on the AudioCD, using the default setting for the CDTrack
preGap and the CD-Texts of the audio file to fill the CD-Texts of the new
AudioRegion.

- Append Only Selection As AudioRegion: as “Append As
AudioRegion”, but using only the region of the selected audio file
waveform. If there is not an audio selection on the waveform view, this
command is not available.

- Generic Markers List to AudioCDLayout: to create AudioRegions and
CD-Tracks on the AudioCD from the generic markers list, one for each
marker. Each AudioRegion of the AudioCD will extend from a generic
marker to the next one on the list. DSP-Quattro allows you to choose
between clear the AudioCD before to build it, or to append the new
AudioRegions to the end of the current AudioCD. If there are not generic
markers, this command is not available.

- Audio Regions List to AudioCDLayout: to create AudioRegions and
CD-Tracks on the AudioCD from the audio regions list, one for each
audio region. DSP-Quattro allows you to choose between clear the
AudioCD before to build it, or to append the new AudioRegions to the end
of the current AudioCD. If there are not audio regions, this command is
not available.

Close All

To close all the waveform views of the Audio Editor, removing all the tabs.
DSP-Quattro will ask if you wish to save the changes, if any.

The Edit Menu

Clicking on the Edit button on top of the waveform view, DSP-Quattro shows
a menu with the commands for doing cut, copy&paste and similar edits on
the audio file:

Cut Editor

00:00:00:000 Cut

Cut... >
Copy #8C
Copy... >
Paste #V
Replace ~¥V
Delete &1

| Insert Silence...
00:00:00:000 00:0030( Append Clipboard... AGEA

Trim

Cut Editor...
The Cut Editor Tool of DSP-Quattro is a very unique graphical tool to make

cut&paste of audio regions without any problem caused by abrupt changes
of the level and slope of waveforms at cut or paste points.
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Please refer to the chapter dedicated to the Cut Editor Tool to know more
about it and how to work with it.

Cut...

Cut Editor

Cut s o
Playback Cursor
Copy

Copy... Loop Start

> I
Paste B Selection Start
Replace
Delete

Insert Silence...
00:00:00:000 :00] Append Clipboard... 8 00:00:04:761

Trim

- Cut (or 8X): to cut a selected region of the audio file. That region of the
audio file will automatically be copied in the custom audio clipboard of
DSP-Quattro.

- Cut Before: a shortcut to cut a region of the audio file from the beginning
up to a certain point. DSP-Quattro allows the following commands:

- Cut Before Playback Cursor: to cut the region of the audio file
before the playback cursor. This command is not available if the
marker is at the beginning of the audio file.

- Cut Before Loop Start: to cut the region of the audio file before the
Loop Start. This command is not available if the loop is OFF or if the
Loop starts at the beginning of the audio file.

- Cut Before Selection Start: to cut the region of the audio file before
the beginning of the selected audio file waveform. This command is
not available if there isn't a selection or if the selected audio file
waveform starts at the beginning of the audio file.

- Cut After: similar to the command above, but to cut a region of the audio
file after a certain point up t the audio file end. DSP-Quattro allows the
following commands:

- Cut After Playback Cursor: to cut the region of the audio file after
the playback cursor. This command is not available if the marker is at
the end of the audio file.

- Cut After Loop End: to cut the region of the audio file after the Loop
End. This command is not available if the loop is OFF or if the Loop
ends at the end of the audio file.

- Cut After Selection End: to cut the region of the audio file after the
the end of selected audio file waveform. This command is not
available if there isn't a selection or if the selected audio file waveform
ends at the end of the audio file.
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NOTE: on DSP-Quattro preferences, there is an option to add a certain
number of frames before/after the cut point when applying the Cut Before,
Cut After and Trim (more about the Trim command later in this chapter)
commands. It is very useful to keep an additional small portion of waveform
before or after the waveform to keep. Some software or hardware samplers
needs of just a few samples after the end loop point to avoid to click at loop,
due their internal interpolation algorithm when transposing the sample along
the keyboard.

Copy...

EImY ; Cut Editor

Cut
Cut...
Copy

00:00:00:000

Left Into Right Channel |
Paste ®V Right Into Left Channel
Replace ~FV Y

GJ‘"' |

Delete

. Insert Silence...
00:00:00:000 hairs  Append Clipboard...

Trim

i

- Copy (or 38C): to make a copy of the audio file saving this copy into the
custom audio clipboard of DSP-Quattro. If the is a selection on the
waveform view, DSP-Quattro will copy only the selected region. If there is
not a selection, DSP-Quattro will copy all the audio file into its audio
clipboard.

NOTE: selecting only one channel of a stereo audio file and doing copy,
DSP-Quattro will copy only that selected channel into the audio clipboard.

- Copy Left into Right Channel: to make a copy of left audio channel of
the stereo audio file into the right channel, overwriting it. This command is
not available if the audio file is a mono audio file.

- Copy Right into Left Channel: to make a copy of right audio channel of
the stereo audio file into the left channel, overwriting it. This command is
not available if the audio file is a mono audio file.

Paste (Insert) and Replace

- Paste (or 38V): if there is a selection on the waveform view, this
command replace the current selection with the current audio clipboard.
If there is not a selection on the waveform view, this command insert the
current audio clipboard at the position of the playback cursor. In both
cases, replacing or inserting, DSP-Quattro places all the audio file
clipboard starting at the insertion point (ie the selection start if replacing,
the playback cursor if inserting), adjusting also the audio file length
accordingly. This command is not available if the audio clipboard is
empty.

- Replace (or 38V): if there is a selection on the waveform view, this
command replace the current selection with the current audio clipboard.
If there is not a selection on the waveform view, this command replace
the current audio file, starting at the position of the playback cursor, with
the audio clipboard. This command is not available if the audio clipboard
is empty.
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Delete...

- Delete (or backspace): to clear (silencing, as with an eraser tool) the
selected waveform or all the audio file if there is not a selection.

DSP-Quattro will show an additional view to set the fade-in and fade-out
times. There is also a transport bar to preview the result of deleting.

Time (msec) Time (msec)

Fade Out Fade In
00:00:00:000

<« <« 4 0 P »» P

[ Cancel IS

NOTE: this is a simplified version of the processing function Fade In<->Out,
which is very much more powerful. Please refer to the part of this chapter
describing the Processing functions to know more about it.

Insert Silence...

- Insert Silence...: to insert a region of silence (no audio) at playback
position.

0 Frames
Length:
00:00:00:000 Time

*cance IS

DSP-Quattro will show an additional view to set length of the region to insert,
in frames and time units.

Append Clipboard...

- Append Clipboard...: to paste the current audio clipboard at the end of
the audio file. This command is not available if the clipboard is empty.
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Trim...

- Trim...: to keep only a certain region, cutting the two regions which are
before and after that one. It is the same as doing two cuts, one before the
region start, one after the region end.

There are two options:

Cut Editor

00:00:00:000 :00: Cut 00:00:05:342
Cut...
Copy
Copy...
Paste
Replace
Delete

Insert Silence... )
00:00:00:000 :00: Append Clipboard... ~3A & 00:00:05:342

Loop 8T
Selection T

- Trim Loop (or "3 T): to cut the regions outside the Loop. If the Loop is
OFF, this command is not available.

- Trim Selection (or 3T): to cut the regions outside the selection on the
waveform view. If the there is not a selection, this command is not
available.

NOTE: please refer to the NOTE in the Cut After/Before paragraph about the
option on DSP-Quattro Preferences to keep a certain number of samples

before and after the cut points. This option is used also by the TRIM
command.

The Commands Menu

Clicking on the Commands button on top of the waveform view, DSP-Quattro
shows a menu with various commands, among which the ones for managing
the markers, regions and the Loop of the audio file:

v Rebuild Graphic Overview

00:00:00:000 00:00:01:335 oqy  Zoom

Playback Cursor
Generic Markers

Regions >

Turn Loop OFF L
Lock Loop Length  C{r36L
Loop Selection 3L A

00:00:00:000 00:00:01:335 :00:!

Show Loop Window  \C88L

Select All #A
Select Loop {38A
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Rebuild Graphic Overview...

- Rebuild Graphic Overview...: doing edits as cut, copy, insert and similar
operations, DSP-Quattro rebuilds the waveform overview using an zero-
time algorithm. This method is very very fast, but may cause a small
approximation on the time x-axis alignment of the displayed waveform
after doing several edits. The waveform may appear out of sync of one
pixel when zoomed-out. Use this command to reset the situation
rebuilding the whole waveform overview. It may request some seconds to
complete but, after this, the overview is perfectly aligned again.

NOTE: it is recommended to use this command every 20-30 operations of
cut, copy, insert or similar.

Zoom...

- Zoom...: clicking on zoom opens a sub menu with the zoom commands
to zoom in/out on both X and Y axis.

Rebuild Graphic Overview

X-Axis Zoom In
X-Axis Zoom Out =

00:00:00:000 00:00:01:335 00:00: > '
Playback Cursor >
Generic Markers > X-Axis Full Zoom In

X-Axis Full Zoom Out

Regions >
. Y-Axis Zoom In 8+
Turn Loop OFF #L Y-Axis Zoom Out 38—
Lock Loop Length  C{r38L
i ‘ Loop Selection 8L Y-Axis Full Zoom Out
00:00:00:000 00:00:01:335

Show Loop Window 3L XY-Axis Full Zoom Qut ~3-
Select All $A Fit On Selection 8=

Select Loop G 8A Fit On Loop
I H | L T

- X-Axis Zoom In (or +): to zoom-in the waveform view on the X-Axis by a
factor x2.

- X-Axis Zoom Out (or -): to zoom-out the waveform view on the X-Axis
by a factor x2.

- X-Axis Full Zoom In: to full zoom-in the waveform view on the X-Axis.

- X-Axis Full Zoom Out: to full zoom-out the waveform view on the X-
AXis.

- Y-Axis Zoom In (or 88+): to zoom-in the waveform view on the Y-Axis by
a factor x2.
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- Y-Axis Zoom Out (or 38-): to zoom-out the waveform view on the Y-Axis
by a factor x2.

- Y-Axis Full Zoom Out: to full zoom-out the waveform view on the Y-Axis.

- XY-Axis Full Zoom Out: to full zoom-out the waveform view on both the
Y and X Axis.

- Fit on Selection (or 3=): to zoom-in or zoom-out on the Y-Axis the
waveform view such to see and center the current waveform selection.
This command is not available if there is not a waveform selection.

- Fit on Loop: to zoom-in or zoom-out the waveform view on the Y-Axis
such to see and center the Loop. This command is not available if the
Loop is OFF.
Playback Cursor...
- Playback Cursor...: clicking on Playback Cursor opens a sub menu with
the commands to place the playback cursor (RED marker on the

waveform view) on specific positions.

Please refer to the previous chapter about Working with Markers for a full
reference of this menu commands.

Generic Markers...

- Generic Markers...: clicking on Generic Markers opens a sub menu with
the commands to manage the Generic markers.

Please refer to the previous chapter about Working with Markers for a full
reference of this menu commands.

Regions...

- Regions...: clicking on Regions opens a sub menu with the commands
to manage the audio regions of the audio file.

Please refer to the previous chapter about Working with Markers for a full
reference of this menu commands.

Turn Loop ON/OFF...

- Turn Loop ON/OFF (or 3L): to toggle the Loop ON and OFF. If the Loop
has been turned ON, the two Loop markers (the yellow markers) will
appear on the waveform view. Otherwise, DSP-Quattro will hide them.

See also the previous chapter about Working with the Loop.
Lock Loop Length...
- Lock Loop Length (or "1+ L) to lock/unlock the length of the Loop.
By locking the length of the Loop, moving any of the two Loop markers,
also the other one will move accordingly. This option is useful in the case
that, once found a good Loop, you wish to shift the Loop without
changing its length. This command is not available if the Loop is OFF.

See also the previous chapter about Working with the Loop.
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Loop Selection...

- Loop Selection (or {+38L): to place the Loop markers at the current
selection start and end. (This command is not available if there is not a
selection on the waveform view). If the Loop is turned Off, it will
automatically be turned On.

See also the previous chapter about Working with the Loop.

Show/Hide Loop Window...

- Show/Hide Loop Window (or \_3L): to show or hide the Loop floating
window tool.

More about this in the previous chapter about Working with the Loop.
Select All...

- Select All: to select all the audio file on the waveform view.
Select Loop...

- Select Loop: to select the Loop on the waveform view. This command is
not available if the Loop is OFF.

The Processing Menu

Clicking on the Processing button on top of the waveform view, DSP-Quattro
shows a menu with the commands for processing the audio file:

AL Ll AU Plug-in...

Render Insert FX...

00:00:00:000 00:00:01:335 00:00:02:671 00:00:0:

Digital Effects
Digital Filters
Find Peak&RMS...
Detect BPM >
Remove DC
p . Invert

00:00:00:000 00:00:01:335 00:00:02:671
Reverse
Swap L&R Channels
Normalize ®8G6
Normalize To... X #8G
Apply Gain... {#G
Fade In ®F
Fade Out {38F
Fade In<->Out... X 8F
Fade Out<->In...
X-Fade Loop... ~3L
Loop By BPM...
Resample... X #R
Speed&Pitch Change...
Pitch Shifting...
Time Stretching...
Analize & Declick/Repair... {3E
Repair Selection... X $8E
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AU Plug-in...

- AU Plug-in...: clicking on this menu item will open a sub menu on which
DSP-Quattro lists all Audio Unit (AU) plug-ins installed on MacOS,
grouped by manufacturers.

DSP-Quattro asks to MacOS the list of the installed plug-ins. To be visible,
the AU plug-in must be a 64 bits effect plug-in.

Selecting one of the available plug-ins, DSP-Quattro will open a dialog with
on the left the custom interface of the AU plug-in (it depends on the plug-in
itself) and, on the right, a preview controller to manage the plug-in preset
and with a transport bar to to listen to the result of the processing before to
apply it. DSP-Quattro will automatically resize the dialog accordingly to the
plug-in custom view.

As an example, this is the dialog which DSP-Quattro will show loading the
Apple Multiband Compressor plug-in which is built-in into MacOS:

Multiband Compressor Fast and Smooth 4

12 24 48 T 19

2 384 8 6,1 12,3 .I P > Copy Paste Compare

Playback Marker Start

00:00:03:481  Enc

<« « 4 0> » P

[ cance IS

Compression Levels
Details
Gain
Pre-Gain
Post-Gain
Attack Time

Release Time

Bands

( EQ1
)
EQ3
EQ 4

NOTE: it is highly recommended to explore the excellent Apple AU plug-ins
which are always present because built-in into MacOS. They offer an
excellent quality for free.

NOTE: If there is a selection on the waveform view, the function will process
only the selected region, otherwise all the audio file.

Please refer to the previous chapter about the real time preview controller to

know how to use it for loading/saving the current plug-in preset and for
previewing the processed audio.
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Render Insert FX...

- Render Insert FX...: it is possible to load a serial chain of effect plug-ins
on insert to the channel strip of the audio editor, which is different for
each audio file under editing. Use this command to render - or finalize -
this serial chain of effect plug-ins into a new audio file. The result is the
same as playing the current audio file thru the effects and saving the
result into a new file which DSP-Quattro will load automatically into the
Project and - optionally - will open into a new tab of the Audio Editor.

Clicking on this menu command, DSP-Quattro will show a dialog to set the
parameters for rendering the plug-ins on insert to the audio editor channel
strip into a new audio file:

LIRS ERNET X MyCount - Fx

@ Load it on the Audio File Editor

® Add Tail: m msecs

@ Apply Fade-Out on Tail

Cancel  JIESNC S

- New File Name: type the new file name.

- Load it on the Audio File Editor: if turned ON, DSP-Quattro, as soon
as it finish to process it and to load the new processed audio file into
the Project, will open the new file into a new tab of the Audio Editor.

- Add Tail: if the option to process FX is ON, it is possible to add a tail
to the destination audio file, setting how much this tail must be long,
as well. This is very useful if the FX chain includes an effect like a
reverb or space simulator which produces audio at the end of the file
even when the audio file stops to play. Turning ON the option “Add
Tail”, DSP-Quattro will continue to process the audio after the audio
file end, capturing the tail of the effect into the destination file.

- Apply Fade-Out on Tail: If the options to process FX and to Add Tail
are ON, it is possible to process the tail thru a fade-out curve to avoid
an abrupt end on the destination file. Turning ON “Apply Fade-Out on
Tail”, DSP-Quattro will decrease the output gain while processing the
tail, to guarantee a smooth end.

Digital Effects...
DSP-Quattro has several high quality digital effects which are built-in into the
application itself. They can be seen as custom plug-in which are unique to

DSP-Quattro.

NOTE: If there is a selection on the waveform view, the function will process
only the selected region, otherwise all the audio file.
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- Digital Effects: this group of effects includes the effects using
modulated delay lines and chamber/hall simulations: Chorus, Stereoizer,
Delay, Dual Delay, Multitap Delay, Reverbs 1&2.

More about using these effects in the chapter about Using the built-in Effects
of DSP-Quattro.

Digital Filters...

Commands # Processing AU Plug-in...

00:00:00:000 00:00:01:335 00:00:02:671 00:00:0 Render Insert Fx...

Digital Effects Chorus
Digital Filters Stereoizer

Find Peak&RMS... Delay
Detect BPM Dual Delay
MultiTap Delay
Remove DC
Invert Reverb 1
00:00:00:000 00:00:01:335 00:00:02:671 Reverse Reverb 2 q

Swan | RR Channele

- Digital Filters...: this group of effects includes effects using digital filters:
Parametric & Graphic Equaliser, Resonant filters (Analog Filter
Emulators).

Commands § Processing AU Plug-in...

Render Insert Fx...

00:00:00:000 00:00:01:335 00:00:02:671 00:00:0

Digital Effects
Digital Filters Parametric EQ

. Graphical EQ
Find Peak&RMS...

Detect BPM Resonant Filter

More about using these effects in the chapter about Using the built-in Effects
of DSP-Quattro which is later in this manual.

Find Peak&RMS...

dB

Frames
Peak Position:
Time

%

dB

Number Of Clips:
%

@ Add a Generic Marker at Peak Position

T
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- Find Peak&RMS...: this command will open a dialog on which DSP-
Quattro shows statistics about the peak and RMS level analyzing the
audio file. If there is a waveform selection on the waveform view, DSP-
Quattro shows the statistics after the analysis of the selected region only.

DSP-Quattro shows also the number of clips, defined as the points where
the waveform reaches the maximum normalized values of —1.0 or 1.0, and
the ratio between the number of clips and the number of frames of the audio
file.

It is also possible to add a generic marker at the position of the detected
peak (or at the position of the first clip, if there are more clips). If you want to
add a marker, turn ON the check box.

Detect BPM...

Detect BPM...: clicking on this menu item will open a sub menu on
which you can choose a region used by DSP-Quattro to compute the
Beats Per Minute (BPM) rhythmic time.

it is possible to compute the BPM using the length of the following regions:

- Use All: DSP-Quattro will compute the Beats Per Minute (BPM) rhythmic
time using all the audio file length.

- Use Selection DSP-Quattro will compute the Beats Per Minute (BPM)
rhythmic time using the length of the waveform selection on the
waveform view. This command is not available if there is not a selection.

- Use Loop: DSP-Quattro will compute the Beats Per Minute (BPM)
rhythmic time using the length of the Loop. This command is not available
if Loop is OFF.

In all cases, DSP-Quattro will show the following dialog:

Beats/Measures:
Additional Beats:

Num Of Measures:

@ Set as Master Clock BPM Value

T e

To compute the BPM value, it is necessary to enter:
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- Beats/Measures: number of Beats for each Measure. This is the number
of hits of metronome. As an example, in case of a 3/4 time, it is equal to 3.

- Additional Beats: it is the number of additional Beats, used if the
measures are not all equals in terms of Beats for each Measure.

- Num Of Measures: it is the total number of measures.

For example, in case we want to know the BPM from a region equal to 3
measures in 4/4, plus one in 3/4, we need to set:

Beats/Measures
Additional Beats
Num of Measures

4

3

3

- BPM shows the computed result. When one of the values in the upper part
changes, the value of the BPMs is updated in real time accordingly.

- Set As Master Clock BPM Value: to set the computed BPM value as

Master BPM Tempo value. It is the master clock use by DSP-Quattro as

reference for sending the synchronization message to AU plug-ins, effects
and virtual instruments, which support synchronization.

Remove DC...
- Remove DC...: to subtract (removing) the DC Level from an audio file.
The DC Level of an audio file is the average value of its samples. The
waveform that represents the audio file should oscillate around the zero, and
therefore its average value should be zero. But sometimes the waveform
doesn't oscillate around the zero, due to several reasons as, for example, to
an imperfection in the analog circuit of the Analog To Digital (A/D) converters
of the system used for digitising the audio signal.
If there is a selection, this function modifies only the selected region,
otherwise all the file.

Invert...

- Invert...: to invert the audio signal around the zero level, ie to change the
sign of all the samples in the region to edit.

If there is a selection, this function modifies only the selected region,
otherwise all the file.
Reverse...

- Reverse...: to reverse in time the audio signal of the audio file, ie to play
it on reverse, from the end to the beginning.

If there is a selection, this function modifies only the selected region,
otherwise all the file.

Swap L&R Channels...
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- Swap L&R Channels...: to swap the samples between left and right
channels of a stereo audio file. On exit, all left channel samples will be
transferred to the right channel and also the contrary.

If there is a selection, this function modifies only the selected region,
otherwise all the file.

Normalize...

- Normalize... (or 3G): to apply an automatic linear gain to samples of
the audio file such that the level of maximum peak of the processed
audio file will be equal to 0 dB.

NOTE: this is one the most used editing function. Doing a recording, usually
it is safer to keep the recording level low enough to avoid audio clips at 0 dB,
which would cause a distortion. Then it is a good practice to apply this edit
function to bring the level of the signal to the maximum allowed level. But
unfortunately also the background noise will be amplified accordingly.

If there is a selection, this function modifies only the selected region,
otherwise the whole audio file.

Normalize To...

- Normalize To... (or \.38G): as the Normalize processing function, but
with the difference that the target maximum peak of the processed audio
file is a user programmable value.

DSP-Quattro will show the following dialog:

dB

Frames

Time
%
dB

Number Of Clips:
%

WARNING: Values above 0 dB will
cause clips on the processed audio file. . Add a Generic Marker at Peak Position

New Peak Value (dB)

[ Cancel IS

On the right side, DSP-Quattro shows the results of the analysis of the
region of the audio file to process. These results are the same as seen
running the Find Peak&RMS command.
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On the left a slider to set the target for the peak of the audio file after
processing.

If there is a selection, this function modifies only the selected region,
otherwise the whole audio file.

Apply Gain...

- Apply Gain... (or {+36G: this command opens the Fade Editor Tool
setting the Fade Type to Gain by default.

The Fade Editor is a graphical tool used to apply a gain on a certain region

defining also a user programmable curve for the fade-in and a user
programmable curve for the fade-out for smoothing the gain changes.

Fade In-Out Gain Silence

Fade Type

410 398 47

Time (msec) Time (msec)

Curve:

Fade Out Dl

1:159 <>

Please refer to the chapter describing the Fade Editor Tool to know more
about how to use it.

Fade In...

- Fade In... (or 38F): to apply a linear fade-in gain curve to the region to
process. The level of the processed audio file will start from zero to reach
the full level at the processed region end.

f there is a selection, this function modifies only the selected region,
otherwise the whole audio file.

NOTE: this is a fast shortcut to fade-in a certain region, without any
graphical tool. For more complex edits, it is possible to use the Fade Editor
Tool. Please refer to the chapter describing the Fade Editor Tool to know
more about how to use it.
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Fade Out...

- Fade Out... (or {+ 3F): to apply a linear fade-out gain curve to the region
to process. The level of the processed audio file will start from the full
level to reach the zero at the processed region end.

If there is a selection, this function modifies only the selected region,
otherwise the whole audio file.

NOTE: this is a fast shortcut to fade-out a certain region, without any
graphical tool. For more complex edits, it is possible to use the Fade Editor
Tool. Please refer to the chapter describing the Fade Editor Tool to know
more about how to use it.

Fade In<->QOut...

- Fade In<->0ut... (or "3 F): this command opens the Fade Editor Tool
setting the Fade Type to Fade In-Out by default.

Please refer to the chapter describing the Fade Editor Tool to know more
about how to use it.

Fade Out<->In...

- Fade Out<->In...: this command opens the Fade Editor Tool setting the
Fade Type to Silence by default.

Please refer to the chapter describing the Fade Editor Tool to know more
about how to use it.

X-Fade Looping...

- Fade Out<->In... (or *3L): this command opens the X-Fade Looping
Editor.

Time (msec)

Set Linear

ExpCurve

Curve:

X-Fade

The X-Fade Looping Editor is a graphical tool used to apply a X-Fade
looping algorithm to the Loop region. It is possible to define the shape of the
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X-Fade curves, while checking visually what happens to the processed
audio file, previewing the waveform and listening to the result as well.

Please refer to the chapter describing the X-Fade Looping Editor to know
more about how to use it.

Loop by BPM...

- Loop by BPM...: to set the Start and End Loop points such that its length
is computed by a user programmable Beats Per Measures (BPM)
rhythmic tempo value. It is also possible to set if the Loop must start at
the beginning of the audio file, at the playback cursor, or if it must end at
the end of the audio file.

BPM: 120.00

1

Measures

# Loop at Playback
@ Loop at Start

@ Loop before the End

conce IS

NOTE: This is a very useful function when you want to set a Loop on
rhythmic patterns. In this case the length of the Loop has to be based
considering the Beats Per Measures metronomic time.

It is necessary to set the following parameters:
- BPM: it is the value of the target Beats Per Measures (BPM)

- Beats/Measures: number of Beats for each Measure. This is the number
of hits of metronome. As an example, in case of a 3/4 time, it is equal to 3.

- Add. Beats: it is the number of additional Beats, used if the measures are
not all equals in terms of Beats for each Measure.

- Measures: it is the total number of measures.

As an example, in case you want to position the Loop points on a region
equal to 3 measures in 4/4, plus one more in 3/4, with a BPM time of 120.32,
you must set:

BPM
Beats/Measures
Measures

Add. Beats

oo
wwh
N
it
w
N

It is also necessary to set where the Loop must start:
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- Loop At Playback : the Loop starts at the playback cursor
- Loop At Start : the Loop starts at the beginning of the audio file
- Before End : the Loop ends at the end of the audio file

If the Loop was OFF, DSP-Quattro will also turn it ON automatically.

Resample...

- Resample... (or \C3R): to change the sample rate of the audio file by
using a HQ linear phase Sample Rate Converter (SRC) algorithm.

The Nyquist theorem demonstrates that the maximum frequency which can
be reconstructed from a digital audio signal is the half of its sample rate. For
this, lowering the sample rate, the SRC algorithm must also remove the
highest frequencies components to guarantee that the maximum frequency
of the digital audio signal is lower than the half of its sample rate. This will
lower the audio spectrum range of the audio signal. The benefit is that the
audio file will have smaller dimensions, saving space on the hard disk.

New Sample Rate:

SRC Algorithm Quality:

Cance IR

NOTE: the offline Sample Rate Converter (SRC) algorithm of DSP-Quattro
uses a very High Quality Linear Phase Sample Rate Converter (SRC)
Resampling algorithm, based on the state-of-art technology about the Digital
Signal Processing and linear phase digital filtering. This SRC guarantees the
maximum audio quality, in terms of frequency response and audio quality
(the filter characteristic is outstanding and being Linear Phase, the algorithm
does not introduce phase artifacts at the transition band).

- New Sample Rate: to set the sample rate of the processed audio file. It
is possible to choose one of the most common values on the popup
menu or to enter the new value numerically.

- SRC Algorithm Quality: to set the quality of the offline Sample Rate
Converter (SRC) algorithm. The Excellent quality needs more CPU than
the others. It will produce the result with the maximum quality but will be
slower to complete the process. Possible values are Fast, Good, Better,
Excellent.

Speed&Pitch Change...
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- Speed&Pitch Change...: to change the pitch of the audio file playing it
faster (to rise the pitch) or slower (to lower the pitch). This is equivalent to
modify the speed of a tape recorder. Also the length of the audio file will
change accordingly, because playing it faster, it will take less time to
reach the end, the opposite playing it slower.

DSP-Quattro will show the following dialog:

+0.0

Semitones

Ratio

Speed&Pitch Change

Playback Marker

00:00:06:367

Start: 00

- Ratio: to set the ratio between the pitch of the processed audio file and
the source as a float value (ratio = 1.0 means no change, ratio = 2.0
means an octave up, and so on).

- Semitones: to set the ratio between the pitch of the processed audio file
and the source as semitones (semitones = 0.0 means no change,
semitones = +12.0 means an octave up, and so on).

If there is a selection, this function modifies only the selected region,
otherwise the whole audio file.

NOTE: It is also possible to modify the pitch without change the speed - or

time (duration of the audio file), using the Pitch Shifting command of DSP-
Quattro.

Pitch Shifting...

- Pitch Shifting...: to change the pitch of the audio file without changing
the speed (duration of the audio file), ie it does not modify the time.

DSP-Quattro will show the following dialog:
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+0.0

Semitones

Ratio

Pitch Shifter

Playback Marker

00:00:06:367

As for the Speed&Pitch Change command,

- Ratio: to set the ratio between the pitch of the processed audio file and
the source as a float value (ratio = 1.0 means no change, ratio = 2.0
means an octave up, and so on).

- Semitones: to set the ratio between the pitch of the processed audio file
and the source as semitones (semitones = 0.0 means no change,
semitones = +12.0 means an octave up, and so on).

If there is a selection, this function modifies only the selected region,
otherwise the whole audio file.

NOTE: even if the interface is the same as for Speed&Pitch Change
algorithm, which change not only the pitch but also the speed, for doing pitch
shifting without changing the speed (time), DSP-Quattro uses a very High

Quality Spectral Re-Synthesizer, which is a very sophisticated algorithm
compared to the algorithm used for Speed&Pitch Change.

Time Stretching...

- Time Stretching...: to change the speed (time) of the audio file without
changing the pitch.

DSP-Quattro will show the following dialog:
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Source

395071

00:00:08:230

120.0

Destination

395071 Frames

00:00:08:230 Time

120.0

Time Stretcher

Playback Marker

00:00:06:367

Cancel

There are different options to set the ratio between the length of the
destination and of the source file:

- Ratio: to set the ratio by using the slider on the left, or by using the
numerical control above the slider.

- Destination Length: to set the length of the destination audio file,
expressing it in frames or in the time format.

- Destination BPM: to set the ratio expressing it in a more usual form used
by musician, the Beats Per Minutes (BPM). For this, you must first set the
BPM of the source file, clicking on the SET button in the section related to
the parameters of the source file. This opens a dialog that allows you to set
all the parameters needed to compute the source BPM, as previously
described for the Detect BPM command. Then, use the numerical control to
set the destination BPM in the section related to the parameters of
destination file, DSP-Quattro will automatically set the time stretching ratio.

NOTE: DSP-Quattro uses an High Quality Spectral Re-Synthesizer to do
Time Stretching.

Analize & Declick/Repair...

- Analize & Declick/Repair... (or {+$8E): to apply a de-clicker algorithm
for the audio restoration of old vinyls or corrupted recordings.
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If there is a selection, this function modifies only the selected region,
otherwise all the file.

NOTE: It is really an astonishing de-clicker algorithm for the audio
restoration of old vinyls or corrupted recordings. This built-in algorithm is
capable to reconstruct portions of a corrupted audio file and substitute them
with a portion of waveform which are very similar to the original ones. It
seems really impossible, but it is so! Not only this: DSP-Quattro first
analyzes the audio file understanding what is good and what is not. In other
words, it is able to detect by itself the corrupted portions to substitute them
with reconstructed waveforms, doing everything with one command only.

Repair Selection...

- Repair Selection... (or \_3E): to repair a certain region of the audio file.
DSP-Quattro will reconstruct the waveform in the selected region using
the portions of the audio file just before and just after the selection.

This command is available only if there is a selection on the waveform view.

NOTE: to reconstruct successfully the selected region, it is is necessary that
there is enough waveform before and after the selected region to
reconstruct, otherwise the algorithm has not enough information to operate
correctly.

NOTE: Please consider also that it is possible to reconstruct with an high
quality result only very, very short regions of the audio file. To operate
correctly, you must first do a very short selection around the corrupted
waveform (no longer than a few milliseconds), Doing longer selection, the
algorithm is not applicable directly. in these cases, use the Analize&Repair
algorithm, it will automatically take care to repair only the necessary portions
of the waveform.

The Cut Editor Tool
DSP-Quattro offers a very unique Cut Graphic Editor tool to make cuts on
the audio file and paste of the clipboard into an audio file without any
problem caused by abrupt changes in the level and slope of waveforms at
cut or paste points.
Doing a graphical Cut using the Cut Editor Tool:
To start using the Cut Editor, click on the Edit button on top of the waveform

view, and select Cut Editor, DSP-Quattro shows a submenu with the
commands for opening the Cut Editor:

» Outputs | Don't Know Why Example 5 - Kings Choir

»  Effects e § Cut Editor Cut... ¥8X

Insert... T8V
Replace... {38Y §
TR WL T

00:00:00:000 -00: 1iEL 38X
Cut... > -
Copy %®C |
Copy... >
Paste BV
Replace ~¥V
Delete

Insert Silence...
Append Clipboard... ~3A P

Trim o | W.n .ll J“ _Il]
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- Cut... (or ©+38X): DSP-Quattro opens the Cut Editor to do a cut at
playback position:

00:00:59:210 00:01:00:371 00:01:01:532 00:01:02:693 00:01:03:854 00:01:05:015 00:01:06:176 00:01:07:337

1512 <>

Playback Marker Start: 00:00:00:000
_— :00:00:
<« « < H » » P 00:01:03:408  End: 00:02:13:761 ok

In the upper part, to the left, there is the waveform before the cut point. In
the lower part, to the right, there is the waveform after the cut point.

The interface is very similar to the AudioCD Layout interface which you will
find later on this manual.

Click on the waveform on the right, that's the audio file region after the cut
point, and drag it to the left such to overlap the waveform in the upper part,
that’s the region before the cut point. DSP-Quattro will automatically create a
cross-fade curve between the two overlapping regions:

00:00:59:210 00:01:00:371 00:01:01:532 00:01:02:693 00:01:03:854 00:01:05:015 00:01:06:176 00:01:07:337

1.00

Total Length: 00:00:00:000 1512 <>

I e e e e e e e 7 R Ie Start: 00:00:00:000
— 1 00:00:
OO 00:01:03:408 e 000212743 | SN

Setting fade-In/Out lengths and shapes of the curve

The Cut Editor Tool gives the complete freedom for setting the cross-fade
lengths and the shape of the fade-in/out curves, even independently. Fade-in
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length and shape can be different compared to the fade-out length and
shape, if necessary.

To set the length only of the fade-out of the upper waveform, click with the
mouse on the little yellow circle control at the beginning of the fade-out, and
shift it backward or forward along the time axis. Do the same procedure to
set the fade-in length of the lower waveform, that's the audio file region after
the cut point.

To set the shape of the curve of the fade-out, click on the little circle control
in the middle of the fade-out curve, and drag it to the four directions to set
the slope which best suite your needs. Do the same to set the shape of the
curve of the fade-in of the waveform after the cut point.

00:00:59:210 00:01:00:371 00:01:01:532 00:01:02:693 00:01:03:854 00:01:05:015 00:01:06:176 00:01:07:337

1:512 <>

Playback Marker Start: 00:00:00:000
'« | W
O [ [ o e 00:01:03:408  en¢: 00:02:12:743 | (EEEGREER

DSP-Quattro allows two different types of shapes for the Fade-In/Out curve:

- Exponential/Bezier type: in this case the shape control point can move
on all directions, setting all the shapes ranging from logarithmic, linear,
exponential.

- S-Curve type: in this case the shape control point can move only up or
down, the shape is convex or concave according to the vertical position
of the shape control point.

To set the type of the shape, click with the right mouse button on the shape
control point, DSP-Quattro will show an utility popup menu with the
command:

1 n '“r"

ullldd
T |

Set Linear
Exp/Bezier Curve
- S-Curve I
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NOTE: by default, the shape of each curve is independent. Keeping the
SHIFT key pressed while clicking and dragging the control to set the shape
of a the fade-In or fade-Out curve, then also the other fade curve will follow
such that the sum of the two curves is always constant (equal power).

Trimming the the start and end of the region at cut point:

Moving the mouse to the border of the upper waveform or of the bottom
waveform, the mouse mode will change to the Trimmer:

00:01:02:693

In this mode, clicking and dragging the mouse to the left or to the right, DSP-
Quattro trims the region end (trimming the waveform before the cut point) or
region start (trimming the waveform after the cut point).

Inserting the Clipboard or Replacing with the Clipboard using the Cut Editor Tool:

Still on the Cut Editor sub menu, only if the Audio clipboard if DSP-Quattro is
not empty, these other commands are also available:

- Insert... (or {+38V): DSP-Quattro opens the Cut Editor, do the cut at
playback position, and inserts the clipboard at the position of the cut. In
the upper part, to the left, there is the waveform before the cut point. In
the lower part, in the middle, there is the waveform of the audio clipboard
then, again in the upper part, there is the waveform starting just after the
cut point.

- Replace... (or {+3Y): DSP-Quattro opens the Cut Editor, do the cut at
playback position, and places the clipboard at the position of the cut. In
the upper part, to the left, there is the waveform before the cut point. In
the lower part, in the middle, there is the waveform of the audio clipboard
then, again in the upper part, there is the source audio file waveform
without the presence of the clipboard in between.

The difference between Inserting and Replacing is that in the first case DSP-
Quattro makes the space to place the clipboard at cut position, shifting the
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rest of the source audio file forward along the time axis. In the second case it
keeps in sync the last section of the source audio file, without shifting it along

the time axis.

00:00:12:770 00:00:19:156 00:00:25:541 00:00:31:927 00:00:38:312 00:00:44:698 00:00:51:083 00:00:57:469

1:2816 <>

LSRG Start: 00:00:00:000
00:00:21:135  Enc: 00:03:36:360 | (EGEEER

Total Length: 00:00:00:000

As you can image, also in this case it is possible to shift the waveforms of
the clipboard and of the region after the cut along the time axis. It is possible
to set the fade-in/out length as set the fade-in/out curve shapes as well.

The Fade Editor Tool

The commands ApplyGain..., Fadeln<->Out... and FadeOut<->In...
available on the Processing popup menu of the AudioEditor use the same

Fade Editor tool:

00:00:00:000 00:00:04:895 00:00:09:791 00:00:14:687 00:00:19:582 e o SIEHED

Fade Type

6813 6351 14

= [}
L [
Time (msec) Time (msec)

ExpCurve % ExpCurve %
Curve: Curve:

Gain (dB)

Fade In Fade Out

1:2159 <>

Flyeb sl Start: 00:00:58:150
00:01:00:496  End: 00:01:22:339 | (EESEEER
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In the left part, the Fade Editor shows the graphical representation of the
envelope curve composed by a Fade-In, a Gain level and a Fade-Out. It is
possible to set the length as well as the shapes of the Fadeln/Out curves
clicking and dragging the yellow fade circular controls.

In the right part, the Fade Editor shows sliders and editable fields to enter
the fades and gain values numerically.

In the upper right part of the the Fade Editor, the possible settings of the
Fade Types are:

- Fade In-Out (automatically set by calling the Fadeln<->Out...
command): in this case the envelope curve starts at zero gain (-inf dB),
go the Gain value with a fade-In, then return to zero after a fade-Out.

- Gain (automatically set by calling the ChangeGain... command): in this
case the envelope curve starts at 1.0 gain (no change of level on the
source file), go the Gain value with a fade-In, then return to 1.0 gain after
a fade-Out. Use this option to change the gain of the source audio file
without changing the audio levels at the borders.

- Silence (automatically set by calling the FadeOut<->In... command):
starts at 1.0 gain (no change of level on the source file), go the 0 level
value with a fade-In, then return to 1.0 gain after a fade-Out. It is similar
to Gain but by default the Gain is at zero (-inf dB).

NOTE: by default, if the file is stereo, the envelope curve processes both the
L&R channels. It is possible to process only one channel turning OFF the
channel to keep as it is, clicking on the L or R square buttons below the
waveform view, in the right part to the Fade Editor window.

The X-Fade Looping Editor Tool

The X-Fade Looping Editor is a graphical tool used to apply a X-Fade
looping algorithm to the Loop region. It is possible to define the shape of the
X-Fade curves checking what happens to the processed audio file visually
and previewing the waveform and listening to the result as well.

)0:00:38:312 00:00:44:698 00:00:51:083 0:00:57:46¢ 00:01:03:854 00:01:10:240 00:01:16:625

0.50
Time (msec)

.00 -
i Set Linear

ExpCurve :
0.50
Curve:

0.00 X-Fade

0.50

1.00

1:2816 <> ©

el Start: 00:00:58:150

<« « 4« B > » »'P 00:01:01:762  End: 00:01:22:339 ok
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The X-Fade Looping Editor is a graphical tool used to apply a X-Fade
looping algorithm to the Loop region. It is possible to define the shape of the
X-Fade curves checking visually what happens to the processed audio file
previewing the waveform and listening to the result as well.

The X-Fade Looping algorithm, available only if the Loop is turned On,
modifies the samples into the loop region mixing the region before the Loop
Start with the region before the Loop End, applying a cross-fade (X-Fade)
between the samples to paste and the samples already on that region.

The purpose to make the loop which sounds as much as natural and as
smooth as possible. Because, after applying the X-Fade looping, the sample
at the Loop End will be mathematically identical to the one at the Loop Start,
you won't hear any audio click when playing and cycling over the loop.

The success of the operation depends on several factors:

Region used

for X-Fading Loop Start X-Fade region

Loop End

)0:00:38:312 | 00:00-44-RO8 nN:0N:51-083 1 10:00:57:469 00:01:03:854 1.NN:01:10:240 | 0N:01:1R:A25
T T Y B B B B T

X-Fade length control curve shape control

- before to apply the X-Fade, the loop points must be already positioned in
places considered good for looping, even if the audio clicks at loop.

- The length of the X-Fade is a very important factor to achieve an
acceptable result, and it is difficult to give in advance a precise rule about
the best value to set. Generally, when applying the X-Fading Loop algorithm
to short loops (less than 1 sec), it is recommended to enter high length
values for the X-Fade, even up to be equal to the full loop length. Instead, for
longer loops, generally smaller values for the X-Fade length are very much
more appropriate.
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The maximum value for the X-Fade length cannot never exceed the length
of the loop, and it cannot exceed also the position of the loop start marker
respect the beginning of the file. In other words, the maximum length of the

X-Fade is smallest value between the length of the loop and the position of
the loop start marker.
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The Built-in Effects of DSP-Quattro

Chorus

DSP-Quattro has a series of built-in digital effects of very high quality. they
range from the various uses of modulated digital delay lines, to the
simulation of analog filters and bank of filters. Algorithms for the room and
hall simulations are available as well.

It is possible to use the built-in effects of DSP-Quattro in the same way as all
the other Audio Unit (AU) Effect plug-ins installed on your MacOS.

When using an effect as edit function in the Audio Editor, If there is a
waveform selection on the waveform view, the function modifies only on the
selected region, otherwise the whole audio file.

The graphic interface, although customized for each effect, uses several
shared graphic objects, such as knobs, sliders, and Vu-Meters.

This chapter describes in detail all of their properties.
The DSP-Quattro built-in effects can be grouped into two main categories:

- Digital Effects: these are the effects using modulated delay lines and
room/hall simulations (Delay, Chorus, Reverb)

- Digital Filters: these are the effects using digital filters (Parametric &
Graphic Equalizer, Analog Filter Emulators).

As in the case of the other AU Effect plug-ins, these effects can be used as a
real time effects, loading them on insert on a channel strip, or can be used
for the offline processing as edit function, by calling the Processing menu
commands on the AudioEditor.

The chorus algorithm uses dual delay lines, modulated by a Low Frequency
Oscillator (LFO).

+0.00

- L&R Gain Sliders: on the left there is a section with two gain sliders, one
for the Left, one for Right channel, to control the gain of the input signal and
to monitor it by the Vu-Meters.

- Efx Balance [0.0...1.0]: to set the ratio between the processed and the
input audio signals.

- Delay [0.0...30.0 msecs]: to set the delay time used by the algorithm.
Higher values produce a more evident and deep chorusing.
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- LFO Depth [0.0...1.0]: to set the amount of the modulation of the Delay
time by the LFO (Low Frequency Oscillator). Higher values produce more
evident and deep chorusing.

- LFO Rate [0.0...5.0 Hz]: to set the speed of the LFO. Lower values
produce a lighter effect, less intrusive.

Stereoizer

The Stereoizer effect uses a delay line to enhance the stereo image of the
input signal.

NOTE: it is highly recommended to check the mono compatibility of the

signal on output, due to phase cancellation side-effect when summing the
Left and Right channel if listening in mono.

+0.00

- L&R Gain Sliders: on the left there is a section with two gain sliders, one
for the Left, one for Right channel, to control the gain of the input signal and
to monitor it by the Vu-Meters.
- Depth [0.0..30.0]: to set the depth of the effect.

Delay

Using one or more Delay effects it is possible to create very special mono
and stereo echoes.
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The Delay effect of DSP-Quattro is a single delay line, which mixes the L&R
input channels before to apply a delay line. It is very good to simulate the
vintage sound of delay pedals used mostly by guitarists.

Dual Delay

L&R Gain Sliders: on the left there is a section with two gain sliders, one
for the Left, one for Right channel, to control the gain of the input signal
and to monitor it by the Vu-Meters.

Efx Balance [0.0...1.0]: to set the ratio between the processed and the
input audio signals.

Time [0..2000 msec]: to set the time of the delay line, in msec. and in
BPM (Beats Per Minute). Changing one of the values, DSP-Quattro will
automatically change the other in real time as well.

Feedback Level [0.0..1.0]: set the feedback level of the output signal
back to the input. The feedback level changes the number of repetitions
(echoes) of the effect.

Feedback Filter Cutoff [20..16000 Hz]: the feedback line pass thru a
lowpass filter to emulate the absorption of reflecting materials, which
higher for the high frequencies.

The Dual Delay effect of DSP-Quattro uses two independent delay lines, one
for the left and one for the right channel. It is very good to produce ping-pong
stereo effects and to spread the stereo image of a stereo input signal.

L&R Gain Sliders: on the left there is a section with two gain sliders, one
for the Left, one for Right channel, to control the gain of the input signal
and to monitor it by the Vu-Meters.

Efx Balance [0.0...1.0]: to set the ratio between the processed and the
input audio signals.
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- Sync: when turned On, changing one setting on one channel control will
change also on the other channel.

For each delay line:

- Time [0..2000 msec]: to set the time of the delay line, in msec. and in
BPM (Beats Per Minute). Changing one of the values, DSP-Quattro will
automatically change the other in real time as well.

- Feedback Level [0.0..1.0]: set the feedback level of the output signal
back to the input. The feedback level changes the number of repetitions
(echoes) of the effect.

- Feedback Filter Cutoff [20..16000 Hz]: the feedback line pass thru a

lowpass filter to emulate the absorption of reflecting materials, which
higher for the high frequencies.

MultiTap Delay

The MultiTap Delay effect is uses four independent delay line, each with its
own controls for setting level and panpot of output signal.

- L&R Gain Sliders: on the left there is a section with two gain sliders, one
for the Left, one for Right channel, to control the gain of the input signal
and to monitor it by the Vu-Meters.

- Efx Balance [0.0...1.0]: to set the ratio between the processed and the
input audio signals.

For each delay line:

- Time [0..2000 msec]: to set the time of the delay line, in msec. and in
BPM (Beats Per Minute). Changing one of the values, DSP-Quattro will
automatically change the other in real time as well.

- Feedback Level [0.0..1.0]: set the feedback level of the output signal

back to the input. The feedback level changes the number of repetitions
(echoes) of the effect.
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- Feedback HF Dump [20..16000 Hz]: the feedback line pass thru a
lowpass filter to emulate the absorption of reflecting materials, which
higher for the high frequencies.

- Panpot [-64..0..64]: to set the balance between L&R channels of the
output signal of each delay line. -1.0 means that the only the L channel
will play, 0 means that both L&R channels will play at full volume, and
+1.0 that only the R channel will play.

- Level [0.0..1.0]: sets the level of the output signal from each Delay unit.

Reverb 1 and Reverb 2

There are two reverb effects in DSP-Quattro. They differ from one each
other for their internal algorithm. The first one is more intense, the second is
lighter. Depending on the audio file that you are working with, one could be
more suitable than the other.

+0.00

- L&R Gain Sliders: on the left there is a section with two gain sliders, one
for the Left, one for Right channel, to control the gain of the input signal
and to monitor it by the Vu-Meters.

- Efx Balance [0.0...1.0]: to set the ratio between the processed and the
input audio signals.

- Time [0.0..1.0]: to set the reverb time. This value is expressed as the
ratio between the minimum value (time = 0) and the higher possible value
(time=1.0).

- Absorption [0.0...1.0]: to set the factor which emulates the reflecting
properties of the walls in function of the frequency. Lower values
correspond to materials having an higher absorption at high frequencies.

- PreDelay [0...100 msec]: to set the time of the delay line which is on
input to the reverb effect. It simulates the time that it takes the first echo
to be heard due to the distance of the reflecting surface, for example,
when playing in a church or an open space.
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Parametric EQ

The Parametric EQ of DSP-Quattro has six full parametric filters.

It is possible to set the frequency, gain, and bandwidth (Q) of each filter.
Since all the filters have a full excursion on the frequency range, it is
possible to overlap two or more filters, to let them to work on the same
frequencies, producing very drastic signal equalization.

- L&R Gain Sliders: on the left there is a section with two gain sliders, one
for the Left, one for Right channel, to control the gain of the input signal
and to monitor it by the Vu-Meters.

- Reset: to reset each parametric filter to the default values.

For each parametric filter:

- Gain [-18..+18 dB]: to set the gain of the parametric filter.

- Freq [20..16000 Hz]: to set the central frequency of the frequency band.

- Q[0.0..5.0]: it controls the width of the frequency response curve of the
filter. Higher values correspond steeper curves, ie a more selective filter.

Graphic EQ
The graphic equalizer of DSP-Quattro built-in uses a bank of seven filters to
modify the frequency contents of the audio signal. Each filter is centered

around a different frequency according to a logarithmic scale. It is possible to
set the gain of each filter in the £18 dB range.

Link L&R

DSP-Quattro 5 User Manual 96



- L&R Gain Sliders: on the left there is a section with two gain sliders, one
for the Left, one for Right channel, to control the gain of the input signal
and to monitor it by the Vu-Meters.

- Reset: to reset all gains to 0 dB.

- Gain [-18...+18 dB]: to set the gain of each frequency band. It is also
possible to enter the numerical value clicking on the control below the
slider.

- Link L&R: when turned On, setting a gain value for one channel, will set
the same value for the other channel as well.

Resonant LowPass, BandPass, HighPass and BandReject Analog Filter emulations

Among the effects of DSP-Quattro, there are the filters that simulate the

resonant analog filters, that became famous in the music world during the

'70s, in - now vintage - synthesizers. The following analog resonant filters
are available: LowPass, HighPass, BandPass and Notch.

. LowPass
=

BandPass1

BandPass2

HighPass

Notch
+0.00

Each filter uses its own interface that is however very similar to the other.
You can set the cutoff frequency, the resonance at cutoff frequency — called
Resonance for LowPass and HighPass, or Q in the other cases — and the
slope of the curve, measured in -dB/octave. Higher slopes bring to more
selective filters, that are more resonant and that cut frequencies with steeper
curves.

- L&R Gain Sliders: on the left there is a section with two gain sliders, one
for the Left, one for Right channel, to control the gain of the input signal
and to monitor it by the Vu-Meters.

- Shape: to choose among one of the following:

* Resonant LowPass: it cuts all frequencies above the cutoff frequency.
Slope can be set to -12 or -24 dB/Octave.

« Resonant BandPass 1: it cuts the frequencies outside the band
centered around the cutoff frequency.
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« Resonant BandPass 2: similar to BandPass 1, but a lot more resonant.

+ Resonant HighPass: it cuts all frequencies below the cutoff frequency.
Slope can be set to -12 0 -24 dB/Octave.

- BandReject: it cuts the frequencies in the band centered around the
cutoff frequency. It can be very selective with high values of Q, and is
very useful when you want to remove from the audio signal a specific
frequency, such as the power line noise at 50 o 60 Hz.

- Slope: to set the slope (-12 or -24 dB) of the filter.

- Frequency [20..16000 Hz]: to set the value of cutoff frequency.

- Resonance/Q: to set the resonance value or the filter bandwidth. Higher
resonance value produces higher gains around the frequency of cutoff

that may cause the auto-oscillation of the filter, exactly as it happens
working with analog filters.

DSP-Quattro 5 User Manual

98



The AudioCD Layout

Click on the AudioCD tab on top of the Project window to show the AudioCD
main view:

00 L4 Untitled

Audio Editor | AudioCD Mixer
] =]
AwdoCDlnfo  RegionInfo  GD-Track Info v Effects
POFSheet  AudioCD Info . 7 " Fie Cmds
Ingort FXa

00:13:1974h1 2 0:26:340:452 e
ik EEE b w e T b e SR L i s P e eSS Ay 5 Edt P2
Pause: Crows 4
Start
&t P

Length:
@ CP-Copy Protection = 7]
@ PE-ProEnphasis .
00:0330:428 | 004:34:285 2 0007:18:857 | 00:08:4714 001003428 [00:10:58285 | 00:11:5314:
AT i T W " T EEEETY e — = ) Eit) Pt
DuiDaay ¢

Performer: it Fxs

Edit Fx
Edit Fx§

Edit Fx7
Edit Fx7 -

Edit Fx8

Copy To Next Copy ToAl

Length P PE ISRC
0004:41:414 | X
0001:01:582 | X
00:0035:658 X

L4 12| AUTO 00:00:00:000 AUTO 006 00:00:02:000 1B

AudioCD Layout 5: 0001 UTO 00:01:05:626 AUTO 007 00:00:02:000 MY 00:

e e e D 00:00-00: = - L8R MainoUTs
— . - s Dl E—

As already introduced, the AudioCD Layout is a tool in DSP-Quattro to
assemble, and master a sequence of audio files. It is possible to create an
audio CD-ROM by adding audio files or regions of audio files to the AudioCD
Layout. These appear as Audio Regions on the AudioCD Layout view,

Then, it is possible to edit and arrange the Audio Regions of the AudioCD
Layout graphically or entering numerical values for their settings. It is also
possible to add effects on insert to each audio region or to the output of the
AudioCD Layout as well. These effects can be chosen among the built-in
effects of DSP-Quattro or the AU effect plug-ins installed on MacOS.

Moreover, it is possible to edit the pre-gaps/pauses between CD-Tracks and
to set fade-ins, fade-outs or crossfades between one audio region and the
next.

The output of the AudioCD Layout can be a new audio file which can be
used as an audio CD-ROM image file by DSP-Quattro itself to burn a
physical audio CD-ROM using the internal or external CD burner device - if
connected to your mac.

DSP-Quattro is able to export the AudioCD Layout in DDP 2 standard format
as well.

The AudioCD Layout allows to assemble an audio CD-ROM very easily and
in only a few steps: just add the audio files to the AudioCD Layout, DSP-
Quattro will automatically create a CD-Track for each audio region added to
the AudioCD Layout. in most cases, the audio CD-ROM is now ready.

DSP-Quattro 5 User Manual 99



DSP-Quattro offers also a very powerful Advanced MODE, to allow every
kind of free combinations among audio regions and CD-Tracks. In Advanced
Mode, it is possible to have configurations where a single CD-Track plays
several audio files or audio regions, or where several CD-Tracks play the
same audio file or audio region.

Now let’s introduce better the concept of audio file region and CD-Track, and
the way of working of DSP-Quattro, in EASY or ADVANCED MODES, and
what are the AUTO or MANUAL modes.

To help you to understand these concepts, let’'s begin with a very easy
tutorial.

Creating your first audio CD-ROM:

It is very easy to create professional-quality audio CD-ROMs using DSP-
Quattro. Just follow these a few steps:

Step 1: Add audio files to the AudioCD Layout

TS TS

MacOS X Finder

Audio Files

Run DSP-Quattro and add your audio files dragging them directly from the
MacOS file system on an empty AudioCD Layout waveform view.

It is also possible to use the menu commands on top of the AudioCD Layout
main waveform view to load new audio file on the AudioCD Layout. It is even
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possible to drag just a selection of the waveform view of the Audio Editor as

well.

When you add an audio file on the AudioCD Layout, DSP-Quattro creates an
audio region and a CD-Track as well:

Advanced Mode

File $ Bumn CD PDF Sheet AudioCD Info

00:06:20:090 00:09:30:136

00:15:50:226 00:19:00:272 00:22:10:317 00:25:20:362

00:08:25:034 00:08:37:659 0:08:50:285 00:09:02:911 00:09:15:537 00:09:28:163 00:09:40:789 00:09:53:414

3
Commands § Region Ir o

ID  Start Name Lengtt Gain Fade In Mode Fade Out

CD Track Commands 4§  CD-Track Info

ID Pause Start Title

004 00:09:17:240 4 Traccia Audio +0.00 00:00:00:000 AUTO 00:00:00:000. :00:02: 00:09:17:240 4 Traccia Audio

005 00:13:56:560 | 5 Traccia Audio : : +0.00 | 00:00:00:000
006 00:17:22:426 6 Traccia Audio B : +0.00  00:00:00:000
007 00:20:51:746 7 Traccia Audio +0.00 5

008 00:24:38:333 8 Traccia Audio 00:04:15:160 +0.00 ' 00:00:00:000

00:13:56:560 5 Traccia Audio
00:17:22:426 6 Traccia Audio

5 7 Traccia Audio
00:24:38:333 8 Traccia Audio

009 00:28:55:493 9 Traccia Audio 00:03:09:680 +0.00 00:00:00:000 AUTO 00:00:00:000 :00:02: 00:28:55:493 9 Traccia Audio

00:10:06:040

00:04:15:160
00:03:09:680

0D:28:30:408

PE ISRC

00:10:18:6€

Step 2: Optionally - set preGaps between CD-Tracks

If needed, set the pause, or pre-gap, between a CD-Track and the next one.
This will generate a countdown before the CD-Track start when a CD-Player

will play the audio CD-ROM.

DSP-Quattro allows to do it by using only one command, just clicking on the
Commands button on top of the CD-Track table, and selecting “Set All CD-

Track Pauses to...”:

Commands

4¢ ID Pause
001 00:00:02:000 "@" " MAN
002 00:00:00:000 ' & ' "AUTO
003 00:00:00:000 ' & ' "AUTO

Split CD-Track at Playback 3D

Remove Selected CD-Track 38X
Remove All CD-Tracks 08X

Set All CD-Track Pauses To....

00:01:

then, enter the Pause length (the standard is 2 secs), click on OK. All the
audio regions and CD-Tracks will move accordingly.
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Step 3: Optionally - edit and adjust crossfades between audio regions

It is possible to set a crossfade an audio region and the next one, just
clicking and dragging the waveform of an audio region to shift it on left or
right along the time x-axis. It is also possible to adjust the curves for the
crossfade, it is possible to set the gain, and to trim audio region start and
end points by using the mouse.

00:02:56:544 | | 00:03:55:392

Setting a crossfade, by default DSP-Quattro reduces the preGap of the CD-
Track corresponding to the beginning of the Audio Region. If needed, click
and drag the left part of the header of the CD-Track marker to set the pause/
preGap between the this CD-Track and the previous one:

aaradil it o

Each CD-Track marker is composed by two sub-markers, the left half for
setting the pause/preGap length, the right half for setting the start location.
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Step 4: Optionally - Enter CD-Texts for each CD-Track and for the audio CD

Clicking on the CD-Track Info button on top of the CD-Track table, DSP-
Quattro will show a side panel view where it is possible to enter all the
informations about CD-Texts, for each CD-Track and for the audio CD as
well.

AudioCD Info Region Info CD-Track Info
CD-Track Index:

Title:
Pause:
Start:

Length:

v CP - Copy Protection

@ PE - Pre Enphasis

ISRC:

Performer:
Songwriter:
Composer:

Arranger:

Message:

ID3 Tags

Copy To Next Copy To All

Step 5: Optionally - Add effects

It is possible to add effects on insert to each audio region and/or to the
AudioCD Layout mix, to enhance and modify the sound. Select the effects
among the high quality internal effects of DSP-Quattro, or among the AU
effect plug-ins from Apple or third-party manufacturers which are installed on
MacOS.

Of course, it is possible to adjust effect parameters and save and recall their
settings.
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» Outputs

s
H
v Effects - Copy Paste Compare

File Cmds
Insert FXs

" (&t Fx-1
Parametric EQ §

AOAOA0A0

O (B Fx-2
AUDyn...ocessor §

Fast and Smooth
Edit Fx-3

A
v

Copy Paste Compare

S Dynamics Processor
s g 80 -60 -40 -20 0 20 40

-60
-80

-100
44.1kHz-To 120
Audio Reg Details Output Level

4 ID Start AUDynamicsProcessor

001 00:00:02:000 5 Traccia Audio 00:01:47:343 :00:00: 00:00:00:000
002 00:01:49:343 5 Traccia Audio -1  00:01:14:374 :00:00: 00:00:00:000
003 00:03:03:718 5 Traccia Audio-3  00:01:18:319 :00:00: 00:00:30:138
WhoYouSaylam A
- 5 Traccia Audio - 4
(U]

AudioCD Layout

Step 6: Burn an audio CD-ROM or export as DDP

Last but not least, if a CD writer device is connected to your Mac, use the
internal audio CD burning engine to burn to burn a physical audio CD-ROM.

Easy Mode Advanced Mode

Audio CD File 4 PDF Sheet AudioCD Info

00:01:00:174 00:02:00:349 00:03:00:523

To do it, just use the BurnCD button which is on top of the AudioCD Layout
waveform view:

then, DSP-Quattro will do all the rest...
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It is also possible to export the current AudioCD Layout as DDP, a standard
used by most factories producing physical audio CD-ROMs. The DDP
standard defines the file format to generate an image file of an audio CD-
ROM, including CD-Texts.

Done!

And now, let's go into more detail to understand how the AudioCD Layout
works, introducing all its features, one after the other.
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The AudioCD Layout view:

The AudioCD Layout interface offers all the tools which you need to build
and edit your audio CD-ROM: it is possible to add and organize the audio
files - or audio regions - to play, see the waveform graphically, it is possible
to place CD-Track markers, set CD-Track pauses/preGaps and crossfades
between audio regions, play the AudioCD Layout to preview your changes,
and add effect plug-ins on insert almost everywhere.

AudioCD Channel Strip Waveform Views Info Side Panel

EasyMode | AdvancedMode wdioCD Info  Region Info  CD-Track Info

File 4  BumCD PDF Sheet AudioCD Info T

00:00:00:000 bo: 0d:08:53:160 00:13:19:741 00:17:46:321 (1:22:12:902 d9:482 00:31:06:63 3 00:39:59:22 Ttle:

Pause:
Start:

Length:

¥ CP-CopyProtection

@ PE-PreEnphasis
00:03:39:428 00i04:34:285 00:0829:142 00:07:18:857 0 -08:14:714 00:09:08%71 00:10:03:428 00:10:58:285 00:11:53:14;
| rar b I Iy I S o o il ISRC:

AUMt. sressor §

t Fx5

Edit Fx-6

s

Edit Fx7
—~ 1D3 Tags
Edit Fx-8

Copy To Next Copy ToAl

& B O 124122 <> o3
Commands §  Region Info Commands §  CD-Track info

D Start Name Length Gain  FadeIn Mode FadeOut  Mode Comment D Pause Start Title Length cP PE ISRC Message

001 00:00:02:000 01 Politik 00:05:18:693 40.00 | 00:00:00:000 AUTO 00:00:35:279 AUTO 001 00:00:02:000 @ | 00:00:02:000 01 Politik 00:04:41:414 | X [

002 00:04:45:414 02InMyPlace  00:01:53:494 +0.00 00:00:35:279 AUTO 00:00:12:253 AUTO 002 00:00:02:000 W@ 00:04:45:414 02InMyPlace  00:01:01:582 X primo brano
003 00:06:26:655 02In My Place -1  00:01:55:312 +0.00 00:00:12:253 AUTO 0701:20:693 MAN 003 00:00:02:000 M) 00:05:48:997 02In My Place -1  00:00:35:658

004 00:07:16:853 03 God...Your Face 00:01:45:895 +0.00 00:01:05:113 AUTO  0:23:701 AUTO 004 00:00:02:000 M) 00:06:26:655 02In My Place -1  00:00:48:198 altro brano
005 00:08:39:048 03 God...rFace-1 00:03:23:539 +0.00 00:00:23:701 AUTO O( 01:02912 AUTO 005 00:00:02:000 M@ 00:07:16:853 03 God PutASmi... 00:01:20:194 > questo mi piace
006 00:10:50:675 04 The Scientist  00:05:09:237 +0.00 00:01:02:912 AUTO 00 0:00:000 AUTO 006 00:00:02:000 M@ 00:08:39:048 03 God Put A Smi... 00:00:57:564 questo ancora.
AudioCD Lavout 007 00:16:10:912 05 Clocks 00:05:07:539 +0.00  00:00:00:000 AUTO 00: 1:05:626 AUTO 007 00:00:02:000 @) |00:09:38:612 03 God Put A Smi... 00:01:19:062

Regions | CD-Tracks [AudioCD

‘Time Display

Transport Bar Audio Regions Table CD-Tracks Table

The AudioCD Layout interface consists of the following main areas:

- The Transport Bar: in the lower part of the AudioCD view, there is a
transport bar to control the playback and the cursor position. By these
controls it is possible to play the AudioCD, to set the playback cursor, and
monitor starting and end points of audio regions and CD-Tracks.

- The AudioCD Channel Strip: in the left part of the AudioCD view, there
is a AudioCD channel strip to control and monitor the level of the signal
on output from the AudioCD.

-  Waveform Views: in the center of the AudioCD Layout view, there are
two views showing the audio CD waveform and CD-Tracks markers. This
is the main section of the interface. There are two waveform views: on
top there is overview, which always shows the whole AudioCD Layout
waveform, from the beginning up to the end. Below it there is a waveform
view which can be zoomed-in/out, allowing precise edits.
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On the waveform view, each audio region is represented by its own
waveform placed on the upper part one time, on the lower part the next
one, and so on, one after the other on opposite sides. This allows to see
graphically what happens when audio regions overlap one each other.

The waveform view area allows to edit graphically the position of audio
regions and cross-fades between them, to place and move CD-Track
markers for setting CD-Track preGaps and start locations. It allows to
zoom on any part of the AudioCD Layout time line. The scroll bar
underneath allows to scroll the waveform view along the x-axis. The level
of zoom can be easily modified by menu commands, by the keyboard, or
by the zoom buttons located in the lower right corner of waveform view
area.

- The Audio Region Table: this table shows the audio regions in
chronological order, one on each row of the table. Using this table, it is
possible to add, remove and organize each audio region of the AudioCD
Layout.

- The CD-Track Table: this table shows the list of the CD-Tracks in the
same order with which they appear on the audio CD-ROM, one for each
row of the table. Each row displays the information of each CD-Track.

- The Info Side Panel: it consists of three views. It is possible to switch
among these views by using the tabs in the upper part of the side panel.
These views show all the settings for the audio CD-ROM CD-Texts, the
settings for each audio region, including the effect plug-ins on insert to
each audio region, the settings for each CD-Track, including the CD-Text
of each one.

NOTE: It is possible to resize each part (waveform/overview view areas,
audio regions and CD-Track tables) of the AudioCD Layout view freely, by
clicking&dragging the borders of the views. Vertical borders can be dragged
horizontally, and horizontal borders can be dragged vertically.

The Transport Bar

The Transport Bar is in the lower part of the AudioCD Layout window. This
section consists of the buttons to play/stop the playback and to control and
monitor the position of the playback cursor as well as current audio region or
CD-Track start/end and title.

5 Traccla Audio start:  00:00:00:000 Regions CD-Tracks ' AudioCD

00:10:33:040  ene: 00:10:33:040

Time Display

The Playback Controls:

On the left part of the Transport Bar, there are the Playback Controls, which
consists of several buttons to control the playback of the AudioCD Layout.
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Playback at normal speed.

one click: Stop

double click: move the playback cursor to the
beginning of the AudioCD.

Playback at double speed, both forward and
reverse.

Go to the next or previous pause/start CD-Track
or generic marker

Toggle Cycle Mode ON/OFF. If the Cycle Mode
is ON, the playback, after reaching the end of
the region to play, restarts at the beginning
without interruption. Otherwise, it stops.

Toggle PreRoll ON/OFF. If the PreRoll is ON, the
playback starts 2 secs in advance when starting
to play.

NOTE: The keyboard controls the playback as well:

- Space Bar: to toggle Play/Stop mode. If it stops, the playback cursor
returns to the position which it had when the playback started.

- Return Key: to stop the playback. The playback cursor remains at the last
position which it reached before to stop.

- #0, #1. #2... keys on the Numeric Keypad: pressing the key 0 on the
numeric will move the playback cursor at AudioCD Layout start. Pressing
key 1 will move to the first CD-Track start, pressing key 2 will move to the
second CD-Track, and so on.

The Counter Display
In the central part of the Transport Bar there is the Counter Display, which

shows you information regarding the playback cursor, the current audio
region, or the current CD-Track, or the audio CD-ROM.

5 Traccia Audio - 2 start:  00:00:00:000 Regions CD-Tracks AudioCD

00:04:22:218 End: 00:10:33:040

Time Display

What DSP-Quattro shows on the display depends on which button of the
group on the right of the display, above the Time Display label, is lit:
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- Regions: if the Regions button on the right of the display is lit, then on
the left part DSP-Quattro shows the current playback position relative to
the current audio region and above it the current audio region title. On the
right of the playback position, there are the current audio region start and
end positions, relative to the start of the AudioCD Layout.

- CD-Track: if the CD-Track button on the right of the display is lit, then on
the left part DSP-Quattro shows the current playback position relative to
the current CD-Track and above it the current CD-Track title. On the right
of the playback position, there are the current CD-Track start and end
positions, relative to the start of the AudioCD Layout.

- AudioCD: if the AudioCD button on the right of the display is lit, then on
the left part DSP-Quattro shows the current playback position relative to
the start of the AudioCD Layout and above it the current CD-Track title.
On the right of the playback position, there are the start and the length of
the AudioCD Layout.

The default time unit setting of hours:minutes:seconds:milliseconds can be
changed with the commands on the menus Options->X-Axes Unit to one
of the following: Frames, Seconds, Milliseconds or AudioCD (CDDA).

The AudioCD Layout Channel Strip
The left part of the Audio Playback Control Section hosts the Audio Editor

channel strip interface. It allows you to set the gain to apply on the output
signal of this audio generator, as well as the Vu-Meters.

0] ()"
AudioEditor

Please refer to the previous chapter for the description of the Gain/VU
Meters control view elements.

v Outputs

MainOUT

Aux1 Aux2
Aux3 Aux4
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On top of the AudioCD Layout channel strip, there is a control to set L&R
outputs. Use this to address the L&R MasterOut or one of the available
Auxiliary Busses.

Below it there are the effects on insert to the AudioCD Layout output. Click
on the white triangle on the left to disclose the FX view:

v Effects

()" File Cmds
Insert FXs

) "Edit Fx-1

Parametric EQ §

¢y 'Edit Fx-2
AUDelay 4

(U] Edit Fx-3
PSP Vi...armer2 §

Edit Fx-4

These effects process the output of the AudioCD Layout, that is all the audio
regions. In other words, DSP-Quattro will apply the same serial chain of
effects when it plays the different audio regions which are part of AudioCD
Layout.

This serial chain of FX will be rendered to file burning or exporting the
AudioCD Layout, ie DSP-Quattro will process the audio regions thru these
effects when burning an audio CD-ROM or exporting a DDP image.

If needed, it is also possible to load different effects for each audio region. To
know more about the FX on insert to each audio region, please see later in
this chapter.

It is possible to load up to eight effects to choose among the high quality
internal effects of DSP-Quattro, or among the AU effect plug-ins by Apple or
third-party manufacturers which are installed on MacOS.

It is also possible to copy the chain of effects to duplicate it into other FX
chain on insert to a different object.
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Please refer to the previous chapter for the description of the insert FX view
elements and about using it.
Waveform Views
In the middle of the AudioCD Layout view there are two waveform views: the
waveform overview and the main zoomable waveform view.
The AudioCD waveform overview

The upper waveform view is the overview. It always shows the whole
AudioCD Layout waveform, from the beginning up to the end.

00:00:00:000 00:01:(19:646 00:02:39:292 :03:58: :05:18: 5 00:07:57:877 00:09:17:523 00:10:37:17

1.00
0.00
1.00
0.00
1.00
0.00
1.00
0.00
1.00

This view is a waveform view without the zoom in/out controls. It is very
useful to know always which region is playing, to place and move the
playback cursor, and even to set where to zoom on the below main
waveform view.

Above the waveform view there is the Time Ruler. To set the unit used by the
time ruler use the menu command Options->X-Axis Unit. Possible values
are hours:minutes:seconds:milliseconds, Frames, Seconds, Milliseconds or
AudioCD (CDDA). On the right side there is the Level Ruler, that shows the
level of samples, using the measure unit set in the menu Options->Y-Axis
Unit. This unit can be chosen among different formats, such as Floats, dB
(decibel), Percentage (normalized in the range [-1.0...1.0]).

Below the waveform display, there is a special Zoom Controller (the orange
rectangle in the figure above), that can be used to set the zoom level that will
be then used by in the main waveform view area. This control highlights in
orange the region that the main waveform view area displays. By clicking on
it and then dragging the mouse, it is possible to set the position where the
main waveform view must scroll and its zoom level:

- going with the mouse over the Zoom controller, the mouse pointer will
turn into a magnifying glass.

- clicking on it and dragging to left or right the mouse, the control draws
an orange region. Then, releasing the mouse button, the main waveform
view scroll to the position where the orange region starts, and zooms to
display waveform corresponding to the waveform region of the overview
which coincides with the orange rectangle.

-~ + mouse click and dragging, DSP-Quattro will scroll the zoomed area
over the new region pointed by the mouse, without modifying the zoom
level.

Clicking on the time ruler and dragging the mouse, it is possible to define a
specific region of the AudioCD Layout to play. The same can be
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accomplished by clicking and dragging the time ruler of the main waveform
view. Please refer to the next chapter describing the AudioCD Layout main
waveform view to know more about it.

The AudioCD Layout main waveform view area

The main waveform view area is the main workspace for working with the
AudioCD Layout. On the main waveform view, it is possible to edit audio
regions and CD-Track markers graphically. DSP-Quattro places the audio
regions, alternately, between the top and bottom areas of the waveform view.
The two rows are functionally identical, this design makes very easy and
user friendly to edit overlapping regions.

CD-Track preGap and start markers Audio Region waveform
Time Ruler Playback region

00:01:57:551 00:02:56:326 00:03:55:102 00:04:54877 00:05:52:653 011:06:51:428 00:07:50:2)4 00:08:48:979

il
il

1:25020 <>

AudioCD Info Mouse Mode buttons Zoom In/Out buttons

Each audio region is displayed as a rectangle, containing a green waveform.
Each audio region has an envelope curve, to set the gain level and fade-in/
out lengths and curves. CD-Track preGap/pause and start markers are
displayed with a green head.

Zoom In/Out Buttons:

Exactly like the overview, the main waveform view shows the waveforms of
the audio regions. However, this view can zoom-in any part of the waveform
up to the level one sample = one pixel. X and Y axis have an independent
zoom levels. It is possible to zoom-in the vertical axis without limits, even up
to show the quantization noise in the audio file.

To zoom In/Out:
- Use the mouse wheel: to set the horizontal X-Axis zoom-in/out ratio.
The same can be done moving vertically 2 fingers on the Apple

Trackpad, if applicable. 38 + mouse wheel set the vertical Y-Axis zoom-
in/out ratio.
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- Use the +/- buttons: use the +/- at the bottom right of the waveform
view to zoom in/out horizontally on the X-Axis or vertically on the Y-Axis.

After zooming-in, the scroll bar will let to scroll the main waveform view to
another position. Do not forget that it is also possible to use the zoom
controller of the waveform overview to zoom in/out on a certain region of the
AudioCD.

Exactly like the Audio Editor, while playing, the main waveform view will
scroll to the next page as soon as the playback cursor will reach the right
border of the waveform view area.

Mouse Mode Buttons:

These buttons choose one of the edit pointer modes, to perform different
tasks on audio regions and CD-Tracks on the main waveform view.

Mouse Mode to shift regions

Mouse Mode to cut regions

Mouse Mode to add CD-Tracks
(only in Advanced MODE)

Depending on the AudioCD current edit mode, which can be EASY or
ADVANCED (more about this later on this manual), there are two or three
mouse edit modes:

- Audio Region Shifter: in this mode, clickihg on an audio region
waveform and dragging the mouse will shift that audio region forward or
backward along the time axis.

- Audio Region Scissor: in this mode, clicking on an audio region
waveform, DSP-Quattro will split that audio region in two audio regions
on that position. DSP-Quattro will also create a new CD-Track at split
point, where the second audio region starts. All other audio regions and
CD-Tracks will remain unaffected.

- CD-Track Scissor (available only if the AudioCD is on ADVANCED
edit Mode): in this mode, clicking on an audio region waveform, DSP-
Quattro will split the CD-Track in two CD-Tracks on that position, adding
a CD-Track marker. other audio regions and CD-Tracks will remain
unaffected.

NOTE: While the mouse mode is in Regions Shifter mode, you can press the
~ key to switch momentary to the Region Scissor Mode.

NOTE: more about the AudioCD EASY and ADVANCED edit modes later in
this manual.
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The Audio Region Waveform view:

Each audio region loaded in the AudioCD Layout appears in the main
waveform view and in the audio region table. The main waveform view
displays the waveforms of each audio region chronologically from left to
right, in the upper or lower half of the view area alternately, to make it easier
to view any overlapping areas between two regions.

D0(02:56:326 00:03:55:102 00:04:53:877 00:05:52:653 00:06:51:428 00:07:50:204

Each audio region waveform view has its own envelope curve for the gain
level, with parameters to set the attack and decay times and the shape of
the curves, and the gain level. It is also possible to edit audio regions, as you
can resize, trim the start and the end, shift them back and forth in time, split,
and very much more. More about this later in this chapter.

The Playback Cycle:

It is possible to loop (or cycle) a region of the AudioCD Layout, so that DSP-
Quattro plays only that region. This is useful to preview a specific region, like
a crossfade between audio region, or the audio at CD-Track start. It possible
to set a cycle region using one or the other of the two time rulers, the one on
the AudioCDLayout waveform overview or the other one on the
AudioCDLayout main waveform view.

Cycle Region
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- to set a Playback cycle region: click on the time ruler of the overview or
main waveform views and drag the mouse from the cycle start position to
the cycle end position.

- to remove the Playback cycle region: Click anywhere on the time ruler
outside the current playback cycle region.

If there is a Playback cycle region, DSP-Quattro plays only that region. If the
cycle button on the transport bar is ON, as soon as the playback cursor
reaches the end of the region, it will jump to the playback region start without
any interruption. If the cycle button on the transport bar is OFF, the playback
will stop as soon as it will reach the playback region end.

The Time Ruler:

Above the waveform there is the Time Ruler. To set the unit used by the time
ruler use the menu command Options->X-Axis Unit. Possible values are
hours:minutes:seconds:milliseconds, Frames, Seconds, Milliseconds or
AudioCD (CDDA). On the time ruler DSP-Quattro draws also the heads of
CD-Track markers (the green markers), each one of these is constituted by
two sub-markers, the preGap/pause and start CD-Track markers. The
playback cursor is the red marker. More about CD-Track markers later in this
chapter.

The Audio Regions table and Audio Region Info view

Audio Regions

4¢ ID Start

Audio Regions table shows the audio files - or audio file regions - which
constitute the AudioCD, one for each row of the table:

Commands ¥ Region Info

Name Length Gain FadeIn Mode Fade Out Mode Comment

001 00:00:02:000 | Don't Know Why 00:01:14:425 +0.00 00:00:00:000 'AUTO 00:00:00:549 "AUTO This is the first song
002 00:01:15:875 || Don't Know Why - 1 1 00:01:51:931 ' +0.00  00:00:00:549 [AUTO | 00:00:00:960 |AUTO
003 00:03:06:846 Example...Kings Choir 00:00:30:328 +0.00 00:00:00:960 'AUTO | 00:00:00:000 ~AUTO

Audio file regions are listed chronologically, from top to bottom, identified by
an ID#. Selecting an audio region in the Audio Region table, the same audio
region is also selected on the waveform views.

NOTE: it is possible to reorder audio regions by clicking and dragging
them up or down. Alt-clicking and dragging will duplicate that audio region.

NOTE: it is also possible to change the order of the columns of the table
by clicking and dragging the column header to left or right. It is possible to
resize each column width by dragging its left or right header border as
well.

The Audio Regions table displays the following information about each audio
region:

- The Speaker icon shows which region is currently playing.

- Start time of that audio region (expressed in the units used also by the time
ruler)
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- Audio region Name

- Audio region Length (expressed in the units used also by the time ruler)

- Audio region Gain level (dB)

- Fadeln Length (expressed in the units used also by the time ruler)

- Fadeln Auto/Manual mode (see the details about this later in this chapter)

- FadeOut Length (expressed in the units used also by the time ruler)

- FadeOut Auto/Manual mode (see the details about this later in this chapter)

- Comment

The Audio Region Info view:

AudioCD Info Region Info CD-Track Info
Audio Region Index:

Name:

Length:

Start:

Gain:

Comment:
Length: AUTO

Fade In
Curve: ExpCurve % Set Linear

Length: AUTO
Fade Out
Curve: =~ ExpCurve ¥ Set Linear
Source Audio File

ccia Audio

Commands #§

Parametric EQ

AUDynamicsProcessor

PSP VintageWarmer2

Toraverb

To show the Region Info view,
- Double-click on a Region row of which you wish to know or edit info.

- Select the Region, then click on the Region Info button on top of the Audio
Regions table.

- Click on the leftmost button among the three which are on the top of the
AudioCD view:

] — o
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The Info side panel, under the Region Info view tab, allows you to view and
edit information about the currently selected region and its source audio file.
Some of these fields are editable, some are not.

The + and - buttons which are on the upper section of the the Info side panel
allow you to step between an audio region and the previous or next one in
the audio region list. This is very useful when you wish to edit a particular
parameter on several regions.

To close the Region Info view, click again on the Region Info button on top of
the Audio Regions table.

The Region Info view displays the following information:

- Name: it is the audio region name. It is an editable field, just double click
on it and type the new name.

- Length: the audio region length (expressed in the units used also by the
time ruler). It is an editable field.

- Start. the audio region start expressed as offset from the AudioCD
Layout start. It is an editable field, double click on it and type the new
value. DSP-Quattro will automatically adjust the new value to be into the
allowed range if it is not possible to assign the value you entered.

- @Gain: the audio region Gain level, expressed in dB. It is an editable field,
double click on it and type the new Gain. DSP-Quattro will automatically
adjust the new value to be into the allowed range if it is not possible to
assign the value you entered.

- @Gain Reset: use this button to reset the Gain value to 0dB.

- Comment: it is the Comment about that audio region. It is an editable
field, double click on it and type the text.

- Fade-In Length and Curve: the audio region Fade-In time and its curve
shape. To edit the value of the fade length, double click on it and type the
new value. DSP-Quattro will automatically adjust the new value to be into
the allowed range if it is not possible to assign the value you entered.

- Fade-In Set Linear: reset the shape of the fade-In curve to linear.

- Fade-In Auto Mode: switch ON/OFF the auto mode for that Fade-In.
More about the Auto Mode for cross-fades later in this chapter.

- Fade-Out Length and Curve: the audio region Fade-Out time and its
curve shape. To edit the value of the fade length, double click on it and
type the new value. DSP-Quattro will automatically adjust the new value
to be into the allowed range if it is not possible to assign the value you
entered.

- Fade-Out Set Linear: reset the shape of the Fade-Out curve to linear.

- Fade-Out Auto Mode: switch ON/OFF the auto mode for that Fade-Out.
More about the Auto Mode for cross-fades later in this chapter.
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- Audio File: it is the name of the source audio file.

On the bottom part of the Region Info view, there is a section to load, edit
and manage to the AU plug-ins and/or internal effects on insert to that audio
region only. These effects process the output of only that audio region.

This serial chain of FX will be rendered to file burning or exporting the
AudioCD Layout, ie DSP-Quattro will process the audio region thru these
effects when burning an audio CD-ROM or exporting a DDP image.

It is possible to load up to eight effects to choose among the high quality
internal effects of DSP-Quattro, or among the AU effect plug-ins by Apple or
third-party manufacturers which are installed on MacOS.

It is also possible to copy the chain of effects to duplicate it into other FX
chain on insert to a different object.

Refer to the previous chapter for the description of the insert FX view
elements and about using it.

Please see next chapters to know how to work with the Region list and how
to add, remove, edit Regions.
The CD-Tracks Table and CD-Track Info view

The CD-Tracks table shows the CD-Tracks as they will appear on the audio
CD-ROM. It shows information about each CD-Track, one for each row of
the table.

CD Tracks Commands §  CD-Track Info

4¢ ID Pause Start Title Length CP PE ISRC Message
001/ 00:00:02:000 "@" "MAN" 00:00:02:000 ' | Don't Know Why 00:01:13:686 X
002/ 00:00:00:189 ' & " MAN | 00:01:15:875 | Don't Know Why - 1 00:01:50:970 X | IT0021234567  this is a message

003 00:00:00:000 & | AUTO 00:03:06:846 Example 5 - Kings Choir  00:00:30:328 =X

Selecting an audio region on the Audio Regions Table, the corresponding
CD-Track will be also selected on the CD-Tracks table.

NOTE: it is also possible to change the order of the columns of the table
by clicking and dragging the column header on left or right. It is possible to
resize each column width by dragging its left or right header border as
well.

The CD-Tracks table displays the following information about each CD-
Track:

- The ID is the index for that CD-Track.
- CD-Track Pause (expressed in the units used also by the time ruler)

- CD-Track Lock/Unlock icon. Shows if it is possible to set the pause length
(unlocked) or not (locked). See the details about this later in this chapter.

- CD-Track Auto/Manual mode. See the details about this later in this
chapter.
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- CD-Track Start (expressed in the units used also by the time ruler). It is the
offset from the Audio- CD start.

- CD-Track Name

- CD-Track Length (expressed in time or samples unit)

- CD-Track CP - Copy Protection flag ON/OFF

- CD-Track PE - Pre-Emphasis flag ON/OFF

- CD-Track ISRC code

- CD-Track Message

The Info side panel, under the CD-Track Info view tab, allows you to view
and edit information about the currently selected CD-Track. Some of these

fields are editable, some are not.

To show the CD-Track Info view:

AudioCD Info Region Info CD-Track Info
CD-Track Index:

Title:
Pause:
Start:

Length:

@ CP - Copy Protection

¥ PE - Pre Enphasis

ISRC:

Performer:
Songwriter:
Composer:

Arranger:

Message:

ID3 Tags

Copy To Next Copy To All

- Double-click on a CD-Track row of which you wish to know or edit info.

- Select the CD-Track, then click on the CD-Track Info button on top of the
CD-Tracks table.
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- Click on the rightmost button among the three which are on the top of the
AudioCD view:

(] . =

The + and - buttons which are on the upper section of the the Info side panel
allow you to step between a CD-Track and the previous or next one in the
CD-Track list. This is very useful when you wish to edit a particular
parameter on several CD-Track.

To close the CD-Track Info view, click again on the CD-Track Info button on
top of the CD-Tracks table.

The CD-Track Info view displays the following information:

Title: it is the CD-Track title. It is an editable field, double click on it and
type the new title.

- Pause: the CD-Track PreGap/Pause. It is an editable field, double click
on it and enter the new value for the CD-Track Pause. NOTE: the pause
in front of the first CD-Track is fixed to the redbook standard value of 2
seconds.

- Pause Auto Mode: switch ON/OFF the auto mode for that CD-Track
Pause. More about the Auto Mode for setting the Pause length later in
this chapter.

- Pause Lock/Unlock: Lock/Unlock the CD-Track Pause length. If locked,
it is not possible to enter a new value of the CD-Track pause, and it is not
possible to engage the Pause Auto Mode.

- Start: the CD-Track start position expressed as time or samples offset
from the AudioCD Layout start. It is an editable field, double click on it
and enter the new value. DSP-Quattro will automatically adjust the new
value to be into the allowed range if it is not possible to assign the value
you entered.

- Length: the CD-Track length expressed in the units used also by the
time ruler. It is an editable field, double click on it and enter the new
value. DSP-Quattro will check if the new value is into the allowed range,
and will show a warning dialog if it is not possible to complete the
operation.

- CP - Copy Protection: switch ON/OFF the Copy Protection flag for that
CD-Track. This info will be written on the audio CD-ROM during the CD
Burning process. NOTE: this is a pretty obsolete flag of the redbook
standard. Most CD-Players do not take care of it.

- PE - Pre Emphasis: switch ON/OFF the Pre-Emphasis flag for that CD-
Track. This info will be written on the audio CD-ROM during the CD
Burning process. NOTE: this is a pretty obsolete flag of the redbook
standard. Most CD-Players do not take care of it.

- ISRC: it is the ISRC code of the CD-Track. It is an editable field, double
click on it and enter the new value. DSP-Quattro will check if the new
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code has an acceptable format and if it fails it will show a warning dialog
refusing the new code. If the ISRC code is not an empty string, it will be
written on the audio CD-ROM during the CD Burning process.

- CD-Text: They are editable fields, click and enter the CD-Text strings for
the current CD-Track, they will be written on audio CD-ROM during the
CD Burning process.

Please read next chapters to know how to work with the AudioCD Layout
Regions and CD-Tracks and how to add, remove, edit CD-Tracks.

The AudioCD Info view

As the Region Info and CD-Track Info, the AudioCD Info view is a subview of
the Info side panel, under the AudioCD Info view tab. On the AudioCD Info

view, DSP-Quattro allows you to enter also the EAN/UPC sub-code and
CD-Text strings for the Audio CD-ROM.

AudioCD Info Region Info CD-Track Info
EAN/UPC Code:

v, Write CD-Texts on Disc
Title:
Performer:
Songwriter:
Composer:

Arranger:

Message:

cerve 0 (IS

ID3 Tags

To show the AudioCD Info view:
- Click on the AudioCD Info button on top of the AudioCD waveform view.

- Click on the rightmost button among the three which are on the top of the
AudioCD view, then on the AudioCD Info tab:

] = =

To close the CD-Track Info view, click again on the AudioCD Info button on
top of the AudioCD waveform view.
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The CD-Track Info view displays the following information:

- EAN/UPC Code: this is the EAN/UPC sub-code for the audio CD-ROM. It
should be a string of 12 or 13 numerical digits.

- CD-Text: They are editable fields, click and enter the CD-Text strings for
the current CD-Track, they will be written on audio CD-ROM during the
CD Burning process.

Working with the AudioCD Layout

Audio files - or regions of audio files - and CD tracks are the elements which
constitute your audio CD. DSP-Quattro creates one audio region and one
CD-Track automatically when an audio file is added to the AudioCD Layout.

To describe how the AudioCD Layout works, let’s introduce the following
definitions:

- Audio files: audio files are the source material for the audio regions used
by the AudioCD Layout.

- Audio Regions: adding an audio file to a AudioCD Layout, DSP-Quattro
creates an audio region automatically. This audio region can address the
entire source audio file or any section of the audio file. When you edit an
audio region on the waveform view or in the Audio Regions table of the
AudioCD Layout, the edits concern only the audio region, not the source
audio file.

- CD-Tracks: adding an audio file to a AudioCD Layout, DSP-Quattro, in
correspondence to the new Audio Region, automatically creates also a CD-
Track. CD-Tracks are the “tracks” which a CD-Player will show to the user
selecting a track number on its display or pressing the forward/backward
buttons while playing the audio CD-ROM.

NOTE: DSP-Quattro allows an Advanced Mode to work with the AudioCD
Layout. In Advanced Mode, a CD-Track can include several audio regions,
and several CD-Tracks can play sections of the same audio region. In other
words, it's possible to combine several audio files into one CD-Track, or
create several CD-Tracks which use only one audio file.

Easy and Advanced Modes

DSP-Quattro allows two operational Modes to work on the AudioCD Layout:
the Easy and the Advanced modes. The difference between these two
modes is the allowed relationship between audio regions and CD-Tracks.

NOTE: If you are familiar with the previous versions of DSP-Quattro, which
did not introduce the Easy or Advanced Modes, just consider that the
previous versions of DSP-Quattro were always in Advanced Mode.

AudioCD Layout EASY Mode

On EASY MODE, the relationship between audio regions and CD-Tracks is
fixed to one-to-one (1:1). This means that it is possible to have only the
configuration where to one audio region (or audio file) corresponds one CD-
Track - which will be the track that a CD-Player will show playing that audio
region (ie song on the audio CD-ROM):
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EasyMode  Advanced Mode

oCD File ¢ Bum CD PDF Sheet AudioCD Info

00:03:10:0#5 00:06:20:090 00:09:30:136 00:12:40:181 00:15:5(:226 3 00:22:10:317 00:25:20:362 0D:28:30:408

00:08:25:034 00:08:37:659 00:08:50:285 00:09:02:911 00:09:15:537 00:09:28:163 00:09:40:789 00:09:53:414 00:10:06:040 00:10:18:6€

' Dy 1:5568 <>

Commands 4  Region Info CD Tracks 4 CD-TrackInfo

ID Start Name Length Gain Fade In Mode Fade Out Title Length CP PE ISRC

240 4 Traccia Audio 00:04:37:320 +0.00 X A AUTO 00 ¢ X - X £ 4 Traccia Audio 00:04:37:320
:560 5 Traccia Audio 00:03:23:866 +0.00 :00:00:f AUTO  00:00:00:f X - 00:13:56:560 5 Traccia Audio 00:03:23:866
00:03:27:320 +0.00 :00:00:f AUTO :00: :00:02: 00:17:22:426 6 Traccia Audio 00:03:27:320

:746 7 Traccia Audio 00:03:44:586 +0.00 :00:00:f AUTO 00:00:00: X - 00:20:51:746 7 Traccia Audio 00:03:44:586
3 8 Traccia Audio 00:04:15:160 +0.00 :00:00:f AUTO  00:00:00:f . & 8 Traccia Audio 00:04:15:160
:493 9 Traccia Audio 00:03:09:680 +0.00 :00:00:f AUTO 00:00:00: :00:( :55: 9 Traccia Audio 00:03:09:680

In this case, clicking on an audio region waveform and dragging it to shift it
in time, the corresponding CD-Track will shift as well. And, of course, clicking
on a CD-Track start marker and dragging it to shift it in time, the
corresponding audio region will shift as well.

NOTE: also on Easy Mode, it is possible to place several CD-Tracks on the
same source audio file using the scissor mouse mode. Using the scissor,
DSP-Quattro will split the source audio file (or audio region) into two audio
regions, creating a CD-Track at the beginning of the new audio region. More
about the mouse modes later in this chapter.

EasyMode  Advanced Mode

Audio CD File $ Bum CD PDF Sheet AudioCD Info

00:00:00:000 00:00:18:743 00:00:37:487 00:00:56{231 00:01:14:975 00:01:33/718 00:0):52:462 X 2 00:02:29:950 00:02:48:693
] o i PO L ||

02:24:544 00:02:26:285 5 k| :34: 00:02:36:734 00:02:38:476 00:02:40:217

R By 0

Commands 4  Region Info CD Tracks Commands 4  CD-Track Info

ID Start Name Length Gain  Fade In Mode Fade Out N ID  Pause Start Title Length CP PE ISRC
001 00:00:02:000 Internals 00:03:07:895 +0.00 00:00:00:000 AUTO 00:00:00:000 # :00:02:f 00:00:02:000 Internals 00:00:06:708 X
00:00:10:708  Internals - 00: 108 X
00:00:20:817 Internals - 1 - 00:00:08:198
00:00:31:015 Internals -1 -1 - 00:00:07:153
00:00:40:169 Internals - 1-1-... 00:00:05:740
00:00:47:909 Internals - 1 - 00:00:06:628
00:00:56:538  Internals - 1 - 00:00:09:058
00:01:07:597 Internals - 1 - 00:00:07:161
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004 00:00:31:923 Carissim...cchio

006 00:00:57:643 Carissim...cchio
]

AudioCD Layout Advanced Mode

On ADVANCED MODE, the relationship between audio regions and CD-
Tracks is free, there is not a fixed relationship between the number of audio
regions and CD-Tracks, which can be a different number (n:m). This means
that it is possible to have configurations where several CD-Tracks markers
are placed on only one audio region (or audio file), or where a single CD-
Track extends over several audio regions.

In the figure above, as an example, there is only 1 source audio file (or audio
region) on which there are 21 CD-Tracks markers.

In the figure below, as another example, therein only 1 CD-Track which will
play 6 audio files (or audio regions):

Easy Mode Advanced Mode

io CD File ¢ Bumn CD PDF Sheet AudioCD Info

00:00:00:000 00:00:06:619 00:00:13:238 00:00:19:857 00:00:26:476 00:00:33:095 00:90:39:714 :09:46:333 00:00:52:952 00:00:59:571

00:00:00:000 00:00:03:773 00:00:07:546 00:00:11:319 00:00:15:092 00:00:18:866 00:00:22:639 00:00:26:412 00:00:30:185 00:00:33:959

R DBg o) 1:1664 <>

Commands 4  Region Info CD Tracks Commands 4 CD-Track Info

Length Gain Fade In Mode Fade Out N ID Pause Start Title Length CP PE ISRC

inocchio | 00:00:11:544 +0.00 00:00:00:000 AUTO 00:00:03:640 A 001 00:00:02:000 @ 00:00:02:000 Carissimo pinocc... 00:01:05:056 X
903 Carissim...cchio - 1 00:00:14:924 +0.00 00:00:03:640 AUTO 00:00:06:648 #
:18:179  Carissim...cchio - 2 +0.00 00:00:06:648 AUTO 00:00:02:018 M
-3 <0.93 00:00:04:668 AUTO 00:00:03:889 2
005 00:00:42:494 Carissim...cchio - 4 +0.00 00:00:03:889 AUTO 00:00:05:380 2
-5 00:00:09:412 +0.00 00:00:05:380 AUTO 00:00:00:000 A

In this case, clicking on an audio region waveform and dragging it to shift it
in time, the corresponding CD-Track will shift as well, as it happens on Easy
Mode, too. BUT, clicking on a CD-Track start marker and dragging it to shift it
in time, the underneath audio region will NOT shift accordingly. This allows
complex configurations where it is possible to place CD-Track start markers
freely, without the restriction to be always at the beginning of the underneath
audio regions, as it is always in Easy Mode.

Please note that it is highly recommended to step from the Easy to the
Advanced Mode only if it is necessary to place CD-Track start markers
freely, in positions which are different from the beginning of an audio region
or audio file start. In most cases the Easy mode is sufficient, and it
guarantees a clear and linked correspondence between audio regions and
CD-Tracks. In Easy Mode, DSP-Quattro will adjust CD-Track start positions
accordingly to the underneath audio regions automatically. In Advanced
Mode, this correspondence can be broken and, if it is not due an intentional
action, it may bring to unwanted results.
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NOTE: stepping from Easy Mode to Advanced Mode, an additional mouse
mode is possible, the CD-Track marker mouse mode. In this additional mode
it is possible to click on the AudioCD Layout waveform view to add CD-Track
start markers freely on the underneath audio regions, without any restriction
on their positions or number. More about the mouse modes later in this
chapter.

NOTE: stepping back from Advanced Mode to Easy mode, it may happen
that the current AudioCD Layout is not compliant to the Easy Mode
restrictions. As an example, it happens when there are several CD-Tracks
belonging to the same audio region. In these cases, DSP-Quattro will warn
you and will adjust the current AudioCD Layout moving, removing or adding
CDTrack start markers to be compliant to the Easy Mode. Of course, if the
result is not acceptable, it is possible to undo the operation to return to the
Advanced Mode and to the AudioCD Layout as it was just before to step to
the Easy Mode.

Working with AudioCD Layout Regions

You can copy, reorder, trim, split, adjust the gain curve shape of each audio
region. Working wit the AudioCD Layout, it possible to play all, or any part, of
the AudioCD Layout to immediately hear the results of the editing done.

Adding an audio file or audio region on the AudioCD Layout

- From the Document Manager table: drag&drop a title of an audio file
from the Document Manager table over the waveform view area of the
AudioCD Layout view. In this case, DSP-Quattro will create a new audio
region on the AudioCD Layout using the beginning and the full length of the
source audio file as reference for start end end points of the new audio
region on the Audio Regions table. It will add a new CD-Track on the CD-
Tracks table and a new waveform on the AudioCD waveform view area as
well.

From the AudioFile Editor: drag&drop a waveform selection or all the
waveform area from the Audio Editor waveform view over the AudioCD
Layout row on the Document Manager table. In this case, DSP-Quattro will
create a new audio region on the AudioCD Layout using the source
waveform selection (or all the audio file if there was not a waveform
selection when the drag started) as reference for start end end points of the
new audio region on the Audio Regions table. It will add a new CD-Track
on the CD-Tracks table and a new waveform on the AudioCD waveform
view area as well.

Directly from the MacOS finder: drag&drop one or more audio files from
the MacOS finder over the AudioCD Layout row on the Document Manager
table or on the waveform view area of the AudioCD Layout view. In this
case, DSP-Quattro will create a new audio region on the AudioCD Layout
using the beginning and the full length of the source audio file as reference
for start end end points of the new audio region on the Audio Regions
table. It will add, for each new audio region, a new CD-Track on the CD-
Tracks table and a new waveform on the AudioCD waveform view area as
well.

- By Menu Commands:

A) menu commands on the AudioCD view:
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- click on the File button on top of the waveform view of the AudioCD view,
the following menu will appear:

Easy Mode Advanced Mode
filo ©e Import Audio File...
Import DDP...

00:00:00:000 :00: Import Project Audio File

Replace Audio Region with...
Replace Audio Region with Project Audio File

1.00
0.00
1.00
0.00
1.00
0.00
1.00
0.00
1.00

Export

- Import Audio File... (or £*380): DSP-Quattro will show a file browser, to
let you to choose one or more audio files from the finder. Then, DSP-
Quattro will use those audio files to create new audio region(s) on the
AudioCD Layout table and, for each new audio region, one CD-Track on
the CD-Tracks table and a new waveform on the AudioCD waveform view
area.

- Import DDP... (or \_380): DSP-Quattro will show a file browser to locate
on the MacOS file system the folder containing the DDP files to import.
Just navigate to locate the folder, DSP-Quattro will check the integrity of
the files and will create a new AudioCD Layout accordingly to what saved
on DDP files.

- Import Project Audio File: in correspondence of this menu item DSP-
Quattro shows a sub menu where it lists all the audio file loaded into the
current Project. Selecting one of these audio files, DSP-Quattro will
create a new audio region on the AudioCD Layout using the beginning
and the full length of the source audio file as reference for start end end
points of the new audio region on the Audio Regions table. It will add a
new CD-Track on the CD-Tracks table and a new waveform on the
AudioCD waveform view area as well.

B) menu commands on the Audio Editor view:

To load a new audio region on the AudioCD Layout, there are some menu
commands on the Audio Editor as well.

On the Audio Editor, clicking on the File button on top of the waveform view,
there is a sub menu under the item Send to AudioCDLayout:

| Don't Know Why Example 5 - Kings Choir

New Audio File

Import Audio File 52: 00:01:10:385 00:01:27:981

Save Current Audio File Edits ~3S
Duplicate Current Audio File  ~8C

Export Audio File ‘
& b

Append As AudioRegion
Append Only Selection As AudioRegion

Generic Markers List To AudioCDLayout
Audio Regions List To AudioCDLayout
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- Append As AudioRegion: to add the current audio file to the AudioCD
appending it at the end of the AudioCD. DSP-Quattro will create a new
audio region on the AudioCD, using the default setting for the CDTrack
preGap and the CD-Texts of the audio file to fill the CD-Texts of the new
audio region.

- Append Only Selection As AudioRegion: as “Append As
AudioRegion”, but using only the region defined by the selected audio
file waveform. If there is not an audio selection on the waveform view,
this command is not available.

- Generic Markers List to AudioCDLayout: to create audio regions and
CD-Tracks on the AudioCD from the Generic markers list, one for each
marker. Each audio region on the AudioCD will extend from one generic
marker to the next one on the list. DSP-Quattro allows you to choose
between clear the AudioCD before to build it, or to append the new audio
regions to the end of the current AudioCD. If there are not generic
markers, this command is not available.

- Audio Regions List to AudioCDLayout: to create audio regions and
CD-Tracks on the AudioCD from the audio regions list, one for each
audio region. DSP-Quattro allows you to choose between clear the
AudioCD before to build it, or to append the new audio regions to the end
of the current AudioCD. If there are not audio regions, this command is
not available.

NOTE: DSP-Quattro will always use the source files which it imported into
the Project bundle for the audio regions on the AudioCD Layout. All the edits
you will do on the same source audio files on the Audio Editor will reflect on
the corresponding audio regions on the AudioCD Layout. For this, DSP-
Quattro does not allow to process and audio file if the result is not
compatible with the current AudioCD Layout like, as an example, to change
the sample rate of source audio file if it is also loaded on the AudioCD
Layout.

Removing an audio region from the AudioCD Layout:

44.1 kHz - Total Length: 00:03:37:174 R DB

Audio Regions el Split Audio Region at Playback ~ %T

W I sl Remove Selected Audio Region 38<&

EUVUVGZORIBEIGBY  Remove All Audio Regions 08
002 00:01:15:875 | Don't K...
R S o, Replace Audio Region with... #R

Normalize Selected Audio Region
Normalize All Audio Regions
Normalize AudioCD

3

To remove an audio region from the AudioCD Layout, first select it on the
audio regions list on the Audio Regions table (or click on its waveform on the
waveform view), then click on the Commands button on top of the Audio
Regions table and use the menu command Remove Selected Audio
Region (or press 3 + backspace).
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If you need to clear the AudioCD Layout, use the menu command Remove
All Regions (or press 1+ 88 + backspace).

Changing the order or duplicate an audio region on the AudioCD Layout:

Selecting an audio region on the Audio Regions table, DSP-Quattro will
select the same region on the waveform view.

To change the order of audio regions, use the Audio Regions table. First
select the audio region to move or to copy on the Audio Regions table or on
the waveform view, then click the row on the table - except for the speaker
column - drag the row up or down on the Audio Regions table up to reach
the destination row.

NOTE: It is also possible to duplicate the audio region, just keeping the alt
key pressed when releasing the mouse button on the destination row.

The AudioCD Layout Mouse Modes

In EASY mode, at the bottom of the AudioCD Layout main waveform view,
there are two buttons to set the mouse modes:

- Shifter Mode (the default mouse mode, the left button): when the mouse
pointer is in Shifter Mode, clicking and dragging the waveform of an audio
region on the AudioCD Layout main waveform view, will shift that audio
region back and forth on the time line, and the CD-Tracks and audio
regions which are after that audio region will follow.

- Scissor Mode (the right button in EASY Mode): when the mouse pointer
is in Scissor Mode, clicking the waveform of an audio region on the
AudioCD Layout main waveform view, will split that audio region into two
audio regions. DSP-Quattro will also add a CD-Track marker at the
beginning of the new audio region at split point.

NOTE: it is possible to switch temporary between the shifter and scissor
mouse modes pressing the alt key before to click with the mouse on a
certain position of the waveform of an audio region. Releasing the alt key will
return to the shifter mouse mode.

In ADVANCED mode, there is one more option:

- CD-Track Start Marker Mode (the right button, available only in
ADVANCED Mode): when the mouse pointer is in CD-Track Start Marker
Mode, clicking on the waveform of an audio region on the AudioCD
Layout main waveform view, DSP-Quattro will add a CD-Track start
marker on that position, without splitting the underneath audio region.
DSP-Quattro will also set the preGap of the new CD-Track to the default
value set on the Preferences. If it is not possible due a constrain for a
conflict with the previous CD-Track, will show a warning dialog.
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Editing the gain envelope of an audio region

There are two ways to edit the parameters of an audio region of the
AudioCD Layout:

- Numerically, using the Audio Region Info view
- Graphically, using the AudioCD Layout waveform view area.
As already described, when you add an audio file to a AudioCD Layout,
DSP-Quattro automatically creates an audio region. DSP-Quattro shows this
new audio region as a new row on the Audio Regions table and as a new
graphical waveform item on the AudioCD Layout waveform view area.
To edit an audio region numerically, use the Region Info button on top of the
Audio Regions table to open the Audio Region Info view as described in the
previous chapter about the Audio Regions table and Audio Region Info view.
To edit a Region graphically, use the audio region waveform on the AudioCD
Layout waveform view area, which we are going to describe. An audio region
waveform element appears something like the figure below:

Fade-In Gain Level Fade-Out
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Envelope Curve Control Points

- Editing the gain value of an audio region

To set the gain level of an audio region, click and drag up or down the Gain
level control point of the audio region envelope curve:
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The Audio Regions table will update the Gain dB value of that audio region
in real time. DSP-Quattro will update in real time also the Gain value on the
Audio Region Info view as well.

NOTE: When you edit stereo audio files, Gain envelope curve and control
points for the left and right channels are linked. Editing the envelope curve or
a control point will edit the curve or control point for both channels.

- Editing the Fade-In or Fade-Out length of an audio region

To set the fade-in or fade-out length of an audio region, click and drag left or
right the Fade-In or Fade-Out length control points of the audio region
envelope curve (the control point on the left border of the audio region
waveform sets the fade-in length, the one on the right border sets the fade-
out length):

00:01:56:040 00:02:15:380 00:02:34:721 00:02:54:061 00:03:13:401

y m———

DSP-Quattro will change the Fade In/Out times accordingly. As you would
expect, also the Audio Regions table and the Audio Region Info view will
update the Fade In/Out values in real time.

- Editing the shape of the Fade-In or Fade-Out curve of an audio region

To change the shape of the fade-in or fade-out curve of an audio region,
click and drag left or right the Fade-In or Fade-Out shape control points of
the audio region envelope curve (the control point on the left border of the
audio region waveform sets the shape of the fade-in curve, the one on the
right border sets the shape of the fade-out curve):

00:01:56:040 00:02:15:380 00:02:34:721 00:02:54:061 00:03:13:401
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DSP-Quattro allows two different types of shapes for the Fade-In/Out curve:

- Exponential/Bezier type: in this case the shape control point can move
on all directions, setting all the shapes ranging from logarithmic, linear,
exponential.

- 8-Curve type: in this case the shape control point can move only up or
down, the shape is convex, linear or concave according to the vertical
position of the shape control point.

To set the type of the shape, click with the right mouse button pressed on the

shape control point, DSP-Quattro will show an utility popup menu with the
command:

1l ‘u
b L

Exp/Bezier Curve

- S-Curve I

Or click on the Curve button on the Audio Region Info view, DSP-Quattro will
show a popup menu with the two possible options:

AudioCD Info Region Info CD-Track Info

Audio Region Index:

Name:
Length:
Start:
Gain:

Comment:

Length: MAN

(eI, v Exp/Bezier Set Linear
S-Curve

Length: MAN

Curve: ExpCurve % Set Linear

Fade Out

Source Audio File

| Don't Know Why

NOTE: the “Set Linear” command on the popup menu of the shape control
point or button on the Audio Region Info view, sets the shape curve to linear.

Trimming the start and end points of an audio region
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If the AudioCD Layout is in Shifter Mouse Mode, as soon as the mouse

pointer approaches to the left or right borders of an audio region waveform,
alter a few seconds, it changes its shape, becoming the tool for trimming:

Then, clicking and dragging it in the direction of the center of the audio
region waveform, DSP-Quattro modifies the audio region start position (if
trimming the audio region waveform left border) or audio region end position
(if trimming the audio region waveform right border) accordingly to the right
or left movement of the mouse.

All the CD-Tracks and audio regions which are after that audio region will
follow the change of the audio region length.

The AUTO MODE for audio region Fade-In/Out

On the Audio Regions table, after the Fade-In and Fade-Out columns, there
are the MODE columns, respectively the Fade-In MODE and Fade-Out
MODE:

Audio Regions Commands ¥ Region Info

4¢ ID Start Name Length Gain Fadeln Mode Fade Out Mode Comment

001 00:00:02:000 | Don't Know Why  00:01:14:425 +0.00 00:00:00:000 'AUTO  00:00:00:549 "AUTO This is the first song
002 00:01:15:875 | Don'tK...Why -1 00:01:51:931 +1.16 00:00:17:780 ~MAN ' 00:00:33:496 = MAN
003 00:03:06:846 Example...gs Choir 00:00:30:328 +0.00 00:00:00:960 'AUTO 00:00:00:000 = AUTO

The Fade MODE sets the behavior of the cross-fade between two audio
regions when one of them shifts and overlaps the other one.

If the AudioCD Layout is in Shifter Mouse Mode, if you click on an audio
region waveform and you drag the mouse to the left, DSP-Quattro shifts that
audio region along the time x-axis. If the audio region starts to overlap the
previous one, then there will be a cross-fade region.

Then, for what concerns the audio region which is shifting backward, if:

- Fade-In Auto MODE is ON: DSP-Quattro will automatically set the Fade-
In length to the length of the overlapping section.

- Fade-In Auto MODE is OFF: shifting the audio region to overlap the
previous one will not affect the Fade-In length previously set.
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L, | 00:00:55:510 | 00:01:14:0

Cross-fade

At the same time, considering the previous audio region which stays on its
position:

- Fade-Out Auto MODE is ON: DSP-Quattro will automatically set the
Fade-Out length to the length of the overlapping section.

- Fade-Out Auto MODE is OFF: the audio region Fade-Out length does
not change.

By default, DSP-Quattro turns ON the Fade-In and Fade-Out Auto MODES
when creating audio regions on the AudioCD Layout.

To Turn ON/OFF the Auto MODE for the Fade-In or Fade-Out of a certain
audio region, click on the AUTO/MAN button on the Audio Regions table, or
on the AUTO/MAN button on the Audio Region Info view, in correspondence
to that audio region.

It is also possible to Turn ON/OFF the Audio MODE by clicking on the Fade-
In or Fade-Out control points with the right mouse button, In this case, DSP-
Quattro will show the following a popup menu:

Set Fade To Auto Mode
Set Fade To Manual Mode

Reset Fade Length
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NOTE: dragging the Fade-In or Fade-Out control points on the audio region
envelope curve, as soon as the fade-in or fade-out length will change
(without shifting the underlying audio region), the corresponding Fade-In or
Fade-Out Fade MODE will automatically switch to OFF.

The AUTO mode is a very powerful tool for doing cross-fades. Having the
Auto Modes turned ON, DSP-Quattro sets the cross-fades between audio
regions, and the resulting AudioCD Layout will play smoothly when two
audio regions overlap, automatically. If needed, turning OFF Auto modes, it
is always possible to set the lengths of fade-in and fade-out independently to
best suite the specific needs, of course.

Setting Equal Power curves for cross-fades between audio regions
By default, each fade-in/out curve slope is independent from the others,

even in the case of overlapping cross-fades. There is an option to make
these linked, the EQUAL POWER curve slope Cross-fade mode.

00:00:55:510 00:01:14:01

if the Cross-fade AUTO mode is ON, keeping the SHIFT key pressed while
clicking and dragging the fade-in or fade-out shape control to set the shape
of one the fade curves, then also the other fade curve will follow such that
the sum of the two curves remains constant (equal power).

Working with CD-Tracks:

By default, DSP-Quattro creates a CD-Track for each audio region which it
adds on the AudioCD Layout. In ADVANCED Mode, it's also possible to
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combine several audio regions into one CD-Track, or to create several CD-
Tracks which uses only one audio region.

CD-Tracks are made up of two sub-markers:

- The CD-Track PreGap or Pause marker, which is connected to the CD-
Track start marker.

- The CD-Track start marker
To create a new CD-Track marker:

As already introduced, when adding an audio file or an audio region to the
AudioCD Layout, DSP-Quattro automatically creates also a CD-Track.

There are two ways to add a CD-Track on an existing audio region:

1. Splitting an audio region: it is possible to split an audio region into two
audio regions. DSP-Quattro will also create a new CD-Track at split point,
where the added audio region starts. All other audio regions and CD-
Tracks will remain unaffected.

To split an audio region, first place the playback cursor on the wanted
position, then:

Audio Regions Commands

Split Audio Region at Playback 38T

4 ID Start Name . R
o e i Remove Selected Audio Region 3
— Remove All Audio Regions 2|
002 00:00:53:034 | Don'tK...
(USRS RRUES EL el Replace Audio Region with... #R

Normalize Selected Audio Region
[P Normalize All Audio Regions
Normalize AudioCD

- use the menu command Split Audio Region at Playback (or 3T) from
the popup menu pressing the Command button on top of the Audio
Regions table

00:00:00:000 00:00:18:503 00:00:37:006 00:00:55:510

New Generic Marker

Split Audio Region At Playback

Go To Next Audio Region
Go To Previous Audio Region

Split CD-Track At Playback

Go To Next CD-Track
Go To Previous CD-Track

- The same command is available clicking on the playback cursor with the
right mouse button
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- Step to the Audio Region Scissor Mouse Mode. In this mode, clicking
on an audio region waveform, DSP-Quattro will split that audio region in
two audio regions on that position.

2. Splitting the CD-Track without splitting the audio region (available
only in ADVANCED MODE): in Advanced mode, it is possible to split a
CD-Track without splitting the underlying audio region.

To doit:

- Step to the CD-Track Scissor Mouse Mode: in this mode, clicking on an
audio region waveform, DSP-Quattro will split the CD-Track in two CD-
Tracks on that position, adding a CD-Track start marker. The underlying
and the other audio regions and CD-Tracks will remain unaffected.

Commands m

Ll liciis Remove Selected CD-Track 38X &

001 00:00:02:000 "&" " MAN Remove All CD-Tracks 08X
002 00:00:02:000 '@ VAN

Set All CD-Track Pauses To....
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- use the menu command Split Audio Region at Playback (or D) from

00:00:00:000 00:00:18:503 00:00:37:006 00:00:55:510

Go To Start

Split Audio Region At Playback

Go To Next Audio Region
Go To Previous Audio Region

Split CD-Track At Playback

Go To Next CD-Track
Go To Previous CD-Track

| New Generic Marker

the popup menu pressing the Command button on top of the CD-Tracks
table

- The same command is available clicking on the playback cursor with the
right mouse button

To remove a CD-Track marker:

In EASY MODE it is not possible to remove a CD-Track marker without
removing the underlying audio region. In this case, just use the command to
remove the underlying Audio Region to remove also the CD-Track marker.

In ADVANCED MODE, first select on the CD-Tracks table the CD-Track row
which must be removed, then:

CD Tracks Commands

Split CD-Track at Playback 8D

O TS Remove Selected CD-Track %X °|

001]00:00:02:000 W SIS Remove All CD-Tracks £ 38X
002 00:00:02:000 @ FIAR

Set All CD-Track Pauses To....

- use the menu command Remove Selected CD-Track (or 3X) rom the
popup menu pressing the Command button on top of the CD-Tracks table

- The same command is available clicking on the CD-Track preGap or start
markers with the right mouse button:

00:01:51:020 00:02:09:523

Move Here the Playback Marker
CD-Track Info
Remove CD-Track

Lock CD-Track Pause
Set PregapMode To AUTO

Set All CD-Track Pauses To...

137
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NOTE: in the command popup menu there is also a command to Remove
All CD-Tracks (or £>38X) in only one step,

NOTE: if there at least one audio region on the AudioCD Layout, at least one
CD-Track must exist. DSP-Quattro will not allow to delete the last CD-Track
of a AudioCD Layout which is not empty.

NOTE: there is an internal mechanism to link a CD-Track to the underlying
Region. In other words, also in Advanced MODE, CD-Tracks belongs to the
underlying audio region. If you remove a audio region from the AudioCD
Layout, also all the CD-Tracks belonging to that audio region will be
removed. More about this mechanism later in this chapter.

Editing a CD-Track:
There are two ways to edit the parameters of a CD-Track:
- Numerically, using the CD-Track Info view.
- Graphically, using the AudioCD Layout waveform view.
Creating a CD-Track, DSP-Quattro automatically shows it as a new row on

the CD-Tracks table and as a new CD-Track green marker on the AudioCD
Layout waveform view area.

To edit an CD-Track numerically, use the CD-Track Info button on top of the
CD-Track table to open the CD-Track Info view as described in the previous
chapter about the CD-Tracks table and CD-Track Info view.

To edit a CD-Track graphically, use the CD-Track markers in the AudioCD
Layout waveform view, which we are going to describe. As already
introduced, The head of a CD-Track marker can be split in two sub-markers,
the CD-Track PreGap/Pause and Start sub-markers:

- The CD-Track start marker: the right half of the CD-Track marker.

- The CD-Track PreGap or Pause marker, the left half of the CD-Track
marker

PreGap/Pause Marker
Start Marker

:01:32:517 00:01:51:020

- Moving CD-Track Start Markers:

clicking on the right side of the CD-Track marker head and shifting it on left
or right on the time ruler, DSP-Quattro will set the CD-Track Start position. In
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the case of EASY Mode, when CD-Track lies exactly on the beginning of an
audio region, the underlying audio region will shift accordingly.

NOTE: it is not possible to step over the previous or next CD-Track markers,
because CD-Tracks are always ordered chronologically. If you wish to
change the CD-Tracks order, change the order of the audio regions which
own those CD-Tracks markers, DSP-Quattro will change also the CD-Tracks
accordingly.

- Setting CD-Track Pause:

It is not possible to change the preGap/pause of a CD-Track if the Pause
length value is locked (if the red lock button on the CD-Tracks table is ON).
Unlock the CD-Track Pause to edit its value numerically or graphically.

Clicking on the left side of the CD-Track marker head and shifting it on left or
right on the time ruler, DSP-Quattro sets the CD-Track Pause length.

NOTE: it is not possible to step over the previous CD-Track markers, CD-
Tracks are always ordered chronologically.

NOTE: Moving the CD-Track start marker, the Pause length will remain
constant except in the special case when a CD-Track Start marker lies
exactly on the beginning of the underlying audio region AND when the CD-
Track Auto MODE is ON. More about CD-Track Auto MODE later in this
chapter.

The connection between a CD-Track Marker and underlying audio region:

A CD-Track belongs to a certain audio region, always. Shifting or removing
that audio region will shift or remove also all CD-Track markers which it
owns.

In EASY Mode, there is only the case in which one audio region own one
and only one CD-Track.

In ADVANCED Mode, where it is possible to have complex configurations, it
is very easy to know which audio region owns a certain CD-Track marker:
given a CD-Track marker, it is the audio region which is under that CD-Track
Start marker or, if the marker is over a waveform region with two overlapping
audio regions, the owner is the audio region which begins after the other
one. Let’'s see some examples:

00:01:25:387 00:01:39:619 5 00:02:08:081 00:02:22:312 00:02:50:775

Fig. A: both CD-Tracks belong to the underlying audio region.
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The fig. B above shows a case in which there is a CD-Track starting on the
overlap zone between audio regions. This CD-Track belongs to the second
audio region (the Region in the upper part of the AudioCD Layout waveform
view), because the CD-Track is over this audio region and this audio region
begins after the other audio region involved in the overlap.

00:01:39:394 00:02:12:526 00:02:45:657

Fig. C: the CD-Track belongs to the second audio region.
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Fig. C shows a case in which there is a CD-Track starting on the overlap
zone between two audio regions, and the preGap extends over the first
audio region. The CD-Track, both start and preGap markers, belongs to the
second audio region, where the CD-Track starts.

The CD-Tracks AUTO MODE

As already introduced, it is possible to shift an audio region forward or
backward along the time axis. By default, CD-Tracks owned by the shifting
audio region (ie positioned later on the time line) will shift accordingly. Also
all next audio regions and CD-Tracks will shift as well.

Now, what happens to CD-Track markers if, when shifting an audio region,
the AudioCD Layout creates a gap with the previous audio region?

Usually nothing very special, EXCEPT when there is a CD-Track Start which
is positioned exactly over the beginning of the underlying audio region. In
this case:

- if the CD-Track Auto MODE is ON, DSP-Quattro will set the CD-Track
Pause length to be as much as the gap between the two audio region (ie
the preGap will follow the gap between the audio regions).

- if the CD-Track Auto MODE is OFF, the Pause length remains constant.
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In the figures above, if the CD-Track Auto MODE is ON, CD-Track Pause will
follow to the gap between audio regions

By default, CD-Track Auto MODE of newly created CD-Tracks is turned ON
if the CD-Track start coincides with the beginning of an audio region.

To Turn ON/OFF the CD-Track Auto MODE click on the AUTO/MAN button
on the Pause column on the CD-Tracks table, on the row of the CD-Track
you wish to edit. The value will toggle, ie it will turn ON if it is OFF or it will
turn OFF it is ON.

CD Tracks Commands §  CD-Track Info

4¢ ID Pause Start Title Length CP PE ISRC Message

001 00:00:02:000 "@"' = MAN "~ 00:00:02:000 | Don't Know Why  00:01:14:425 X
002 00:00:01:664 & | AUTO | 00:01:18:090 | Don't Know Wh... ' 00:01:50:297

X
003 00:00:09:534 '@ " MAN | 00:03:17:922 || Don't Know Wh... | 00:00:30:431 | X
004 00:00:00:000 & [AUTO | 00:03:48:353 | Don't Know Wh... 00:01:12:898 | X

NOTE: in ADVANCED Mode, dragging the CD-Track start marker away from
the beginning of the underlying audio region, will automatically turn OFF the
CD-Track AUTO MODE.

NOTE: if the pause length cannot be locked if the CD-Track AUTO mode is
ON. If in a certain moment the pause length is locked and the CD-Track
AUTO mode is OFF, turning ON the CD-Track AUTO mode, DSP-Quattro
will unlock the pause length.

Turning ON the CD-Track Auto MODE, DSP-Quattro will move the
corresponding CD-Track Start marker to the location of the beginning of the
underlying audio region. If it is not possible due a conflict with the previous
CD-Track, it will show a warning.

The AUTO mode is a very powerful tool making audio CD-ROM in EASY
Mode. In just a few steps you can drag your audio files over the AudioCD
Layout window, then by default DSP-Quattro will create also CD-Tracks for
each audio file. Shifting audio regions in time will automatically move CD-
Tracks, too. If you wish to set preGaps on your audio CD-ROM, just create
gaps between audio regions. DSP-Quattro will automatically set also the
CD-Track perGaps for you.

Setting all CD-Tracks Pauses to...

A very common situation is when it is necessary to set all CD-Track preGaps
to the same value, adjusting the underlying audio regions accordingly. To do
it, DSP-Quattro offers a very useful menu command, Set All CD-Track
Pauses To.. , available from the Command button on top of the CD-Track
table:

CD Tracks Commands

Split CD-Track at Playback 8D

N R Remove Selected CD-Track 38X §

001/ 00:00:02:000 Wl - Remove All CD-Tracks 38X
002 00:00:01:664 '@ [AUTO

003 00:00:09:534 '@ [AUTO Set All CD-Track Pauses To....
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The following dialog will appear

New Pause Length: 00:00:02:000

Shift the Audio Regions if they start on a CD-Track start without
overlapping another Audio Region.

. Apply also if the CD-Track Pause is locked.

[ concel IS

then enter:

- New Pause Length: Enter the value you wish to set to the preGaps of all
the CD-Tracks

- Shift the Audio Regions if they start on a CD-Track start without
overlapping another audio region: enable/disable this option.

- Apply also if the CD-Track pause is locked: to bypass the lock flag on
the CD-Track preGap length, if enabled.

NOTE: the preGap in front of the first CD-Track is always 2 secs according
to the Redbook standard.

DSP-Quattro does not shift the audio regions overlapping the previous ones
to avoid to reset cross-fades between audio regions, in the case in which
there is a CD-Track Start on that cross-fade.

Cancel closes the dialog without modifying the AudioCD Layout; OK closes
the dialog setting the preGaps to the wanted value.
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Using Audio Unit and Internal Plug-in Effects on the AudioCD Layout

DSP-Quattro allows to configure a serial chain of effects on the output of the
AudioCD Layout or, if needed, independently on each audio region of the
AudioCD Layout.

The effects on insert on the output of the AudioCD Layout are available on
the AudioCD Channel Strip, on the left of the AudioCD view.

v  Effects

)" File Cmds
Insert FXs

)" "Edit Fx-1

Parametric EQ §

)" "Edit’ Fx-2

AUDelay ¢

)" "Edit' Fx-3
PSP Vi...armer2 §

Edit Fx-4

As already described earlier in this manual, these effects process the output
of the AudioCD Layout, that is all the audio regions. In other words, DSP-
Quattro will apply the same serial chain of effects when it plays the different
audio regions which are part of AudioCD Layout.

This serial chain of FX will be rendered to file burning or exporting the
AudioCD Layout, ie DSP-Quattro will process the audio regions thru these
effects when burning an audio CD-ROM or exporting a DDP image.

If needed, it is possible to load different effects for each audio regions used
by the AudioCD Layout, using the Audio Region info view:

Commands §
Fx-1 Edit Parametric EQ
Fx-2 Edit AUDynamicsProcessor
¢y Fx-3 Edit PSP VintageWarmer2
)" Fx4 "Edit Toraverb

Fx-5 Edit

Fx-6 Edit

Fx-7 ' Edit

Fx-8 ' Edit
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It is possible to load up to eight effects to choose among the high quality
internal effects of DSP-Quattro, or among the AU effect plug-ins by Apple or
third-party manufacturers which are installed on MacOS.

It is also possible to copy the chain of effects to duplicate it into other FX
chain on insert to a different object.

WARNING: as when burning an AudioCD, all the functions to export the
AudioCD Layout into a new file or group of audio files, will play the AudioCD
Layout using the effects on insert to each audio region and the effects on
insert to the AudioCD Layout Channel Strip, BUT NOT the FX on insert to
the L&R MainOut Channel Strip of DSP-Quattro. If you need to apply your
effects on all the audio regions of the current AudioCD Layout, be aware to
load the effects on the AudioCD Layout Channel Strip, and NOT on the L&R
MainOut Channel Strip of DSP-Quattro.

Please refer to the previous chapter for the description of the insert FX view
interface and about using it.

Loading, Saving and Exporting the AudioCD Layout:

The AudioCD layout is part of the Project document. DSP-Quattro saves all
the information of the current AudioCDLayout into the Project bundle,
including all the files it needs. Loading a Project document, DSP-Quattro will
restore the AudioCD Layout as well.

NOTE: please consider that to be able to play again the current AudioCD
Layout, DSP-Quattro will need also of all the AU plug-ins used on insert to
each audio region and on the output of the AudioCD Layout, which must be
present on the current MacOS when you will load again the same Project
document. It is also valid if you will load the same Project document on a
different mac.

DSP-Quattro is also able to export off-line the audio on output from the
AudioCD Layout as new audio file or as audio CD-ROM image files
according to the DDP standard format.

Moreover, DSP-Quattro allows also to build a AudioCD Layout by importing
the regions from an audio file, or folder with the audio CD-ROM image files
compliant with the DDP standard.

Easy Mode Advanced Mode

Audio CD Import Audio File...
Import DDP...
00:00:00:000 :00: Import Project Audio File :08:02: 00:03:28:290

Replace Audio Region with...
Replace Audio Region with Project Audio File

P = = =
Q00000090
885588858

Export Export AudioCD As Audio File...
Export AudioCD As 44.1 kHz Audio File...
Export AudioCD As mp3...

00:00:00:000 00:00:16:544 00:00:33:088 00:00:49:632 :01:06: % Export AudioCD As DDP...

Export All CD-Tracks As Audio Files...
Export All CD-Tracks As mp3...
Export All CD-Tracks As iTunes Plus AAC

Export Current CD-Track As Audio File...
Export Current CD-Track As mp3...
Export Current CD-Track As iTunes Plus AAC

Export AudioCD and CD-Track Infos As PDF Sheet... 8P
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Please refer to the previous chapter titled “Adding an audio file or audio
region on the AudioCD Layout” to know about the commands to import Audio
Files and adding audio regions to the AudioCD Layout.

About exporting the AudioCD Layout in several ways, click on the File button
on top of the AudioCD Layout main waveform view, a popup menu will
appear, where:

- Export AudioCD As Audio File... (or \“8E): DSP-Quattro will export

the current AudioCD Layout rendering it into an audio file. DSP-Quattro
will then show the following dialog:

Export AudioCD Layout as audio file (enter the audio file name without any extension):

File Name: | my AudioCD)| ~
Tags:
< coRi= E g v 7 steve 2 Q
|...) Desktop 1 Desktop >
Macintosh HD & Documents g
E | @ Downloads >
Plug-ins iCloud Drive (Archivio) >
£ Library 1 Movies >
71 Music >
£} steve .
@ _Pictiires >
Audio File Format: ~ AIFF d
Bits/Sample: 16 Bits u
Apply Dither
©  AsSource
Sample Rate: u
44100 Hz
SRC Algorithm Quality: Excellent | T
Hide extension =~ New Folder Cancel | el

In the upper part you must type name for the audio file to create, without
any extension (DSP-Quattro will take care to add the most suitable
extension according to the chosen file format). Use the file browser to
navigate to the destination folder, and the bottom section to set the
destination audio file format:

- Audio File Format: to set among the standard formats which are
available on the list:

AIFF
WAVE
v CAF

MPEG Layer 3

NeXT/Sun

Sound Designer I

AAC ADTS

Apple MPEG-4 Audio
Apple MPEG-4 AudioBooks
MPEG-4 Audio
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According to the chosen audio file format, the view which is on the
bottom part of the custom DSP-Quattro view will change.

The uncompressed PCM formats (AIFF, WAVE, CAF) need of these
additional parameters:

- Bits/Sample: DSP-Quattro can save 8, 16, 24, 32 or 32 (floats) bits
for each sample.

- Stereo/Mono: to set if the destination audio file must be mono or
stereo. In the case of mono, DSP-Quattro will mix the last and right
channels on output from the AudioCD Layout.

- Sample Rate: to set the sample rate of the destination audio file.

- SRC Algorithm Quality: if the sample rate of the destination audio file
is not the same of the audio file used by the AudioCD Layout, DSP-
Quattro will use its internal Sample Rate Converter (SRC) to write the
destination audio file. Four levels of quality of the advanced liner
phase algorithm of DSP-Quattro are available, ranging from Fast to
Excellent.

Export AudioCD As 44.1 kHz Audio File...: as above but setting
automatically the destination sample rate to 44.1 kHz, the audio CD-
ROMs standard sample rate value.

Export AudioCD As .mp3...: calls “Export AudioCD As Audio File...”
setting the default audio file formats to MPEG Layer 3.

Export AudioCD As DDP... (or 3E): DSP-Quattro will export the
current AudioCD Layout rendering it into an audio CD-ROM image file
according to the DDP 2 standard. DSP-Quattro will first ask for a folder
where to export all the files which are compliant, including also the
additional optional md5 checksum file.

NOTE: The DDP standard is the best format to export/import an AudioCD
image file in a standard format. This standard includes all the AudioCD
Layout informations like CD-Texts, ISRC, PQ, EAN/UPC sub-codes. And,
being a data file, it also guarantees the integrity of the written audio stream,
byte after byte.

Export All CD-Tracks As Audio Files... (or £+3E): similar to “Export
AudioCD As Audio File...” but saving each CD-Track as a separate audio
file. DSP-Quattro will ask for a folder where to save all the audio files,
then the audio file format of the destination audio files. NOTE: the
preGaps in front of each CD-Track - if any - will be rendered at the end of
the audio file regarding the previous CD-Track.

Export All CD-Tracks As .mp3...: to do “Export All CD-Tracks As Audio
Files...” setting the default audio file formats to MPEG Layer 3.

Export All CD-Tracks As iTunes Plus AAC...: to do “Export All CD-
Tracks As Audio Files...” using the iTunes Plus AAC standard audio file
format for the destination audio files. In this case, after choosing the
destination folder, no additional parameters are required.

Export Current CD-Track As Audio File... (or ~3E): similar to “Export
AudioCD As Audio File...” but saving only the current CD-Track as a
single audio file. DSP-Quattro will ask the location and the audio file
format of the destination audio file.
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- Export Current CD-Track As .mp3...: to do “Export Current CD-Track
As Audio File...” setting the default audio file formats to MPEG Layer 3.

- Export Current CD-Track As iTunes Plus AAC...: to do “Export Current
CD-Track As Audio File...” using the iTunes Plus AAC standard audio file
format for the destination audio files. In this case, after choosing the
destination location, no additional parameters are required.

- Export AudioCD and CD-Tracks Info as PDF Sheet...: DSP-Quattro
will ask you for name and location where to print into a PDF document
the AudioCD Layout Regions Table, CD-Tracks tables together with some
other useful information about the current AudioCD Layout.

The output on text file will appear something like the following:

([ ] AudioCD Track Sheet
Mastering Session
Date (YY-MM-DAY): 2018 - 11 - 13
Time (HH:MM): 21 : 53
Audio Engineer / Studio: | This is my name
File Name: Project.dspqproject
Application: DSP-Quattro 5.0.9 build 180918
AudioCD Info
Title: | This a test for AudioCD title
Artist/Performer: Steve
Produced By: | Nicholas
Record Label: DSPQ Records
Notes: ' bla bla bla
EAN/UPC Code:
Total Length: 00:05:01:251
Number of Tracks: 4
CD-Tracks: Time Units: HH:MM:Secs:msecs a
ID Pause Start Title Length CP PE ISRC Comment
001 |00:00:02:000 | 00:00:02:000 || Don't Know Why | 00:01:14:425 | X
002 [00:00:01:664 |00:01:18:090 || Don't Know Wh... [00:01:51:931 | X
003 |00:00:09:534 |00:03:19:556 || Don't Know Wh... [00:00:28:797 | X
004 |00:00:00:000 |00:03:48:353 || Don't Know Wh... [00:01:12:898 | X
Audio Regions:
ID Start Name Length Gain Fade In Fade Out Comment
001 | 00:00:02:000 || Don't Know Why [00:01:14:425 |+0.00 |00:00:00:000 | 00:00:00:000 | This is the first song
002 |00:01:18:090 || Don't Know Why |00:01:51:931 |+1.16 |00:00:24:105 | 00:00:00:000
003 |00:03:19:556 || Don't K...Why -1 |00:00:28:797 |+0.00 |00:00:00:000 | 00:00:00:000
004 |00:03:48:353 || Don't K...Why -2 |00:01:12:898 |+0.00 |00:00:00:000 | 00:00:00:000

cancel (TN

DSP-Quattro 5 User Manual

148



It is possible to type the info of the mastering session and the most important
AudioCD info.

It is also possible to resize each column of the Audio Regions and CD-
Tracks tables, and even to change the order of the columns on the tables,
just clicking and dragging to the left or to the right the headers on the tables.
Then, clicking on the OK button, DSP-Quattro will generate a PDF file.

NOTE: this menu command is equivalent to click on the PDF Sheet button
on top of the main waveform view of the AudioCD view.
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The Mixer

One of the main views of the Project Document window is the Mixer.

> Outputs

v Effects

@" (Fie' Cmds
Insert FXs

" ‘Edt Fx1

ParametricEQ 4

Edit| Fx2

Edit| Fx3

Edit| Fx4

S
v

" File Cmds
Insert FXs

Edit Fx0
Edit Fx0

Edit Fx0

Edit Fx0

Outputs

Effects

5" (File' Cmds

Insert FXs

Edit Fx1
Edit Fx2
Edit Fx3

Edit Fred

Audio Editor

> Outputs

v Effects

@" (Fie' Cmds
Insert FXs

Edit| Fx-t

Edt Fx2

Edt| Fx3

Edt| Fx4

o

v Outputs

MainOUT
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Edit Fx1
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Edit Fx3

Edit Fxed
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+0.00 N +0. 4000 NF
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AudioEditor AudioCDLayout | Audiolnput - 1 Audiolnput - 2. POIyKB Il InputRec - 1

F™  00:00:00:000

sem 12000 @
a

L&R MainOUTs

The mixer controls the audio routings and output settings of all the audio
generators loaded into DSP-Quattro. From here, together with the Output
Recorder interface, it is possible to control what plays, how everything plays.
Gains, pan-pots, insert effects of each component of DSP-Quattro.

On the mixer it is also possible to control audio inputs, input recorders and
virtual instruments modules.

This is really a high professional mixing desk, which transforms DSP-Quattro
into an excellent tool to use on stage as well as in your recording studio for
live performances.

The mixer is composed by channel strips. DSP-Quattro creates
automatically one channel strip for each audio generator which is loaded into
the Project.

- AudioEditor Channel Strip: this channel strip is always present, and it is
the same channel strip which is also on the left part of the AudioEditor
main view, described into the chapter dedicated to the Audio Editor.

- AudioCD Channel Strip: also this channel strip is always present, and it
is the same channel strip which is also on the left part of the AudioCD
main view, described into the chapter dedicated to the AudioCD Layout.
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- Output Channel Strips: always present, to the right of the mixer view,
these are housed into a side view to be always available also when the
Project Document window main view switches to the AudioEditor or the
AudioCD Layout. This group of channel strips show the audio outputs of
DSP-Quattro and allow the complete control of what DSP-Quattro will
play on output. Please refer to the chapter describing the Output Channel
Strips to know more about that.

- Audio Input Channel Strip: this is an optional channel strip. DSP-
Quattro creates an audio input channel strip when an audio input module
is added to the Project by using the corresponding command on the
Document Manager. More about how an audio input module works later
in this chapter.

- Audio Input Recorder Channel Strip: this is an optional channel strip.
DSP-Quattro creates an audio input recorder channel strip when an
audio input recorder module is added to the Project by using the
corresponding command on the Document Manager. More about how an
audio input recorder module works and about how to make a new
recording later in this chapter.

- Virtual Instrument Channel Strip: this is an optional channel strip. DSP-
Quattro creates an virtual instrument channel strip when a AU instrument
plug-in is added to the Project by using the corresponding command on
the Document Manager. More about how a virtual instrument work and
about how to load and play it later in this chapter.

The Audio Input Module and its channel strip

The Audio Input module is an object to route a mono/stereo audio input to
the mixer and then to the output channel strips of DSP-Quattro.

It is the prefect solution if you wish to transform your Mac into a real time
effect unit. Just add an Audio Input Module to your Project, load your FX on
insert on its channel strip, and... you have it.

To add an Audio Input Module, click on the Add button on the top of the
Document Manager table, then select New Audio Input.

» Outputs

Import Audio File...
Import Audio File from Dual Mono L&R
Import Audio File from Binary File

New Empty Audio File...

New Audio Input
New Input Recorder

AU Virtual Instrument

DSP-Quattro adds a new Audio Input module to the Project, then it will
switch to the Mixer panel showing the new Audio Input channel strip. By
default, DSP-Quattro will mute the output of the added Audio input module to
avoid unwanted audio feedbacks on output.
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» Outputs

» Effects

Mic 1

Mic 2

Input Channels

0.00

U]

(0)

Audiolnput - 1

Several of the elements of the audio input channel strips are the same of the
output channel strip described previously on this manual. Please refer to the
chapter describing the Output Channel Strips to know how to use them.

The only controls which are new on the audio input channel strip are on the
Input Channels subview:

Use the two popup menus to assign the audio ports to the left and right input
Mic 1

Mic 2

Input Channels

channels. Each popup menu lists the available ports of the current input
audio device addressed by DSP-Quattro (use the application Audio Settings
describer later on this manual to set which audio device DSP-Quattro must
use). As an example, these are the input ports of a multi-port Scarlett 6i6
external USB audio device:

Outputs

Mic 2
Line 3

Line 4
S/PDIF L
S/PDIF R

0 Mute

Mono

+0.00 -90.48
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NOTE: you can open how many Audio Input channel strips you will like, and
use all of them at the same time, assigning each one to a different stereo
input, if you have an input device with several audio inputs. Of course, it is
even possible to load different effects on insert to each audio input for
maximum flexibility.

The AU Virtual Instrument Module and its channel strip

The AU Virtual Instrument module is an object to play a virtual instrument
plug-in using DSP-Quattro. Because DSP-Quattro has not a internal
sequencer, it is supposed that you will play a virtual instrument by an
external MIDI device or by routing a virtual MIDI cable internally to MacOS.
Use the Apple AudioMIDI Utility which is into the Applications/Utility folder to
configure the current MIDI network.

NOTE: DSP-Quattro asks to MacOS the list of the available AU Virtual
Instrument plug-ins. To be visible to DSP-Quattro, a plug-in must be installed
on MacOS as 64 bits Audio Unit plug-in before to run DSP-Quattro.

It is the prefect solution if you wish to transform your Mac into a real time
musical instrument to play by an external MIDI keyboard. Just connect the
MIDI Keyboard to your mac, add an AU Virtual Instrument Module to your
Project, configure the MIDI device to use, and... you have it.

To add an AU Virtual Instrument Module, click on the Add button on the top
of the Document Manager table, then select AU Virtual Instrument, DSP-
Quattro will list all the AU Virtual instrument installed on MacOS, order by
Companies.

112dB

» Outputs 4Front Technologies
& AdmiralQuality
Import Audio File... AIR Music Technology
Import Audio File from Dual Mono L&R Alan ViSTa
Import Audio File from Binary File Ample Sound
= .~ Apple
e O . Applied Acoustics Systems
New Audio Input Arturia
New Input Recorder Audio Modeling
~ AudioSpillage
v B Audioin__ AU Virtual Instrument Autodafe
v Il AudiolnputRecorders -+ el
Beepstreet
v I Vvirtual Instruments allsz 2 Big Tick
Cableguys

Diva

Cakewalk

D16 Group Audio Software
Daichi Laboratory
Datsounds

Digital Suburban
discoDSP
extentofthejam
FabFilter

Full Bucket Music
FXpansion

GForce

Green Oak Software
Instigator
kiloHearts
Klevgrand

YVYVVYVVYVVVVYVVVYVVYVVYVYVVVYVYVVVVYVVYVVVVVVZ

Slave KORG
00:00:58:150 KV331Audio
— LennarDigital
LinPlug

Then, select the AU Virtual Instrument you wish to play.

DSP-Quattro adds the new AU Virtual Instrument module to the Project,
naming it with the name of the loaded plug-in, then it switches to the Mixer
view showing the AU Virtual Instrument channel strip. By default, DSP-
Quattro will open the GUI to edit the AU plug-in on a dedicated floating
window.
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» Outputs

» Effects

B mor

Scarlett 6i6 USB - ¥

Edit

As for the Audio Input Module, several of the elements of the AU virtual
instrument channel strip are the same of the output channel strip described
previously on this manual. Please refer to the chapter describing the Output
Channel Strips to know how to use them.

The only controls which are new on the AU virtual instrument channel strip,
are the ones on the following subview:

MIDI

Scarlett 6i6 USB - ¥

Edit

In the upper part there is the control to set the MIDI device and MIDI channel
to use. DSP-Quattro lists all the available MIDI devices, select the one you
wish to use to play the virtual instrument. If needed, select one of the sixteen
MIDI channels to use, or ALL to receive from all MIDI channels (OMNI).

Use the Edit button to open/close the custom AU plug-in graphical interface
to edit its parameters and manage its internal patches.

The GUI which DSP-Quattro will show depends on the third party AU plug-in,
each plug-in has its own interface. DSP-Quattro shows the plug-in GUI on a
floating window, together with the controls to load/save and to manage the
current plug-in patch/preset. Here below there is an example:

In the upper part DSP-Quattro shows the controls to turn it ON/OFF and to
manage the current patch - or preset - of the plug-in:

DSP-Quattro 5 User Manual 154
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< > Copy Paste Compare l
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I
( - ) 4 > Copy Paste Compare

ON/OFF Plug-in preset ,
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Al A ey

WAVEFORM RANGE SEMI FINE VOLUME FEEDBACK ATTACK DECAY SUSTAIN RELEASE

Legend

DSP-Quattro place the custom plug-in GUl is in the lower part.

NOTE: the current plug-in, including the current patch which it is playing, is
part of the current Project Document. DSP-Quattro saves automatically the
current present together with the plug-in reference to restore the current
situation later when it will load back the Project Document.

The Audio Input Recorder Module and its channel strip

The Audio Input Recorder module is very similar to an Audio Input Module,
with the additional feature to be able to record to file the audio which comes
from its L&R inputs.

It is the prefect solution if you wish to transform your Mac into a real time
recorder. Just add an Audio Input Recorder Module to your Project and set
up the new recording session as explained in the next paragraph.

To add an Audio Input Recorder Module, click on the Add button on the top
of the Document Manager table, then select New Input Recorder

» Outputs

o~ Import Audio File...

(N WM Import Audio File from Dual Mono L&R

Import Audio File from Binary File
» Bl AudioCl

New Empty Audio File...

v [l AudioFl

T ed  New Audio Input
New Input Recorder

@ Exampl
; AU Virtual Instrument >




or press the + button on the AudiolnputRecorders row:

v I AudiolnputRecorders - +[}

DSP-Quattro adds a new Audio Input Recorder module to the Project, then it
will switch to the Mixer panel showing the new Audio Input Recorder channel
strip. By default, DSP-Quattro will mute the output of the added Audio Input
Recorder module to avoid unwanted audio feedbacks on output.

»  Outputs

» Effects

Mic 1
Mic 2
Input Channels

File Name

New Recording

New Mrk

Save

(0}

InputRec - 2

Several of the elements of the audio input recorder channel strips are the
same of the audio input channel strip described previously in this chapter.

The audio input recorder channel strips adds the following subview:

File Name

New Recording

New Mrk

Save

This subview contains the controls to make a new recording. Let's see how it
works.

How to make a new recording using DSP-Quattro
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To make a new recording from the audio input, you must use an Audio Input
Recorder Module.

The procedure is easy to accomplish:

1) Configure DSP-Quattro to use the wanted audio device using the
Options->AudioSettings... menu command from the top application
menu bar, as described in the chapter Audio Settings in this manual.

2) Add an Audio Input Recorder module to the current Project (see the
previous chapter).

Click on the Add button on the top of the Document Manager table, then
select New Input Recorder, or press the + button on the
AudiolnputRecorders row. DSP-Quattro adds a new Audio Input
Recorder module to the Project, then it will switch to the Mixer panel
showing the new Audio Input Recorder channel strip.

3) Use the popup menu controls on the Input Channels view to set the
input ports for the L&R input channels:

Mic 1
Mic 2

Input Channels

The VuMeters of the Audio Input Recorder module will start to show the
input signal levels.

4) Click on the File Name on the Audio Input Recorder module to set
the file name of the new recording and the audio file format.

New Recording Settings

New File Name: New Recording
Stereo/Mono:
Bit Depth: PZRE:1i <

[ Cancer JNCC S

It is possible to set if the recording must be stereo or mono, and the bit
depth (8, 16, 24, 32 and 32 floats) of the new recording. Click on the OK
button to confirm.

5) Click on the REC button to set on PAUSE the recording, DSP-
Quattro engages the recording, setting the input recorder on pause
(DSP-Quattro still does not start to record at this stage). The REC button
will turn ON.

File Name

New Recording

New Mrk

Save
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6) To start the recording, click on the PLAY button on the Transport
Bar on the lower part of the Mixer view. The counter will show the
elapsed recording time.

00:00:16:486 ° 12000

7) To stop the recording, click on the STOP button on the Transport
Bar on the lower part of the Mixer view. The counter stops and the PLAY
button turns OFF.

You will also notice that the Save button on the Audio Input Recorder
module turns ON:

File Name
New Recording

New Mrk

Save

8) If the recording is ok, you MUST SAVE the new recording clicking
on the Save button on the Audio Input Recorder module. Then,
DSP-Quattro adds the new recording to the Document Manager table
adding it to the list of the audio files.

v Bl AudioFlles
@ | Don't Know Why

@ Example 5 - Kings Choir

@ New Recording

If you wish, double-clicking on the new file name row on the Document
Manager table to open the new recording waveform on the AudioEditor to
see it.

NOTE: IF YOU DO NOT CLICK ON THE SAVE BUTTON, DSP-
QUATTRO WILL DISCARD THE LAST RECORDING.

9) To start a new recording, loop returning to the point 6).

NOTE: it is possible to add how many Audio Input Recorder modules you
wish, and it is also possible to start several synchronized recordings on
different audio files. To do it, just set on pause all the input recorders to use,
then clicking on the Play button on the Transport Bar, the engaged input
recorders will start, synchronized one each other.

NOTE: it is possible to synchronize the Output Recorder as well, as it is

possible to synchronize the AudioEditor and the AudioCD Layout to start
play when the recording starts.
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NOTE: click on the New Marker button on the Audio Input Recorder
interface to add a generic marker at the current cursor position while
recording. DSP-Quattro will save these generic markers on file at the
moment of saving the new recording into the Project Document.

The Audio Output Recorder

The Audio Output Recorder records to file the audio on output from DSP-
Quattro.

DSP-Quattro creates always an Audio Output Recorder at startup, and there
is always only one Audio Output Recorder. Differently from the other objects
that we have seen, the Audio Output Recorder is part of the application and
not of the current Project document.

To open the audio Output Recorder, use the command Show Output
Recorder ( or £+3R) from the top menu bar of the application:

@ DSP-Quattro File Edit Options m Help

| JON Show Output Recorder {+8R
Enter Full Screen

Show Previous Tab
Show Next Tab
— Remove I Move Tab to New Window

Merge All Windows
Show Tab Bar
» Bl AudioCD Layout Show All Tabs

> Bl Audio Editor

v Il AudioFlles Minimize

@ | Don't Know Why Zoom

@ Example 5 - Kings Choir Bring All to Front

@ New Recording

v Project

DSP-Quattro will show the Audio Output Recorder floating window:

) Output Recorder

Recording Time Partial Rec Time: (00:00:00:000

00:00:00:000  mmeonto: 12:51:50:243
—
- Save

New Marker

File Name: New Recording - 1

Format: Stereo - 24 bits - 44100 Hz

Slave
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The interface of the Audio Output Recorder has several elements which are
the same of the ones that you have seen on an Audio Input Recorder:

- Gain sliders and Vu-Meters, these are the same elements also used
by all other audio generators.

- New Marker button, to add generic markers while recording.

- Save button, to confirm the new recording session, loading the new
audio file into the Project Document.

- REC button, to set on pause the new recording session.

- File Name: it shows the current file name. Clicking on it, DSP-Quattro
shows a dialog to enter a new file name and the audio file format to use.

There are some other elements, shared with the Transport Bar:
- PLAY and STOP buttons, to start and stop the new recording session.

- Current Recording Time: it shows the time elapsed since the start of
the recording session.

And there are some other elements, unique to the Output Recorder:

- the Input Channels subview: use the two popup menus to assign the
audio ports to the left and right channels. Differently from the audio input
modules, DSP-Quattro lists the output audio ports, not the input audio
ports. Choose the output ports from where you wish to get and dump to
file a replica of the audio on output from DSP-Quattro.

- Partial Rec Time, it shows the time elapsed since the last time you
placed a generic marker on the current recording clicking on the New
Marker button.

- Time On HD: the free space on the HD where is located the new file.

- Slave Button: if turned ON, the Output Recorder will accept the Start/
Play command from the transport bar of the current main view, ie the
transport bar of the AudioEditor if the AudioEditor is the main view on the
current Project Document window, the transport bar of the AudioCD
Layout if the AudioCD is the current main view, and same in the case of
the Mixer view.

NOTE: turning the Slave button ON, it is possible to dump to file in real time
the output of the AudioCD Layout or of the AudioEditor.

Rendering to file the audio processed by an external hardware unit

Using the Output Recorder as Slave to the transport bar of the AudioEditor
or of the AudioCD Layout is an important feature of DSP-Quattro which
allows you to create a new file as result of the processing on an audio file
thru an external hardware effect unit.
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To do it, open the Output Recorder, configure it to get audio from the
MainOut L&R channels, click on its Slave button to set it slave to the Project
Document transport bar. Then, set it on pause clicking on the REC button.

Go to the AudioEditor (or AudioCD Layout9 load the audio file to process.
Set as effect on insert the External 1/0 special plug-in of DSP-Quattro:

Efx

A
v

Paste Compare

+0.00 +0.00 +0.00

Mute

Mic 1

ry
v
ry
v

Mic 2

AUDIO SEND AUDIO RETURN

External Audio Send&Return

configure it to send and get audio to/from the external hardware effect.

Then, start the AudioEditor. The Output Recorder will start automatically to
record because slave. Stop when finished, Save the new recording on the
Output Recorder. Your processed audio file will be into the Project listed
among the audio files on the Document Manager table.

NOTE: to work properly, due an restriction of the internal audio routing of
DSP-Quattro, the sample rate of the current audio file to process must be
the same of the sample rate of the current output audio device used by DSP-
Quattro to play its output.
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Audio CD-ROM Burning

This chapter describes the procedure to burn the AudioCD Layout on an
audio CD-ROM by using DSP-Quattro.

If you have an internal or external CD-ROM writer device connected to your
Mac and, if external, this device is supported by the disc burning component
of MacOS, DSP-Quattro allows you to burn an audio CD compliant with the
Redbook standard including also CD-Text, ISRC, EAN-UPC, PQ sub-codes
extensions.

The Redbook standard defines several specs about the format of an audio
CD-ROM. If the audio CD-ROM is compliant to the Redbook standard, all
the audio CD-Players should always be able to play it.

Among the others, the redbook standard defines that an audio CD-ROM
cannot have more than 99 CD-Tracks. An audio CD-ROM must start with a
preGap of 2 secs. Each CD-Track cannot be shorter then 4 secs, and the
CD-Track Start markers can be placed only at quantized time intervals,
multiple of a certain small constant value.

Using DSP-Quattro, most of these specs will be invisible to you, DSP-
Quattro will take care to follow the specs for you. If it will be not possible to
produce automatically an audio CD-ROM compliant with the rebook
standard, DSP-Quattro will show you a warning message (as, for example,
in the case in which a CD-Track will result to be shorter than 4 secs), letting
you to choose to continue or not.

DSP-Quattro burns an audio CD-ROM from the output of the AudioCD
Layout converting it - if necessary - to the standard 44.1 kHz sample rate
using its internal Sample Rate Converter at maximum quality.

DSP-Quattro will also use its internal dithering algorithm rendering the audio
CD-Layout into the audio file used by the CD-Burning engine, when
converting the audio samples from the internal floating point numerical
representation to the fixed 16 bits/sample precision of the audio CD-ROM
rebook standard. The dithering algorithm is necessary to avoid audio
artifacts on low level signal levels when truncating the word representing the
numerical sample to 16 bits.

If you wish to use an external AU plug-in to do dithering, just insert it as final
FX on insert on the AudioCD Channel Strip, and turn OFF the internal
dithering algorithm of DSP-Quattro. This can be done on the Preference
dialog fo DSP-Quattro. Under the Default options of the AudioCD, there is a
button to turn on/off the internal dithering algorithm exporting audio CD-ROM
image file (the same algorithm is used by default also exporting DDP image
files).

WARNING: when burning an audio CD-ROM, DSP-Quattro will play the
AudioCD Layout using the effects on insert to each audio region and the
effects on insert to the AudioCD Layout Channel Strip, BUT NOT the FX on
insert to the MasterOut Channel Strip of DSP-Quattro. If you need to apply
your effects on all the audio regions of the current AudioCD Layout, be
aware to load the effects on the AudioCD Layout Channel Strip, and NOT on
the MasterOut Channel Strip of DSP-Quattro.

NOTE: if external, the CD-Burner device must be connected and turned ON
before to start this operation.
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To burn an audio CD-ROM, having ready the AudioCD Layout, press the
BurnCD button on top of the AudioCD Layout main waveform view:

» Outputs Easy Mode Advanced Mode

»  Effects Audio CD File * Burn CD

00:00:00:000 00:00:26:036 00:00:52:072

DSP-Quattro will render the AudioCD Layout to a temporary internal data
file, then will show the MacOS Burning dialog:

Burn Disc

. . Burn Disc In:  OPTIARC DVD RW AD-5970H u A

Ready to burn.

Burn Options

<)

Speed: 8x

After Burning
Verify burned data
o Eject disc Mount on Desktop

Eject Cancel Burn

if there are several CD-Burner devices connected to your mac, use the Burn
Disc In popup menu to choose the device to use.

Then, after inserting the blank audio CD into the device, you must set the
burning Speed among the available values (MacOS is the responsible for
giving the list of the available speeds, according to the device and current
inserted CD-ROM media).

NOTE: It is highly recommended to choose always the slowest
possible speed among the available values.

Even if the MacOS burn disc dialog shows an option to Verify burned data
under the “After Burning” section, this option is not applicable for burning an
audio CD-ROM. It is applicable only in case of burning data disc, which is
not the case of DSP-Quattro.

Press the Burn button to start the process, DSP-Quattro will show a
progress dialog until the burning session is completed.
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DSP-Quattro Preferences

Use the Preference dialog to set the default parameters used by DSP-

Quattro at startup.

The Preference dialog shows a multi-panel view that gathers all the user

configurable settings, split in the following categories:

- General: general settings

- AudioEditor: Audio Editor settings

- AudioCD: AudioCD settings

To open the Preferences dialog, use the Preferences...

from the application top menu bar:

@ POEETEL M File Edit

About DSP-Quattro

Preferences... 8,
Check For Updates...

Services »

Hide DSP-Quattro  38H
Hide Others X $8H
Show All

Quit DSP-Quattro  #Q

Options  Window

menu command

Help

In upper part there are the different tabs to choose the category of

>

>

Outputs

Effects

configurable settings to show on the lower part.
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General Preferences

@® Preferences

@ AudioEditor ~ AudioCD

X-Y Units:

X-Axis units:  HH:MM:SS:MSEC E Y-Axis units:  Float

Others:

Autozero

" Playback marker returns to its starting position when the playback stops

Graphic engine frame rate: Good a

Waveform drawing method: Connected lines between samples a

Waveform: | [ Selected waveform: | | RN
Waveform colors: Set Defaults

Background: | BB Sclected background: [T

Project:

Restore plug-ins windows.

Opening an existing Project: )
Restore Solo ON/OFF state for each channel strip.

Opening a new Project: Show Audio Editor View

Messages:

Show mute ON warning when adding Input Recorders or Input channel strips on
the mixer.

Mp3 Encoder:

Type: Constant Bit Rate
VBR Quality: = 05 - Medium
Stereo/Mono:  Auto
Bit Rate: 128 kbps (Standard)
Encoding Engine Quality: 03 - Very Good

(o o of oo

Set Defaults

Selecting the General tab, the above view appears.

X-Y Units Options:

- X-Axis Units: it allows you to choose the default unit used by DSP-
Quattro to represent the time axes on the Time Ruler and for displaying
time values. Choose one of the possible options: hh:mm:sec:msec,
Seconds, Samples, milliseconds or AudioCD.

- Y-Axis Units: the default unit used by DSP-Quattro to represent the

audio signal level. Choose one of the possible options: floats (-1.0, 1.0),
Decibels (dB).

Other Options:
- AutoZero: if turned ON, when DSP-Quattro sets the position of a marker

or of a waveform selection, it automatically moves it to the previous point
of Zero Crossing. A Zero Crossing point is the location in which the
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waveform passes thru the zero level changing its sign. This option is very
useful when we want to place markers in a position that has a shared
zero level.

- Playback cursor returns to its starting position when the black
stops: if turned OFF, the playback cursor remains on the last position
reached when DSP-Quattro stops to play.

- Waveform drawing method: set the method used drawing the
waveform. It has a big impact at high x-axis zoom-in levels, like 1:1 or
more. Possible methods are: connected lines between samples, one dot
for each sample, one vertical line for each sample.

- Waveform Colors: it allows you to assign the colors used to draw
waveforms and backgrounds. Use the Set Default button to restore these
settings to factory values.

Project Options:

- Restore plug-in windows: If OFF, when DSP-Quattro loads a Project
document, it does not show the plug-ins windows left visible when saving
that Project. Otherwise, it restores also the status of all plug-ins windows.

- Restore Solo ON/OFF Status for each Channel Strip: If OFF, when
DSP-Quattro loads a Project document, it does not restore the Solo
button status as it was when saving that Project.

Messages:

- Show mute ON warning...: by default, allocating an audio input or input
recorder module, DSP-Quattro shows a warning about the fact that it
automatically mutes the audio monitoring to avoid unwanted feedbacks
between audio inputs and outputs. Set this flag OFF to avoid to see that
warning (you can always instruct DSP-Quattro to do not show that
warning after the first time).

Mp3 Encoder:

These are the advanced settings for the internal mp3 encoder. It is highly
recommended to keep the default values if not strictly necessary.
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AudioEditor Preferences

Preferences

General [AVEIGZEIGIg)  AudioCD

Defaults:

Transport Bar Cycle button is ON
0 samples before the cut point
Cut Before/After and Trim commands leave:
0 samples after the cut point
Drag&Drop Audio File Export:
File Format:  AIFF [T
Exporting Audio Files by Drag&Drop, use:
Bit Depth: 24 Bits u
If there is a wavefrom Selection, export that Selection only.

Selecting the AudioEditor tab, the above view appears.

Defaults:

Transport Bar Cycle button is ON: if this flag is ON, creating a new
Project the Cycle button on the Transport bar will ON by default.

Cut Before/After commands leave: it allows you to set two values for
the number of samples that DSP-Quattro will leave before and after the
cut points, when it is applicable. It is very useful doing sample editing,
because several samplers need of some samples after the loop end to
play without clicking due the internal interpolation algorithm when they
transpose.

Drag&Drop Audio File Export:

Exporting Audio Files by Drag&Drop, use: it allows to set the file
format and bit depth of the destination audio files when exporting an
audio file by Drag&Drop to the MacOS finder.

If there is a waveform selection, export that selection only: If OFF,
exporting by Drag&Drop to the MacOS finder will always export all the
file, even if in that moment there is waveform selection.
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AudioCD Preferences

o Preferences

General  AudioEditor W’

Defaults:
AudioCD Layout starts on Easy Mode.
Apply internal Dither algorithm burning AudioCD or exporting DDP
. . ) . Audio Region Length
Replacing an Audio Region, keep settings for:
Audio Region CD-Texts and ID3 Tags
AudioCD:
EAN/UPC Code:
Write CD-Texts on Disc ID3 TAG:
Performer: Album:
Songwriter: Year: 2018
Composer:
Arranger:
Message:

Genre ID:  Other

<>

Defaults CD-Track settings:

CD-Track Pause length LOCKED

Pause length for new CD-Tracks: 2000 msecs
CD-Track Pause AUTO/MANUAL Mode to AUTO

CP - Copy Protection use CDTexts/ID3 Tags from source AudioFile
CDTexts/ID3 Tags:
PE - Pre Enphasis use AudioCD CDTexts/ID3 Tags

Selecting the AudioCD tab, the above view appears.
Defaults:

- AudioCD Layout starts on EASY Mode: if this flag is ON, creating a
new Project the the AudioCD will be on EASY Mode by default, otherwise
on ADVANCED Mode. NOTE: The EASY/ADVANCED Mode is part of the
Project, and saved when saving the Project document.

- Apply internal Dither algorithm burning AudioCD or exporting DDP:
if ON (default), DSP-Quattro applies its internal dithering algorithm
rendering the audio CD-Layout into the audio file used by the CD-Burning
engine and exporting DDP image files, when converting the audio
samples from the internal floating point numerical representation to the
fixed 16 bits/sample precision of the audio CD-ROM rebook standard.
The dithering algorithm is necessary to avoid audio artifacts on low level
signal levels when truncating the word representing the numerical sample
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to 16 bits. Turn OFF this flag if you wish to use an external AU plug-in for
dithering.

- Replacing an Audio Region, keep the settings for: it allows to set the
default values used by DSP-Quattro when replacing an audio region of
the AudioCD Layout with another audio file. NOTE: DSP-Quattro,
replacing an audio region, always shows a intermediate dialog allowing to
set these options.

AudioCD:

- Write CD-Texts on Disc: if ON, DSP-Quattro will write CD-Texts, ISRC,
EAN/UPC and PQ codes on the CD when burning an audio CD-ROM
using its internal burning engine.

Use the other fields of this section to set the default strings and values for
the audioCD CD-Texts.

Default CD-Track Settings:

- Pause length for new CD-Tracks: it allows to set the default value
(expressed in milliseconds) for the preGap/pause to use when creating
new CD-Tracks adding new audio regions on the AudioCD Layout. New
audio region will be placed on the time line accordingly to this value.
NOTE: the preGap in front of the first CD-Track is fixed to 2 secs.
However, it is possible to shift the first audio region to create a silence
before the audio of the first song.

- CD-Texts/ID3 Tags: it allows to set if DSP-Quattro, creating a new CD-
Track, must use the the CD-Texts/ID3 Tags from the audio file or from the
default CD-Texts settings for the AudioCD (see the above AudioCD
section).

Use the other fields of this section to set the default settings for the options
on the AudioCD Layout CD-Track table, to use when adding new CD-Tracks.
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Audio Settings

Even if DSP-Quattro doesn't need any additional audio hardware to work
properly, it supports and manages different audio boards provided that they
are compatible with CoreAudio of MacOS. MIDI devices can be used as
well. To verify if your Audio or MIDI external device is compatible with
MacOS and DSP-Quattro, run the Apple Audio MIDI Configuration utility
which is into the Application/Utility folder. If you can configure it using this
tool, then DSP-Quattro will surely be able to address it.

DSP-Quattro X uses the CoreAudio component by Apple which his built-in
into MacOS to address the built-in audio 1/O or third parties hardware audio
devices eventually present on your configuration. During the startup, DSP-
Quattro asks to MacOS to know about which audio I/O device is available.

To assign and configure the audio device used by DSP-Quattro for audio
input/output, use the Options->AudioSettings... menu command from the
application top menu bar:

@& DSP-Quattro File Edit m Window Help

[ RON ) X-Axis Units
Y-Axis Units

Waveform Drawing Method

— Remove § v AutoZero

> Bl Audio Editor Audio Settings... k)

DSP-Quattro shows the following dialog:

Audio Settings...
Input Device: System ﬂ
_ Sync
Output Device: System u
1/0 Buffer Size: 512 H
Preferred Inputs
Left Input Channel: Input-L E
Right Input Channel: Input-R u
Preferred Outputs
Left Output Channel: Mon 1 E
Right Output Channel: Mon 2 u
Cancel Apply Save as default

Where:
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- 1/0 Audio Devices: in the upper part, two popup menus allow you to set
which 1/0O device must be used by DSP-Quattro to address audio for its
inputs (input device) and to play its outputs (output device).

Among the available devices, there is always a “System” device, which is the
one assigned to MacOS for the audio I/O. By default, DSP-Quattro starts
using the System device.

NOTE: it is highly recommended to set the same physical device for both
inputs and outputs. Other settings may produce audio drop outs and clicks.

Turning ON the Sync menu selections check box, choosing the Input
Device, DSP-Quattro will automatically try to synchronize the choice of the
Output device to maintain the same physical hardware interface for both
Inputs and Outputs. It is highly recommended to keep this option On.

- Preferred Input/Outputs: these popup menus list the available audio
channels (or ports) for inputs and outputs according to the current audio
device used by DSP-Quattro, that is the audio device which is selected
on the 1/0 Audio Device popup menu above).

These preferred Input channels will be the channels which DSP-Quattro will
set by default for a new input / input recorder module on the mixer. The
preferred output channels will be used for the output channel strips.
However, consider that these settings are saved and restored with the
Project document, and can be changed if needed directly on the mixer
channel strips.

As an example, chosen the Scarlett 6i6 as input and Output audio device,

which is a multi-port audio device, this is what DSP-Quattro shows as
possible choice for the preferred input channels

Audio Settings...

Input Device: Scarlett 6i6 USB E
Sync
Output Device: Scarlett 6i6 USB u
I/O Buffer Size: 512 <)
Preferred Inputs None
Left Input Channe!: I TX NI
. Mic 2 \
Right Input Channel:
< 2 Line 3 i
Line 4
Preferred Outputs S/PDIF L
Left Output Channel: | IR _j
Right Output Channel: Mon 2 ﬂ
Cancel Apply Save as default
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And for the preferred output channels:
Audio Settings...

Input Device: Scarlett 6i6 USB

Sync
Output Device: Scarlett 6i6 USB

I/O Buffer Size: 512

(O OO

Preferred Inputs

Left Input Channel: Mic 1 a
Right Input Channel: Mic 2 B
Preferred Outputs None

Left Output Channel:

Right Output Channel: Mon -
Line 3

Line 4

S/PDIF L

S/PDIF R

DAW 7 pit
DAW 8

DAW 9

DAW 10

DAW 11

DAW 12

Cancel

With the above settings, creating a new input module, its channel strip on
the mixer will appear as:

Mic 1
Mic 2
Input Channels

File Name

New Recording

New Mrk

Save

0.00 Solo

“ Mute

Mono

+0.00 -90.04

(0}

InputRec - 1
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Where DSP-Quattro sets the Mic1 and Mic2 as preferred audio input ports t
the new input module.

For the same reason, creating a new Project, DSP-Quattro will set Mon1 and
Mon2 as output ports for the L&R MainOUT and AUX channel strips:

» Effects

Mon 1
Mon 2
Output Channels

0.00 Solo

“ Mute

Mono

+0.00 -INF

()

L&R MainOUTs

Use the “Save As Default” option to save the current audio configuration as
default configuration to use when opening a new Project also after re-
starting DSP-Quattro.
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